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Introduction

This guide describes how to create tables with the STEP Table Component. You can create and maintain
dynamic, multi-dimensional product tables with support for inheritance, advanced transformations and sharing of
layout and table settings across classifications and catalogs.

We recommend that you familiarize yourself with the key concepts of this guide.

The guide assumes that:

» Users have a working knowledge of the STEP system.

If you need information on other STEP components, see the online help or the specific user guides.

Accessing Shortcut Menus on PC and Mac

You can access shortcut menus by right-clicking on both PC and Mac if you are using a two button mouse. If you
are working on a Mac with a one-button mouse, use CTRL-click to access the shortcut menu. This guide uses the
term right-click.

Creating Table Types in System Setup

Before a table can be defined on product and/or classification objects in the Tree, the table type must first be
configured in System Setup.

System Setup

EEI--E.. Reference Types
B Workspaces
-l Table
}% Colors
>,\§> Rules
Eﬁ Table Types
Eﬂ Table Row Types
Eﬁ Table Calumn Types
T o REYS

Setting up a table type involves defining the settings and formatting for table types, column types, and row types.
Table types, column types, and row types must all be defined under a group. Also included in the setup is the
creation of the colors and rules that will be used in the tables.

Note: You can set up table types, column types, and row types in any sequence you want. However, if you start
with no types defined at all, it is recommend that you define column types and row types before you assign them to
atable type.

Creating Column Types
Before you can define a column type, you must define a column type group in System Setup.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 6
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Defining Column Type Groups

1. In System Setup, go to Table > Table Column Types, then right-click and select Create Column Type
Group.

2. Inthe New Column Type Group dialog, enter an ID and Name for your column type group, then click Create.

¥ New Column Type Group

D PriceTableColumns

Mame |Price Table Columns

Defining Column Types
1. In System Setup, navigate to the desired column type group, then right-click and select Create Column Type.

2. Inthe New Column Type dialog, enter an ID and Name for your row type, then click Create.

3 New Column Type

1D SalesPriceColumn

Mame |Sales Price Column

The column type is ready for use, through in most cases column type settings and formatting definitions will need
to be applied. See the next topic in this section, Configuring Column Type Settings and Formatting, for more
information.

Configuring Column Type Settings and Formatting

Settings and formatting definitions for column types are applied in System Setup. These formatting definitions
are global, meaning that they will inherit to the column type wherever itis used in STEP. Since case-by-case
exceptions to global formatting are sometimes needed, these definitions can be overridden locally, i.e., on the
column itself, when used in a table.

To configure settings for column types in System Setup, follow these steps:

Name and Defaults

1. In System Setup, navigate to Table > Table Column Types.

2. Expand the column type group that contains the column type that you would like to configure, then select the
relevant column type.

3. Onthe Column Type tab, enter a name for the column type in the Name field if a name was not provided
when the column type was created.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 7
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< Normal - Column Type -
Name *| * [Value >
* IName Normal
> Defaults ertical Adjustment:Top e
* Heading/Footer Normal Row
* |Publication Types Al
3 Legal for Table Types
Mame >
* |Price Table
|* | Add Table Type

4. Inthe Defaults field, click the ellipsis button (...). The Change Defaults dialog displays.

E’ Change Defaults @
Width in v
Text Style ot Defined v
Background Color :?Not Defined v:
Cell Vertical Alignment :Top v:
Rule Left :Not Defined v:
Rule Right :Not Defined v:
Cell Rotation :Not Defined v:
Process Flag :Not Defined v:
Cell Story Direction :Not Defined v:
Cell Image Scale 50%

’ DK l ’ Cancel

5. Use the following settings to specify the formatting of the columns that will be created from the column type:

o Width: Sets the width of the column. Available units are inches, millimeters, picas, and points. Also included
in the dropdown is Proportion, which allows the option to specify proportionality to other columns in the table.

Example: When Table X is mounted, then column type B will be twice as wide as column type A. The
proportionis 2to 1.

Table X

Column Type A | Proportional is set to 1

Column Type B | Proportional is set to 2

© Stibo Systems - Confidential - STEP Trailblazer 8.2 8
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To prevent having to select a unit every time a width is set, a default unit can be set in System Settings. See
the Table Defaults section of the System Settings documentation for more information.

« Text Style: Sets the text style of the column. Contents of the dropdown list are populated by style tags
created in System Setup.

« Background Color: Sets the background color of the column. Contents of the dropdown list are populated
by table colors created in System Setup.

« Cell Vertical Alignment: Controls the alignment of the cell contents cell contents (text and images) within
the column as follows:

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Center Centers contents vertically

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat

« Rule Left: Controls which line style is used as the left border of the column. Contents of the dropdown list
are populated by table rules created in System Setup.

« Rule Right: Controls which line style is used as the right border of the column. Contents of the dropdown list
are populated by table rules created in System Setup.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 9
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« Cell Rotation: Controls the orientation of cell contents (text orimages) within the column. Cell contents can
be rotated 0, 90, 180, or 270 degrees as follows:

Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

90

1eH Aped

ajyMW g s|ding
1eH Aued

8juM g a|ding
1eH Aued

SHUM ' 81ding

180

JeH Aped apypn g ading
1eH Aued apypn @ aiding
1eH Aped apypn @ apding

270

Purple & White

Party Hat
Purple & White

Party Hat
Purple & White

Party Hat

« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store
custom table settings.

« Cell Story Direction: Determines whether the contents of the cells in a column (text and images) are
displayed horizontally or vertically.

Cell Story Direction Direction

Horizontal (default) Sets the text direction to horizontal:| ABCDE

© Stibo Systems - Confidential - STEP Trailblazer 8.2 10



StiboSystems

Cell Story Direction Direction

Vertical

3028V

Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the cells within the column. Images may be scaled
from 25% to 500%.

By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

5. Click OK to close the Change Defaults dialog box.

Heading/Footer

In the Heading/Footer field, specify whether the column type should be a Normal Row, Heading (1), Sub
Heading (2), or Footer. These column type designations enable table transformations to specify how to handle
the column.

(The term 'Row" is used here because columns can function similarly to rows in instances where a table is
designed to display vertically instead of horizontally. In a vertical table, a header 'row' will appear as a column on
the far left instead of a row across the top.)

< Normal - Column Type Y

Name *| * Value >
* Name Mormal
* Defaults Vertical Adjustment:Top

Heading/Footer Mormal Row b
* |Publication Types

Heading (1)
Sub Heading (2)
Footer

T Legal for Table Types
Name

Price Table
| * |Add Table Type

W

W

For example, Heading and Sub Heading 'rows' can be excluded for certain transformations, such as alternate
row shading, where the Heading and Sub Heading rows should remain unformatted. Likewise, if a table is split
across columns or pages when mounted in InDesign, a row designated as a Heading will repeat on the next
column or page.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 11
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Publication Types

If the column type should only appear in tables that are mounted on pages connected to specific publication types,
follow these steps:

1.

7.

In the Publication Type field, click the [...] button. The Select Publication Type dialog box appears. The
dialog displays all the publication types that are available.

E] Select Publication Types @

@ Show In all Publication Tvpes

P

() Specify
Included Excluded
Futurs Publication Tvpes <|
PublicationFlakplan
PublicationClient |>

PublicationAutopage
Publication_DPS
Publication'orkflow
Publication

Publication Market Publishing

[ (8] 4 H Cancel

Leave Show In All Publication Types selected if the column type should be allowed in all publication types.
This is the default setting.

Select Specify if the column type should only be allowed in certain publication types. To exclude the column
type from a specific publication type, select the publication type, then click the right-pointing arrow to move the
publication type into the Excluded column.

To ensure that the column type is excluded from any publication type created in the future, select Future
Publication Types, then click the right-pointing arrow to move the publication type into the Excluded column.

Click OK when complete.

Legal for Table Types

All column types must be made legal (valid) for at least one table type before the table type can be used to create a
table in STEP. To make a column type valid for a table type, follow these steps:

1.
2.

On the Column Type tab, expand the Legal for Table Types flipper.
Click Add Table Type. The Select Table Type dialog displays.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 12
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< Normal - Column Type b
Name > > [Value

> [Name Normal

» |Defaults

» Heading/Footer E]SEIEHTE'METYPE @ B

Publication Types Search

P Legal for Table Types =-0f Table Types
Name &+Of) Price Tables

Price Table __.-""" - B
1/ Add Table Tvoe Eﬁ Specifications Tables

W

W

©- Details

[ Select H Cancel

3. Clickthe Browse or Search tab to browse to or search for the desired table type, then click Select.
4. The column type is now legal for the table type.

Removing a Table Type

To remove (unlegalize) a table type, follow these steps:

1. Onthe Column Type tab, expand the Legal for Table Types flipper.

2. Right-click on the arrow to the left of the table type that you would like to remove, then select Remove Table
Type.

? Legal for Table Types

MName
* |Prira Tahla
[j Hide N
Show All Rows

Rotate Table
Add Table Type Ctrl+Plus
Remove Table Type Cirl+Minus

3. The table type is now removed.

Creating Row Types

Before you can define a row type, you must define a row type group.

Defining Row Type Groups
1. In System Setup, go to Table > Table Row Types, then right-click and select Create Row Type Group.

2. Inthe New Row Type Group dialog, enter an ID and Name for your row type group, then click Create.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 13
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33 New Row Type Group

1D PriceTableRows

Mame |Price Table Rows

3. The dialog closes and the row type group is created.

Defining Row Types
1. In System Setup, navigate to the desired row type group, then right-click and select Create Row Type.

2. Inthe New Row Type dialog, enter an ID and Name for your row type, then click Create.

¥ New Row Type

1D SalePriceRow

Mame |Sale Price Row

3. The dialog closes and the row type is created.

The row type is ready for use, through in most cases row type settings and formatting definitions will need to be
applied. See the next topic in this section, Configuring Row Type Settings and Formatting, for more
information.

Configuring Row Type Settings and Formatting

Settings and formatting definitions for row types are applied in System Setup. These formatting definitions are
global, meaning that they will inherit to the row type wherever it is used in STEP. Since case-by-case exceptions to
global formatting are sometimes needed, these definitions can be overridden locally, i.e., on the row itself, when
used in a table.

To configure settings for row types in System Setup, follow these steps:

Name and Defaults

1. In System Setup, expand Table, then expand Table Row Types.

2. Expand the Row Type Group that contains the row type that you would like to configure, then select the
relevant row type.

3. Onthe Row Type tab, enter a name for the row type in the Name field if a name was not provided when the
row type was created.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 14
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< Header - Row Type -
Name *|* Value >
* |Mame Header
> Defaults |vertical Adjustment:Top [aad]
* Heading/Footer Heading (1)
* |Publication Types All
7 Legal for Table Types
Name >
* |Price Table

* |Add Table Type

4. Inthe Defaults field, click the ellipsis button (...). The Change Defaults dialog displays.

£33 Change Defaults @

Height | in v
Text Style ot Defined v
Background Color :Not Defined v:
Vertical Alignment :Top v:
Rule Above :Not Defined v:
Rule Below :0.5 pt v:
Cell Rotation :Not Defined v:
Process Flag :Not Defined v:
Cell Story Direction :Not Defined v:

Cell Image Scale

[] Keep with Next

l 0K ” Cancel

5. Use the following settings to specify the formatting of the rows that will be created from the row type:
» Height: Sets the height of the row. Available units are inches, millimeters, picas, and points.
To prevent having to select a unit every time a height is set, a default unit can be set in System Settings. See

the Table Defaults section of the System Settings documentation for more information.

« Text Style: Sets the text style of the row. Contents of the dropdown list are populated by style tags created
in System Setup.

« Background Color: Sets the background color of the row. Contents of the dropdown list are populated by

© Stibo Systems - Confidential - STEP Trailblazer 8.2 15
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table colors created in System Setup.

« Vertical Alignment: Controls the alignment of the cell contents (text and images) in the row as follows:

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Center Centers contents vertically
Purple & White Party Hat
Purple & White Party Hat

Purple & White Party Hat

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat

« Rule Above: Controls which line style is used as the top border of the row. Contents of the dropdown list are
populated by table rules created in System Setup.

« Rule Below: Controls which line style is used as the bottom border of the row. Contents of the dropdown list
are populated by table rules created in System Setup.

« Cell Rotation: Controls the orientation of cell contents (text or images) in the row. Cell contents can be
rotated 0, 90, 180, or 270 degrees as follows:

© Stibo Systems - Confidential - STEP Trailblazer 8.2 16
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Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

90

1eH Aped

ajuM g sjding
1eH Aued

8juM g 8ding
1eH Aued

S}IU ' Sjding

180

1eH Aued anypp g 3jding
1eH Aued anypp g 3jding
1eH Aued apyp g 2(ding

270

Purple & White

Party Hat
Purple & White

Party Hat
Purple & White

Party Hat

« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store
custom table settings.

« Cell Story Direction: Determines whether the cell contents (text and images) in the row are displayed
horizontally or vertically.

Cell Story Direction Direction

Horizontal (default) Sets the text direction to horizontal:| ABCDE

© Stibo Systems - Confidential - STEP Trailblazer 8.2 17
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Cell Story Direction Direction

Vertical

3028V

Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the row. Images may be scaled from 25% to
500%.

By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

« Keep With Next: Check this box if rows of the row type should remain with the next row in the table if the
mounted table splits across a column or page. (A table will split across a column or page if it is too large to
fully mount in a single column or page.) The row will be mounted onto the following column or page in order
to keep it with the next row.

5. Click OK to close the Change Defaults dialog box.

Heading/Footer

In the Heading/Footer field, specify whether the row type should be a Normal Row, Heading (1), Sub Heading
(2), or Footer. These row type designations enable table transformations to specify how to handle the row.

£ Normal - Row Type p

Row Type

Mame *| * [Value >
* IName Normal
> Defaults Vertical Adjustment:Top Rule Below:0.5 pt Keep ...
* Heading/Footer Normal Row b
* |Publication Types Normal Rows
9 Legal for Table T Tts

298 ypes Sub Heading (2)

MName

Footer

* |Price Table

W

* |Add Table Type

« Forexample, Heading and Sub Heading rows can be excluded for certain transformations, such as
alternate row shading, where the Heading and Sub Heading rows should remain unformatted. Likewise, if a
table is split across columns or pages when mounted in InDesign, a row designated as a Heading will repeat
at the top of the table in both frames.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 18
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« Footer rows are handled similarly by table transformations. For example, the text style or background
shading of Footer rows is typically different than that of the rest of the table. Therefore, Footer rows can be
excluded for certain transformations that apply to the whole of the table but should not apply to the Footer
row.

Publication Types

If the row type should only appear in tables that are mounted on pages connected to specific publication types,
follow these steps:

1. Clickinside the Publication Types field and click the [...] button. The Select Publication Types dialog box
displays. The dialog displays all available publication types.

E] Select Publication Types @

@ Show In all Publication Tvpes

P

() Specify
Included Excluded
Futurs Publication Tvpes <|
PublicationFlakplan
PublicationClient |>

PublicationAutopage
Publication_DPS
Publication'orkflow
Publication

Publication Market Publishing

[ (8] 4 H Cancel

2. Leave Show In All Publication Types selected if the row type should be allowed in all publication types. This
is the default setting.

3. Select Specify if the row type should only be allowed in certain publication types. To exclude the row type from
a specific publication type, select the publication type, then click the right-pointing arrow to move the publication
type into the Excluded column.

4. To ensure that the row type is excluded from any publication type created in the future, select Future
Publication Types, then click the right-pointing arrow to move the publication type into the Excluded column.

7. Click OK when complete.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 19
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Legal for Table Types

All row types must be made legal (valid) for at least one table type before the table type can be used to create a
table in STEP. To make a row type valid for a table type, follow these steps:

1. Onthe Row Type tab, expand the Legal for Table Types flipper.
2. Click Add Table Type. The Select Table Type dialog displays.

< Normal - Row Type
Name *| * [Value
* Mame Normal
» |Defaults
» Heading/Footer EHSEIE‘I Table Type @ B

Publication Types Search

@ Legal for Table Types =0 Table Types .
Name =) Price Tables

Price Table __.-""' il B
1/ Add Table Tvoe Eﬁ Specifications Tables

W

W

©- Details

[ Select H Cancel

3. Clickthe Browse or Search tab to browse to or search for the desired table type, then click Select.
4. The row type is now legal for the table type.
Removing a Table Type

To remove (unlegalize) a table type, follow these steps:

1. Onthe Row Type tab, expand the Legal for Table Types flipper.
2. Right-click on the arrow to the left of the table type that you would like to remove, then select Remove Table
Type.

? Legal for Table Types
Name

* |Prira Tahla
[[] Hice
Show All Rows
Rotate Table
Add Table Type Ctrl+Plus
Remove Table Type Cirl+Minus

3. The table type is now removed.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 20
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Creating Table Types

When you have created at least one column type and one row type, you can define the table group type and table
type itself. The process is similar to creating row types or column types.

Defining Table Type Groups
1. In System Setup, go to Table > Table Types, then right-click and select Create Table Type Group.
2. Inthe New Table Type Group dialog, enter an ID and Name for your table type group, then click Create.

33 New Table Type Group

1D PriceTables

Mame |Price Tables

Defining Table Types
1. In System Setup, navigate to the desired table type group, then right-click and select Create Table Type.
2. Inthe New Table Type dialog, enter an ID and Name for your table type, then click Create.

82 MNew Table Type

1D PriceTable

Mame |Price Table

Note: The ID for table types has a limit of 33 characters and cannot end with a'$.' For row and column types,
the ID has the usual restriction of 40 characters.

The table type is ready for use, through in most cases table type settings and formatting definitions will need to be
applied. See the next topic in this section, Configuring Table Type Settings and Formatting, for more
information.

Configuring Table Type Settings and Formatting

Settings and formatting definitions for table types are applied in System Setup. These formatting definitions are
global, meaning that they will inherit to the table type wherever it is used in STEP. Since case-by-case exceptions
to global formatting are sometimes needed, these definitions can be overridden locally, i.e., on the table itself.

Once you have created a table type consisting of at least one legal row type and one legal column type, you can
start using it to create tables in the Tree. Instructions on how to create legal row and column types are covered in
this topic. For information on how to use a table type to build a table, see the Creating Tables section of the STEP
Tables documentation.

To configure settings for table types in System Setup, follow these steps:

© Stibo Systems - Confidential - STEP Trailblazer 8.2 21



Name and Defaults

1. In System Setup, expand Table, then expand Table Types.

StiboSystems

2. Expandthe Table Type Group that contains the table type that you would like to configure, then select the
relevant table type.

3. Onthe Table Type tab, enter a name for the table type in the Name field if a name was not provided when the
table type was created.

< Price Table - Table Type L
Name *| » Value >

> IName Price Table

» |Edited by 2015-07-16 18:04:00 by USER

> Defaults |

W

Dimension Dependenc...

W

Pagination Plugin

Mone

&= | egal Row Types

& | egal Column Types

©- Default Transformations

= Resolvable for Product Types

= Resolvable for Classification Types

4. Inthe Defaults field, click the ellipsis button (...). The Change Defaults dialog displays.

Cell Image Scale

E] Change Defaults
Width |
Text Style ot Defined
Background Color iNot Defined
Rule Above iNot Defined
Rule Below iNot Defined
Rule Left iNot Defined
Rule Right iNot Defined
Vertical Alignment :Top
Cell Rotation :Not Defined
Process Flag :Not Defined

Cell Story Direction :Not Defined

’ DK ” Cancel

5. Use the following settings to specify the formatting of the tables that will be created from the table type:
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Width: Sets the width of the entire table. Available units are inches, millimeters, picas, and points. Though
Proportional is also available in the dropdown, this setting only applies to columns. (See Configuring
Column Type Settings and Formatting for more information.)

To prevent having to select a unit every time a width is set, a default unit can be set in System Settings. See
the Table Defaults section of the System Settings documentation for more information.

Text Style: Sets the text style for the entire table. Contents of the dropdown list are populated by style tags
created in System Setup.

Background Color: Sets the background color of the entire table. Contents of the dropdown list are
populated by table colors created in System Setup.

Rule Above: Controls which line style is used as the top border of the table. Contents of the dropdown list
are populated by table rules created in System Setup.

Rule Below: Controls which the line style is used as the bottom border of the table. Contents of the
dropdown list are populated by table rules created in System Setup.

Rule Left: Controls which line style is used as the left border of the table. Contents of the dropdown list are
populated by table rules created in System Setup.

Rule Right: Controls which the line style is used as the right border of the table. Contents of the dropdown
list are populated by table rules created in System Setup.
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« Vertical Alignment: Controls the vertical alignment of cell contents (text and images) as follows:

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Center Centers contents vertically

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat

« Cell Rotation: Controls the orientation of cell contents (text orimages). Cell contents can be rotated 0, 90,
180, or 270 degrees as follows:

Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat
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Cell Rotation Example

. §73232
PRI
8 ® &
180
JeH Aped apyp @ 3jding
JeH Aped apyp @ 3jding
1eH Aped apypn @ apding
270 L o o
O
EEEFETD
M0 3 M 3 @
ooododd

« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store
custom table settings.

« Cell Story Direction: Determines whether the contents of the cells in the table (text and images) are
displayed horizontally or vertically.

Cell Story Direction Direction

Horizontal (default) Sets the text direction to horizontal:| ABCDE

Vertical

3028V

Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the cell. Images may be scaled from 25% to
500%.
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By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

6. Click OK when complete.

Dimension Dependencies

Table types can be made dimension dependent if there is Free Text content within the table that needs to be
translated and/or appear differently in different countries. Since Free Text only exists within tables (and is not tied
to attribute values), the only way to enable Free Text content to appear differently in different Contexts is to make
the table type dimension dependent.

Note: Attributes used in a table can be dimension dependent even if the table type itself is not. Dimension-
dependent attributes will display different values for different contexts automatically when the table is viewed in a
different context.

To make a table dimension dependent:

1. Double-click inside the Dimension Dependencies field, then click the ellipsis button (...). The Select
Dimension Dependencies dialog displays.

2. Check the applicable Dimension checkbox. The number of available checkboxes is determined by the
number of available Dimensions that have been created in System Setup.

£ Select Dimension Dependencies @

Language

Level of difficulty of applying changes: 0

Operation might be time consuming

[ Apply H Cancel

3. Click Apply to complete. The table type is now dimension dependent.
Dimension-Dependent Table Type Example
The following two screenshots show a dimension-dependent table type in two different Contexts.

1. Example with English Free Text values displayed in an English-language Context:
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Commercial

b#4 Context| English US

[ € - C ure 0820025 [F] I EF [l coto [1oieme
Paper Hats rev.0.1 - Tables

Category Profile || Proof View || Status || State Log || Tasks

> | Prod [}

Product Product Variants ” Sub Products “ References ” Referenced By ” Images & Documents ]
¢ Tables
Name * |Defined At *
> |Price Table Products
> | Add Table Type
BEVLTGON [ Preview
Price Table 1 (2 3 > |4 >
Normal Mormal Mormal Normal
[1F Product name | ID Primary Prod... ﬁ Price
1 *Header 13 name Product Name Part No. Image
2 »|Normal (& Local

2. Example with French Free Text values displayed in a French-language Context:

Commercial

“ Context :French France

~ | € - C ur [d=main 5] [F] i [ [ Goto [1oieme
per Hats rev.0.1 - Tables

Cateqgory Profile || Proof View || Status || State Log || Tasks

* |Proc [

Product Product Variants “ Sub Products “ References ” Referenced By “ Images & Documents ]
? Tables

Name * |Defined At >
> |Price Table Products

> | Add Table Type

Preview
Price Table 1 s |2 3 4 >
Mormal Mormal Normal Mormal
(1T Mom du produit (1T D Image du Pro...ﬁ Price
1 »Header (1T name Mom du produit | Référence L'image
2 »|Normal & Local

Pagination Plugin

The Pagination Plugin field is where the Header Repeating Pagination Plugin is selected. To choose this

plugin:

1. Onthe table type tab, click in the Pagination Plugin field and select Header Repeating Pagination Plugin.
('None' will appear as the default selection.)
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< Price Table - Table Type L
Mame *| * Value *

* IName Price Table

* |Edited by 2015-07-16 18:04:00 by USER

* Defaults

* Dimension Dependenc...

>|Pagination Plugin None ¥ Change Settings

= | egal Row Types

Header Repeating Pagination Plugin

| egal Column Types

2. Click on Change Settings. The Header Repeating Pagination Plugin displays.
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¢ Row/Coumn counts

Minimum Body Rows to Keep With Heading at Bottom of Column |1
Minimum Body Rows to be Carried Over to Top of Next Column 1
Minimum Body Columns before a table width split

Minimum Body Columns after a table width split

i
Name >
* |Add Row Type
i
Name >
* | Add Column Type
4
MName >
* |Add Row Type
i
Name >
* | Add Column Type
4
MName >
* |Add Row Type
¢ Alternating Row Colors Settings

Enable alternating row colors
Restart row count at always repeated headers

Restart row count at repeat last headers

Ignore always repeated headers

Ignore repeat last headers
Ignore footers

Normal Colored Rows
Alternate Colored Rows

Normal Color Light Blue -

==
4

Alternate Color Paper

§ Table Rulers and Width settngs

Use table bottom ruler on splits as bottom ruler.
Use table top ruler on splits as top ruler.
Use table left ruler on splits as left ruler.

Use table right ruler on splits as right ruler.

-

Enable table split when wider than frame

Break before table width split

| ok || cancel
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Instructions on how to configure the Header Repeating Pagination Plugin are not covered in this topic. For
information, see the Header Repeating Pagination Plugin section of the STEP Tables documentation.

Legal Row Types
Every table type must contain at least one legal (valid) row type before the table type can be used to create tables
in the Product and/or Classification hierarchies.

The following steps explain how to add a legal row type to a table type.

1. Onthe Table Type tab, expand the Legal Row Types flipper.
2. Click Add Row Type. The Select Row Type dialog displays.

3. Click the Browse tab to navigate to the desired row type(s), then click Select. Row types may be multi-
selected by holding down Shift or Ctrl when making selections.

E] Select Row Type @

=0 Table Row Types

& Details

Select Cancel

4. The row types are now legal for the table type.

Removing a Row Type
To remove (unlegalize) a row type, follow these steps:

1. Onthe Table Type tab, expand the Legal Row Types flipper.
2. Right-click on the arrow to the left of the row type that you would like to remove, then select Remove Row
Type.

% Legal Row Types
Default * \Mame

) Header

» {7 Nnrmal

Hide

€ Show All Rows

o Rotate Table

@ Add Row Type Ctrl+Plus

@ | Remove Row Type CtrI+Minu5|

W

3. Therow type is now removed.
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Legal Column Types
Every table type must contain at least one legal (valid) column type before the table type can be used to create
tables in the Product and/or Classification hierarchies.

The following steps explain how to add a legal column type to a table type.

1. Onthe table type tab, expand the Legal Column Types flipper.
2. Click Add Column Type. The Select Column Type dialog appears.

3. Click the Browse tab to navigate to the desired column type(s), then click Select. column types may be multi-
selected by holding down Shift or Ctrl when making selections.

E] Select Column Type @

=0 Table Column Types
=G Price Table Columns

------ fifi Mormal

& Details

Select Cancel

4. The column types are now legal for the table type.
Removing a Column Type

To remove (unlegalize) a column type, do the following:

1. Onthe Table Type tab, expand the Legal Column Types flipper.

2. Right-click on the arrow to the left of the column type that you would like to remove, then select Remove
Column Type.

? Legal Column Types

Default * |Name
> @) Mormal
- 1 Prire
> Hide

@ Show All Rows

& Rotate Table

oy Add Column Type Ctrl+Plus
|Remove Column Type Ctrl+Minus |

3. The column type is now removed.
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If more than one row type or column type is added, a default type must be specified for each. Default column
types are required to use the Create Table From Clipboard option.

Tables created using Create Table From Clipboard are simply 'pasted’ from an external application such as Excel.
Since no prompt appears that asks you to choose which row or column types to use, the system will build the table
using the specified default row and column types.

To define a default row type or column type, simply click the radio button next to the preferred row type and column
type. The default type can be overridden in the table if needed.

7 Legal Row Types

Default * |Name
> Header
) Mormal
* | Add Row Type
T Legal Column Types

Default * |Name
) Mormal

> Price
* |Add Column Type

See Creating Tables from Clipboard in the STEP Tables documentation for more information.

Default Transformations

Transformations that apply to every table created from a table type are selected from the Default
Transformations area. To apply a default transformation to the table type, follow these steps:

1. Onthe Table Type tab, expand the Default Transformations flipper.
2. Click Add Transformation. The Select Transformation dialog displays.

Browse

E] Select Transformation

EX5

-1 Sortings

#-£3 Layout Transformations

-3 Formatting
-0 Transformations

& Details

[ 0K H Cancel

3. Navigate to the relevant transformation, then click OK.

4. Repeat these steps to add additional transformations.
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Descriptions of these transformations and instructions on how to configure them are not included in this topic. See
About Table Transformations in the STEP Tables documentation for more information.

Resolvable for Product Types and Classification Types

Alltable types must be made resolvable for at least one Product type or Classification type before the table type
can be used to create tables in the Tree. 'Resolvable’ essentially means the same thing as 'valid'. Though a table
can be built at a higher level in the Product or Classification hierarchy to take advantage of inheritance, the table
cannot be previewed on any object where it has not been made resolvable (valid), nor can it be mounted in
InDesign. To make Product types and Classification types valid for table types, follow these steps:

1. Onthe Table Type tab, expand the Resolvable for Product Types and/or Resolvable for
Classification Type flipper.

2. Check the box(es) for the Product type(s) and/or Classification type(s) where the table should be resolvable.

Configuring Table Formatting in System Setup and InDesign

Formatting definitions for STEP Tables are configured in two places: the System Setup tab inthe STEP
Workbench and in publication templates created in InDesign using the STEP'n'design plugin.

Table formatting definitions in STEP are composed of the setups for Colors, Rules, and Style Tags. The
corresponding setups in publication templates are swatches, line styles, and paragraph styles.

System Setup

£ Obiect Tvpes & Structures

=g Tags
=05y Style Tags
Uz Special Characters
fﬁ Character Tags
05 Footnotes
=I5 Hyperlinks

H-g Units

- Users & Groups

7Bl Reference Types

-2 Workspaces

£
[
£
£

#-Lp Table Types
-0 Table Row Types
=y Table Column Types
- Keys

The following sections of this documentation explain both the STEP Workbench and the corresponding
STEP'n'design publication template configurations required to format tables.

Defining Table Colors in STEP

Colors in STEP are used to define the colors applied to rule lines and cells in STEP Tables. These colors are
used in the STEP Table Preview view in the workbench to provide a rough approximation of what the table will
look like on the InDesign page.
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In order for these colors to display correctly on the InDesign page, each color used in a STEP Table must have a
corresponding color Swatch defined in the publication template that will be used to mount these tables InDesign.

The following steps describe how to create a new colorin STEP.

1. In System Setup, expand Table, and then click Colors.

2. Onthe Table Colors tab, click Add Color.
< Table Colors

{2 Object Types & Structures .
IZZI-- Tags
E-¢ Units Name v|Color i
% Users & Groups > |Black
IZZI--E»E Reference Types > [Blue
-7+ Workspaces
£ i} Tabla > (Grey
-} 3% [Colors ||/ * |Light Blue
SEPRmE
O Table Types > Reore
Eﬂ Table Row Types = >
5+-Cffj Table Column Types » White
e Keys
#-i Event Queues -
#-Bd Component Models ~
< | 1 | 3 l’ Add Color

3. Inthe Add Color dialog, enter a name for the new color.

£33 Add Color

Mame |Unnamed|

| Swatches | HS"-"l HS|:| RgEl CMYK|

Recent:

Preview

B - [l Sample Text Sample Text

. . . Sample Text Sample Text

l oK ” Cancel

4. Onthe Swatches tab, select the preferred color.

5. Alternately, you may create a color from one of the four additional tabs:
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o HSV (Hue, Saturation, Value)

o HSL (Hue, Saturation, Lightness)

« RGB (Red, Green, Blue)

o CMYK (Cyan, Magenta, Yellow, Black)

5. Click OK.

Note: Even though the Add Color dialog provides fairly advanced options for creating colors, colors created in
STEP are only used to render the color of rule lines and table cells in the STEP Tables Preview. To mount tables
in InDesign with the same color, you must create a corresponding color swatch for your publication template in
InDesign. The name of the color created in STEP and the swatch created in InDesign must match exactly, as both
names are case sensitive.

Defining Table Rules in STEP

Rules in STEP are used to define the width and color of rule lines used in STEP Tables. Rules are used in the
table Preview view in the workbench to provide a rough approximation of what the table will look like on the
InDesign page. Table rules created in STEP must also have corresponding Line Styles defined in the publication
template through the STEP'n'design Table Settings dialog. The following steps explain how to define a table rule
in STEP.

1. In System Setup, expand Table, then click Rules.
2. Onthe Table Rules tab, click Add Rule.

< Table Rules -
-2 Object Types & Structures - Table Rules
IZZI-- Tags
[]...&9 Units Name ~(Width * |Color >
% Users & Groups > 0.5 pt Black
D"?“g Reference Types > 1 pt Black
-1t Workspaces

> |Black Dashed 1 pt Black
' ~— |||/ * Red Dashed 1 pt Red

0
1
=il Table > 2 pt 2 Black
. 1
1

O Tabe Types
Eﬂ Table Row Types
5+-Cffj Table Column Types
e Keys
Hgll Event Queues
#-[& Component Models
E
4

111

ZI""_‘} Recycle Bin -

| 1] | » I’ Add Rule I

3. Inthe New Rule dialog, enter a Name, Width, and Color for the new rule.
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£23 New Rule @

Name Black 2 pt
Width 2|

Color | Black -

[ Create H Cancel

4. Click Create.

If needed, any of the aforementioned values (Name, Width, and Color) may be changed in STEP after the rule has
been created.

Considerations and Limitations

Rule Name

The Name of the rule must exactly match the name of a corresponding line style created in the publication
template in InDesign. The name in both locations is case sensitive.

Rule Width

The value entered for Width is a number that defines the width of the rule line in points, which is typically a
number from 1 to 3. STEP will not accept a number lower than 1 in the Width field, even if the output for the line in
InDesign will be less than 1 pt (for example, 0.25 ptor 0.5 pt).

The Width value entered in STEP is only valid for the table preview, as the preview functionality cannot represent
aline smaller than 1 pt. Due to this, a rule line intended to only be 0.25 pt or 0.5 pt must always display as 1 ptin
STEP. The true display of the rule line in InDesign will be set in the publication template.

Rule Color

The options available in the Color dropdown list are limited to those that have already been created under Table >
Colors in System Setup. The previous section of this documentation, Defining Table Colors, explains the
process for creating colors in STEP.

Dashed, Dotted, and Other Non-solid Rule Styles
The STEP Table Preview does not support display of dashed, dotted, or other non-solid line styles. Rule lines will
still appear as solid lines in the preview. Non-solid styles are only visible from actual pages created in InDesign.

With this in mind, you may choose to differentiate a dashed rule from a solid rule in STEP by assigning a non-
standard color to the rule line. For example, a bright fuchsia color could be a visual indicator—in the table preview
only—that the rule line is 'different'.

Defining Style Tags for Tables

Style tags in STEP are commonly used to apply text styling to STEP Tables. Style tags define styles such as bold,
underline, color, left aligned, right aligned, center aligned, and so on. Style tags can be applied at the table,
column, row, or cell level. Typically, each style tag in STEP will match, by name, a corresponding paragraph style
in the InDesign publication template.
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Note: The following steps describe how to configure a sample setup for a style tag and tag group intended to be
used for tables; this is not all-encompassing documentation on the subject of tags and style tags. Full instructions
for how to create style tags in STEP are located in the Tags section of the System Setup / Super User Guide
documentation.

Create a Tag Group for Table Style Tags
1. In System Setup, navigate to Tags > Style Tags.
2. Right-click and select New Tag Group.

3. Give the new tag group an ID and Name that identifies the group as a container for tables-only styles, e.g.,
'Table Styles'. Click Create. (This is merely a 'best practices' suggestion—style tags used in tables may be
created in the same tag group as style tags that are used for basic text formatting in rich text editors in STEP.)

E] Create Tag Group @

1D Table Styles
Name

| Create | | Cancel

4. Right-click the newly created 'Table Styles' tag group, then select New Tag.

5. Give the new style tag a Name and Tag that indicates its intended output in InDesign. For example, the style
could be named Bold_C to indicate that it is a bold, centered text style. (This is merely a suggestion, as the
value of Name and Tag can be anything you would like as long as there is a matching paragraph style in
InDesign.)

To avoid confusion, Name and Tag are typically the same value.

| £ | New Style Tag @
Name |Bold_C

Tag |Bold_d]

oK | Cancel

6. With the newly created style tag selected, click inside the Rendering field on the Style Tag tab, then click the
ellipsis button (...).
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< Bold_C - Style Tag >

[]---[ffi:i Workflow Profiles P style Tag
E]--Dqukl:IU:s ; ¥ Special Character Definition
-[El Derived Events
- Object Types & Structures Name >| > [value ’
[_]..% Tags Mame Bold_C
L:J% Style Tags | Edited By
=g Table Styles Tag Bold C -
o3| Bold_C 3 I Rendering The Quick Brown Fox Jumps Over The Lazy Dog
~[o] Normal_c Show Style No
“-Jz3] Normal_L
..... ol bold - Keyboard Shortcut
----- &l bolditalic List Tag _ ho
----- ol BoldRed ? Output Formatting
..... &3] bullet Format * |Farmatting Start * |Formatting Stop >
""" % bulletlist | > | Add Formatting
----- italic

7. Inthe Rendering dialog box, make the selections that will approximate the intended look of the style on the
InDesign page, then click Apply.

In this example, the options to display the Bold_C style as 12 pt Arial Bold have been selected.

m Rendering

Style
Font Size On Tnherit Off
Arial ¥ |12 il Bold @ () O
Text Color _ _ _
: : malic () @ ()
Black adl
Background Color Underline () @ ()
[Tnherit - Subscript () @ ()

Superscript () @ ()
[] Paragraph Style
Prefix List Tag -
Preview
The Quick Brown Fox Jumps Over The Lazy Dog

[ Apply ] [ Cancel

When the Rendering dialog closes, the view reverts back to the Style Tag tab.

8. Onthe Style Tag tab, select Yes for Show Style.
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Note: Selecting No will make the tag unavailable for selection in all dropdown lists available in STEP. No is
only used for 'hidden’ styles such as stibo.STIBOSPELL, which is used by the system to highlight spelling
errors in STEP's text editors.

9. Leave Keyboard Shortcut blank if you intend to use this style only in STEP Tables. Keyboard shortcuts are
only relevant for tags intended for use in STEP rich text editors, since there is no way to use a shortcut to apply
a style tag anywhere inside a table.

10. Select No for List Tag, since this style tag will not be used to configure the output of bullet lists in HTML.

11. Output Formatting is not required for style tags created specifically to apply styling to tables. These style tags
are simply matched by Name to a corresponding paragraph style in InDesign.

Limitations of Style Tag Display in the STEP Tables Preview

The STEP Tables Preview will only display text as left aligned, even if the style tag is intended to display centered,
right-aligned, or justified text in InDesign. However, this is merely a limitation of the preview; the text styles will
display correctly when the table is mounted in InDesign.

Note that any settings applied in the Rendering dialog (bold, color, italics, etc.) will display properly in the preview.

Configuring Table Styles in Publication Templates

In order to format STEP Tables on InDesign pages, a parallel set of formatting configurations must be created in
STEP and InDesign for the following:

« Colors (used both for rule lines and background shading)
o Rulelines
o Textstyles

In STEP, these configurations are the Colors, Rules, and Style Tags created on the System Setup tab. The
corresponding configurations in InDesign are swatches, line styles, and paragraph styles. The InDesign
configurations are created in the InDesign publication template that will be used to mount (generate) tables in
InDesign.

This topic deals only with the table formatting definitions created in publication templates. Full details on how to
configure the corresponding definitions in STEP are outlined in the Creating Table Formatting in System
Setup section of the STEP Tables documentation.

Example of a Styled Table in STEP

The following screenshot shows a styled table in STEP as it appears in the STEP Table Preview. The background
colors, rule lines, and text styles have been applied using the settings created in System Setup. In order for the
table to appear with the same colors, text styles, and rule lines in InDesign, the corresponding settings must be
created in the publication template.

Note: If no styles are defined for the table in STEP, the table will be mounted in InDesign with basic InDesign
paragraph styling, and the table must then be styled manually using the standard InDesign table editor. Manual
styling of tables on InDesign pages is discouraged, as formatting not connected to STEP can be easily lost when
tables are updated.
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Select version iAcme Party Supplies/English US

viSeIect Preview MNode

Product Name Part No. Image Product Name Price
Chriztmas Party Hat 121184-A Christmas Party Hat 5759
o
<y
Cosmic Party Hat 121177-A Cosmic Party Hat $3.99
4 )
Pink & Green Party Hat 121171-A Pink & Green Party Hat $2.99
Pink & Green Pem-Pom Hat  |121193-A Pink & Green Pom-Pom Hat  |32.59
Political Party Hat 121182-A Peolitical Party Hat 217.76
» | » |Transformation * |Parameters ¥

> Alternate Row Colors
* |Add Transformation

Color 1 rows "White" then 1 "Light Blue". Restart count after...

Configuring Table Colors in InDesign
Colors defined in STEP are configured in InDesign as Swatches, as follows:

StiboSystems

1. InInDesign, navigate to Window > Color > Swatches (or press F5). The Swatches panel displays.

% Swatches |

Iﬁn @T Tint: L

[7] [None] 7
[l [Registration] W
[ (Pep=r]

| REEES| ®

[ C=100 M=0 =0 K=D
[l C=0 M=100 v=0 K=D
[] c=0M=0v=100 K=D
[l c=15 M=100 ¥=100 K=0
B c=75 M=5 ¥=100 K=0

B c=100 M=30 ¥=10 K=0

M R &

2. Click the Options menu in the upper right corner of the Swatches panel, then click New Color Swatch.

3. Onthe New Color Swatch dialog, deselect the Name with Color Value checkbox, then type a name in the

Swatch Name field.

Note: The name of the swatch must be identical to the corresponding color created in STEP. Names of colors

and swatches are case sensitive.
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Swatch Options
Swatch Name: Light Blue
[ name with Color Value — Cancel |
Color Type: Process - Preview
Color Mode: CMYK -

Oyan Ly s— 10 oh

Magenta & ———— |2 o5
Yeloweg o |0 %
Black gy ———— | %o

4. Adjustthe color values as needed, then click OK.

Loading Swatches From Another InDesign Document

To load swatches from another InDesign document:

1. Inthe Swatches panel, click the Options menu, and then click Load Swatches. An Open a File dialog box
displays.

2. Navigate to the InDesign file that contains the swatches that you would like to import, then click Open. (This file
does not have to be another publication template; it can be any InDesign document.)

3. The Swatches from the selected InDesign file will automatically import.

Configuring Table Line Styles in InDesign

Rules defined in STEP are configured as table Line Styles in InDesign via the STEP > Table Settings menu.
Line styles govern the lines (‘borders' or 'rulers') that appear between cells and/or surround the table.

To create line styles in the InDesign publication template:

1. Navigate to STEP > Table Settings. The Table Settings dialog displays.
2. Click Add in the lower left-hand corner. The New Line Style dialog displays.
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rTabIe Settings
Defauk Inset
Left 0in Above 0in Right 0in Below Oin
Style Name Line Weight  Line Colour Lne Tt Line Type Gap Colowr GapTim  Left Above  Right Below
New Line Style I
Style Name 1 pt Black
Line Weight 1 pt
Line Colour Black A
Line Tint 100%
Line Type A
Gap Colour -
Gap Tint
Inset - Left
Inset - Above
Inset - Right
Inset - Below
[ oK | [ cancel | -
Add Remove [ ok [ Ccancel |

. Populate the fields in the New Line Style dialog as follows:

« Style Name: Name of the line style. Must exactly match the name of the corresponding rule created in
STEP. Is case sensitive.

« Line Weight: Width in points. The measurement unit will always default to points regardless of what
measurement unit is being used for the rest of the page (for example, mm, inches, or picas).

« Line Colour: Color of the line style. An InDesign swatch for the color must first be created in the publication
template before the color will appear in this dropdown list.

« Line Tint: Opacity level of the line style. Default is 100%. Value must be typed.

« Line Type: Specify whether the line style should be solid (most common) or a different style such as dashed
or dotted. The same line styles available in the InDesign Stroke panel are available in the Line Type
dropdown.
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MNew Line Style
Style Name
Line Weight
Line Colour
Line Tint

Line Type
Gap Colour
Gap Tint
Inset - Left
Inset - Above
Inset - Right

Inset - Below

1 pt Black Dashed
1pt

Black

100%

ﬂ

Thick - Thick
Thick - Thin

Thick - Thin - Thick
Thin - Thick

Thin - Thick - Thin
Thin - Thin

Triple

mmm mmm Dashed (3 and 2)
mm  mmDashed (4 and 4)
s Left Slant Hash
sy Right Slant Hash
HIRN Straight Hash

* e eDotted

StiboSystems

« Gap Colour: Only applicable for non-solid rule lines. Defines the color that goes in between the dashes,
dots, hashes, etc. The same colors (swatches) that appear in the dropdown list for Line Colour appear in the

Gap Colour dropdown. Leave blank for solid rule lines.
« Gap Tint: Opacity level of the gap color. Defaultis 100%.

« Insets (Left, Above, Right, Below): How much inset space (‘padding') should be placed between the
edge of a cell that is bordered by the rule line and the text or image content within the cell. If left blank—or if a
value of 0 is inserted—the insets will default to InDesign's default table cell inset, which is 4 points (or, 0.0556
inches or 1.411 mm).

Note: If you would like no inset padding at all, enter a hairline space value of .0001. The system will recognize

this value as being so close to 0 that there will be no visible inset padding.

needed.

Loading Table Line Styles From Another InDesign Document
Toload table line styles from another InDesign document:

Click OK when finished. Any values entered during the initial creation of the line style may be edited later if

1. Navigate to STEP > Table Settings, then click the Import button in the lower left corner of the Table
Settings dialog box.
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Add Remove

2. AnOpen a File dialog box displays. Locate the InDesign publication template containing the line styles that
you would like to import, then click Open.

3. Theline styles from the selected InDesign file will automatically import.
4. Click OK to complete.

Configuring Paragraph Styles for Tables in InDesign
Style tags created in STEP and applied to tables are configured as paragraph styles in InDesign.

For example: If the tables you are mounting from STEP contain the styles 'HeaderRowStyle' and 'BodyRowStyle',
then there must be corresponding paragraph styles also named 'HeaderRowStyle' and 'BodyRowStyle'. STEP
style tags and InDesign paragraph styles are both case sensitive and must match exactly.

System Setup

{E’ Object Types & Structures
[l] Tags

E} Style Tags

=g Table Styles

E;}-- Fivot Table Styles
- [e3] BodyRowStyle
~[s3] Beld_C
BoldHeader
HeaderRowStyle
-] Mormal_C

3] Mormal _L

To create a paragraph style in InDesign:

1. InInDesign, navigate to Window > Styles > Paragraph Styles (or press F11). The Paragraph Styles panel
displays.

I’ad I.a* Ij4 04 { Paragraph Styles | ro | -
Normal C _;

[Basic Paragraph]

1[1
| m—

»

Busllet copry

bold

Bold C

MNormal_L

 Wormac |
BaoldRed

bold—BaokiRed
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2. Click the Options menu in the upper right corner of the Paragraph Styles panel, then click New Paragraph
Style.

3. Onthe New Paragraph Style dialog, enter a Style Name that exactly matches the corresponding style tag in
STEP.

MNew Paragraph Style
p Style Name: BoldHeader

Basic Character Formats
Advanced Character Formats

Location:

Indents and Spacing General

Tzbs

Paragraph Rules Based On: Mormal_C hd
Kesp Crptions
Hyphenation
Justification Shortcut:
Span Colsmns

Drop Caps and Nested Styles
GREP Style Style Settings: Reset To Base

MNext Style: [Same style] -

Ballets and Numbesing
Character Color

Normal_C + nest: [Same style] a

CrpenType Festunes
Undesline Crptions
Strikethrough Orptions
Export Tagging

[ | Apply Style to Selection

[ Preview oK | [ cancel |

4. Continue configuring the paragraph style as needed, then click OK to complete.

Merge of Row / Column Style Names

In the case where a row with a style applied crosses a column with a style applied, a third paragraph style is
created when the table is mounted in InDesign. The name of this third paragraph style (sometimes called an
'intersection style') is a combination of the name of the paragraph style used for the row and the paragraph style
used for the column, connected by an em dash.

For example, a table may contain a row style called 'bold' and a column style called 'RedBold'. In the cells where
these rows and columns cross over each other, the two styles will overlap. When the table is mounted in InDesign,
the system will automatically create a new paragraph style called 'bold—BoldRed'.
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Adobe InDesign @

Style not found - creating;
! %, bold—BoldRed

However, with the system not knowing which of the two paragraph styles to 'pick up,' the newly created
'intersection’ style will appear as a generic (basic) paragraph style.

ﬂ |_.| |_.| §|s Paragraph Sty... |_

bold—BolkiRed
[Basic Paragraph]
Bullet copy
bokd
Boli_C

MNormal_L
MNorma|_C
BoldRed
bold—BoldRed

Note: In order to avoid the creation of 'intersection' styles in InDesign, it is recommended to apply text styling at
the cell level in STEP Tables where an overlap will occur between row and column styles. 'Intersection’ styles are
essentially duplicates of existing styles and can cause clutter in a long list of paragraph styles.

Price

$7.99

For more information on applying formatting to STEP Table cells, see Specifying Local Cell Formatting in the
STEP Tables documentation.

Creating Tables

Before you can create a table on a product or classification, you must first add a table type to a product or product
hierarchy.

If no table types are available, you have to define them in System Setup. For more information about defining
tables in System Setup, see Creating Table Types in System Setup in the Tables documentation.

Important: While you can create tables on classifications, we recommend that you only create tables in the
product hierarchy to simplify the maintenance of inherited tables.

To Add a Table Type to a Product or Classification

1. Inthe Tree, click the relevant product hierarchy or product.
2. Click the Tables tab, then click Add Table Type to display the Select Table Type dialog.
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33 Select Table Type

| Search

El--fﬁ Table Types
Eﬁ Fivot Tables
Eﬁ Price Tables
Eﬁ Spedfications Tables

- Details

Select Cancel

3. Browse or search for the relevant table type, and then click Select. The table type appears in the Tables list on
the Tables tap.

You can now create basic tables with the Create Table wizard or more advanced tables where you start with an
empty table, and then specify the contents and settings of the table. For more information, see the following topics:
Using the Create Table Wizard and Creating Advanced Tables.

Using the Create Table Wizard

When you create a new table, the Create Table wizard guides you through a two-step process where you select
the products and attributes that you want in the table. You can make changes to the table later on if needed.

To learn about advanced features such as creating dynamic rows, table cells containing plain text or images, or
extracting product content dynamically, see the Content Definitions section of the Tables documentation.

Table Inheritance

Before you create a table, consider carefully where in the product hierarchy you want to create the table. The
creation point is important because tables are inherited downwards in the hierarchy until you create a local
variation of the table. The local variation then overrides the inherited table.

This means you can create a table with a default look that applies to an entire catalog. You can then override that
table style with a different style for specific a section of that catalog. That section can, in turn, contain a third
variation of the table and so on.

Therefore, when you create a table that you want to use on many products, create the table close to the root of you
product hierarchy. If you are creating a table that will only be used on a few or a single product family, select a
definition-point close to or on the actual product family level. For more information, see the Understanding Table
Inheritance section of the Tables documentation.

To Create a Basic Table

1. Inthe Tree, expand the Primary Product Hierarchy, and then select the product or product group where you
want to create the table.
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2. Clickthe Tables tab, right-click a table type, which must appear as "not defined", and then choose Create
Table. The Create Table wizard appears.

FE] Create Table I&1

Steps Select Products

1. Select Products [ﬁearch

2. Select Attributes
=151 Market Publishing Offers -
@ 12 Gallon Holiday Flip-Top Tote — 12 Gallon Holiday Flip-Top Tote
@ 20-Gallon Holiday Tote — 20-Gallon Holiday Tote
(37 300-Light Icide Set — 300-light Icide Set
@ FLight Vanity Sconce — Commerdial Electric 3-Light Vanity Sconce
0 3-Outlet Stake — 3-Outlet Stake
R 50" Extension Cord — 50' Extension Cord|
@ 56-Quart Holiday Storage Tote — 56-Quart Holiday Storage Tote
A7 Air Filter — Air Filter
@ Alurninimurn Extension Ladder — Aluminimum Extension Ladder
(37 Anderson Windows — Anderson Windows
(A Cadet Bath Faucet — Cadet Bath Faucet
38 Carbon Monoxide Alarm — Carbon Monoxide Alarm
ﬁi Ceiling Light — Plafonnier
@ Eco Light Bulbs — Eco Light Bulbs
@ Elongated Toilet Kit — Elongated Toilet Kit
@ Folding Door — Porte pliante
ﬁ] Garage Door Opener — Ouvre-porte de garage

m

i@ Products in rows Type Header -

(7 Products in columns Type |First Column

3. Instep 1, Select Products, you select the products you want in the table. You can browse or search for
products in the product hierarchy, and you can select one or multiple products. It is possible to select products
that are located at different levels in the hierarchy than where you are creating the table.

4. Next, you specify whether you want a horizontal table or a vertical table.

» Click Products in a row if you want to create a standard horizontal table where the information that relates
to a specific product is placed across a single row. Then, in the Type list, choose the row type you want to
use for the product row. The available row types depend on how your system is set up.

-OR-

« Click Products in columns, if you want to create a vertical table where the information that relates to a
specific product is placed in single column. The column is read from top to bottom. Then, in the Type list,
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choose the column type you want to use for the product column. The available column types depend on how
your system is set up.
5. When you have made the preferred selections, click Next.

6. Instep 2, Select Attributes, you select the attributes you want in the table. You can browse or search for
attributes in the attributes hierarchy, and you can select one or multiple attributes. You can also click Legal
Attributes to limit the list to the attributes that are valid for the products you have selected.

7. Inthe Type list, select the column type or row type you want to use for the attributes. Column type are for
horizontal tables and row types are for vertical tables.

FE] Create Table @1

Steps Select Attributes
1. Select Products -
Bruwse Search || Legal Attributes
2. Select Attributes [ ”

Ly LSty

=51 All Kinds OF Attributes

£ Multi Valued Attributes
ID__I Multi Valued Hard LOVs
Ic:l Multi Valued Medium LOVs
ID:I Single Valued Attributes
E Single Valued Hard LOVs
-3 Single Valued Medium LOVs
- ----- [T (MetaPortalMandatory)

m

=3 All Kinds OF Attributes LD
-2 Multi Valued Attributes LD
-[£31 Multi Valued Hard LOVs LD
-[£31 Multi Valued Medium LOVs LD
-7 Single Valued Attributes LD
-7 Single Valued Hard LOVs LD
-7 Single Valued Medium LOVs LD
~[|T blob text (sin val med lov) 1d
JI date (sin val med lov) Id i

Type :First Column -

Back Mext [ Einish H Cancel

8. Ifyou click the Legal Attributes tab, you have to choose which attributes you want to see.

« Choose All Legal Attributes to view all attributes that are valid for the selected products.

« Choose Linked Local to view all attributes that are linked to the selected products.
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'l |
E] Create Table ﬁ
Steps Select Attributes
L. Select Products [ Browse ” Search l Legal Attributes
2. Select Attributes - »
Linked Local - Selected
Brand Namm_ Add
cColour All Legal Attributes
Add all
Type :First Colurmn v:
Back Mext Einish
L

9. When you have selected all the relevant attributes, click Finish. A table is created with the selected products
and attributes.

Creating Advanced Tables

If you want to create more advanced tables, you can start with creating an empty table where you then define the
content of the columns and rows by specifying column and row content definitions.

Some of the content definitions extract the content dynamically. This is useful, for example, when you want to use
commercial data from a publication dynamically.

To Create an Advanced Table

1. Inthe Tree, expand the Primary Product Hierarchy, and then select the product or product group where you
want to create the table.

2. Clickthe Tables tab, right-click a table type, which must appear as "not defined", and then choose Create
Empty Table. An empty table grid with one free text cell is created.

[N | Proview |

Frice table 1

First Column

abe Free Text

|1 ?b—(eader abe Free Text | |
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3. Next, define the column and row content of the table. Right-click ** % ™t o a column or a row, and then

click Edit. The Row/Column Type & Content Definition dialog box appears.

F -
E] Row/Ceolumn Type & Content Definition ﬁ
Column/Row Content definition ;Free Text -
Commercial data aspect -
Current Ohiject
Date Spread Commerdal data b
First Subproduct, Classification ‘ = ‘

First SubProduct, Family B

Leqal Attributes
Meta Data Attribute -

4. Select the relevant content definition, make the preferred changes to each row or column type and content
definition, and then click OK.

The available content definitions are described in the following section of this documentation, Content
Definitions.

Creating Tables from Clipboard

If you want to create a table based on, for example, a tab separated list of data from Excel, you can copy and paste
the information in to STEP.

1. Inthe Tree, click a Product or a Classification, and then click the Tables tab.

2. Right-click the Table Type, and then click Create Table From Clipboard.

The content from the Clipboard is pasted into the table.

Content Definitions

The following content definitions are available for STEP Tables. Content definitions determine what content
appears in table rows, columns, and cells. The below table gives a brief overview of each content definition and a
link to more details in following sections of the STEP Tables documentation.

Content Definition Description

Asset Points to a specific image or asset.

For more information, see Asset Content Definitions

Asset Reference Inserts an image or asset based on the selected asset type.

For more information, see Asset Content Definitions

© Stibo Systems - Confidential - STEP Trailblazer 8.2 51



StiboSystems

Content Definition Description

Attribute Displays an attribute for the selected object.

For more information, see Attribute Content Definitions

Attribute Group Attributes Extracts all attributes in a group.

For more information, see Attribute Content Definitions

Blank Inserts a blank row or column.

Commercial Data Includes terms from a commercial list.

For more information, see Commercial Data Content Definitions

Commercial Data Aspect Includes a date aspect from the data field of a commerecial list.

For more information, see Commercial Data Aspect Content
Definitions

Current Object Extracts or resolves an object based on where the user of the DTP
application decides to extract a table. You cannot point the Current
Object row to a specific object. If you, for example, mount a table on
the product 123-123 in InDesign, the current object resolves to 123-
123.

In a horizontally read table, a current object row type is typically used
with Attribute or Asset Reference column types to display selected
attributes for the products in the rows.

Date Spread Commercial Uses commercial data from a publication dynamically.
Data
For more information, see Commercial Data Aspect Content
Definitions
First Subproduct, Returns information from the first child (subproduct) of a selected
Classification classification.
First SubProduct, Family Similar to 'First Subproduct, Classification.' Returns information from

the first child (subproduct) of a selected product family.

Free Text Enables you to enter free text content directly in table cells. Free text
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Content Definition Description

is used where no suitable attribute exists, or where you want to be
able to enter specific data. Free text cells take priority over any
selections made at the row or column level.

Free text cells can be translated if the table type is language
dependent. For more information, see Configuring Table Type
Settings and Formatting

Legal Attributes Dynamically resolves legal attributes of the extracted products.

For more information, see Attribute Content Definitions

Meta Data Attribute Functions like the Attribute content definition except it can display an
attribute that is defined on a reference. This will only display the value
on a reference when the opposing row or column is using the Node
Reference content definition (as opposed to the Referenced Node
content definition).

Node Reference Extracts values from a referenced product, classification, or asset
where the reference is owned by a configured product, classification,
or asset.

Parent Extracts the parent product up a specified number of levels in the

product hierarchy.

Parent Name Displays the name of the parent product of the product that is inserted
in the table.

For more information, see Product Content Definitions

Product/Classification/Asset | Enables you to select a specific product, classification or asset.

For more information, see Product Content Definitions

Referenced Node Extracts values from a referenced product, classification or asset.

For more information, see Product Content Definitions

Sub-classifications, Extracts classifications that are children of the current classification or
Classification a configured classification.
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Content Definition Description

Subproducts, Classification | Extracts product families manually by pointing to any level in the
classification hierarchy or dynamically from the level where the table is
defined.

For more information, see Product Content Definitions

Subproducts, Family Extracts products by pointing to any level in the product hierarchy or
dynamically from the level where the table is defined.

For more information, see Product Content Definitions

Attribute Content Definitions

The Attribute content definition inserts an attribute for the selected object in the table. The Name and ID of an
object is also considered an attribute. You can apply content definitions for individual attributes as well as for
attribute groups.

In a horizontally read table, an attribute column definition is typically used with rows of the types SubProduct,
Classification, Current Object, Product/Classification/Asset, SubProduct, or Family.

1. On the Table tab, right-click ** 7= ™ on a column or a row, and then click Edit. The Row/Column Type &
Content Definition dialog box displays.

2. Inthe Column/Row Content definition dropdown list, select Attribute.
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3. Select the attribute that you want to insert in the table.

4.

P

m Row/Column Type & Content Definition

Column/Row Content definition :httribute
! | Mame
@ D

) Attribute | Value & Unit

[ Search ” Legal Atfributes

=0 Attribute Groups
. E-EJ ATTGroup

- [ air gauge included
-[I3 Hose length
~[I3 Primary Color

+[]3 Short Description

== Details

Default Attribute

Transformation

Append -A

111

=
=

’ 0K ” Cancel ]

the ID of the product is inserted in the table.

« Value - Only values are resolved.

« Unit - Only units are resolved.

« Select Attribute to insert a specific attribute in the table.

« Value & Unit - Attribute values and units are resolved in the defined order.

© Stibo Systems - Confidential - STEP Trailblazer 8.2

StiboSystems

« Select Name to insert the object names in the table. If Name is inserted in a column, and the row extracts a
product, then the name of the product is inserted in the table.

« SelectID to insert the object IDs in the table. If ID is applied to a column, and the row extracts a product, then

If you select Attribute, specify how to resolve the attribute. You have the following options.

« Unit & Value - Attribute values and units are resolved in the defined order. Units are resolved before values.
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5. Search or browse for the relevant attribute or click the Legal Attributes tab to view only the attributes that are
legal for the selected product.

6. To apply an attribute transformation, under Transformation, click the ellipsis button (...). The Select
Transformation dialog opens.

P "

E] Select Transformation @

MewProductyM
Append -A
UOM Print
ExclusiveyN

I oK H Select None H Cancel

7. Select the relevant transformation.

For example, if you have selected a multivalued attribute, you can apply a transformation that specifies how to
separate the values should be separated.

For more information about applying attribute transformations, see the Applying Attribute
Transformations to Tables section of the STEP Tables documentation.

8. Click OK.

Legal Attributes Content Definition

The Legal Attributes content definition limits the number of available attributes to attributes that are legal on the
selected object, and to enable additional limitation options. This option also enables you to specify how to sort the
attributes.

9. Inthe Column/Row Content definition list, select Legal Attributes.
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m Row/Column Type & Content Definition @

Column/Row Content definition |Legal Attributes i w

Include Attributes from Classifications
¥ | Only non empty Rows/Columns
Maximum number of Rows/Columns |10

Sort on: | Attribute Name » | || Exclude if empty

| Ok || Cancel

10. SelectInclude Attributes from Classifications if you want to include attributes on classifications.

11. Select Only non empty Rows/Columns if you want to resolve only attributes with values.

12. Inthe Maximum number of Rows/Columns field, enter the maximum number of attributes to be resolved.
13. Fromthe Sort on list, select the relevant sort option.

Important: The available sort options depend on how attributes are setup. If the functionality is not available,
contact Stibo.

7. Select Exclude if empty if you want to sort only attributes that have a sorting sequence.
8. Click OK.

Attribute Group Attributes Content Definition

The Attribute Group Attributes definition enables you to select an entire group of attributes and add them to a
table in one operation. So, if you assign a column to an attribute group that contains six individual attributes, six
columns are created in the table (unless limiting options are applied; see the steps below for more information).

The Attribute Group Attributes content definition extracts all attributes in a group dynamically. Therefore, if new
attributes are added to the attribute group in System Setup after the table has been created, columns or rows for
these attributes are created dynamically.

In a horizontally read table, an Attribute Group Attributes column definition is typically used with rows of the types
SubProducts, Classification, Current Object, Product/Classification/Asset, SubProduct, or Family.

1. While on the Definition tab, right-click in the content definition cell (for example, ** == 7= on the column or

row that you would like to edit, then click Edit. The Row/Column Type & Content Definition dialog box
displays.
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. Inthe Column/Row Content definition list, select Attribute Group Attributes.

Column/Row Content definition | Attribute Group Attributes

Full 9 :‘I.I'alue

E] Row/Column Type & Content Definition o @

=--E3 tem Maintenance
: i 3 tem Brand Information
e El I‘:'_:“I [tem Description Information|
[If Base Unit of Measure
[ pescription Source
[ Description Target
T Exclusive?
~-[]¥ Family Description

== Details

] Apply Recursively

T Limit Attributes (to only legal attributes and...)
8 [ | Include Attributes from Classifications

o] Only non empty row/columns

1} Maximum number of rows/columns |10

BB Sort on :Table Sort Order

v: Exclude if empty

Transformation 6 B

@[ 0K ” Cancel
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. Inthe Pull dropdown list, select what content should be displayed for each attribute. Available options are:

Value & Unit
Unit & Value
Value

Unit

LOV Value ID

. Browse or search for the relevant attribute group. (You may need to create a new group just for this purpose.)
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To apply an attribute transformation, click the ellipsis button (...) next to the Transformation field. The Select
Transformation dialog displays.

P "

E] Select Transformation @

MNewProductyN
Append -A
UOM Print
ExclusiveY

| oK || Select None || Cancel

Select the relevant attribute transformation for the group. For example, you may need an attribute
transformation to:

« convert the fractional numbers into true fractions

« remove the space between the numbers and units for both imperial (for example, inches) and metric (for
example, mm) units

« apply a transformation that specifies how to separate the values if there are multivalued attributes in the
selected attribute group

Only one attribute transformation can be applied to the group. But, a single attribute transformation can contain
multiple transformations, so it is possible to apply all of the transformations that you might require.

Note: The attribute transformation applied to the attribute group in this step should not have previously been
made valid on any attribute or attribute group, including the group to which it is being applied in the table. If the
transformation is valid on any attribute or attribute group, it will not appear in the Select Transformation dialog.

For more information about applying attribute transformations, see the Applying Attribute
Transformations to Tables section of the STEP Tables documentation here.

6. Select Apply Recursively to apply the transformation.

7. SelectLimit Attributes (to only Legal attributes and...) so that only attributes that have been made legal

10.

11.

for the specific products included in the table will be included as columns in the table. Selecting this also makes
more limitations available.

Select Include Attributes from Classifications to include specification attributes that are inherited from
classifications.

Select Only non empty rows/columns so that attributes without values will not be included as columns in the
table.

In the Maximum number of rows/columns field, enter the maximum number of rows / columns to include. A
number is required; if this left blank, the value defaults to 0.

From the Sort on list, select the relevant sort option.
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The best practice for this option is to create a special 'table sort' attribute that is exclusively used for sorting
rows and/or columns created using the Attribute Group Attributes content definition. For more information, see
the Controlling the Attribute Order in 'Attribute Group Attributes' Within Tables section of the Tables
documentation.

12. Check Exclude if empty to include only attributes that have a sorting sequence entered. In other words, any
attributes (even if they have values entered) without a value in the selected sorting sequence (‘table sort’)
attribute will NOT be displayed. If this box is not selected, those attributes without an entry in the sorting
sequence attribute will be included at the end in alphabetical order.

13. Click OK.

Controlling the Attribute Order in 'Attribute Group Attributes’ Within Tables

Understanding the control mechanisms available for the Attribute Group Attributes content definition in tables
will help explain why you need to create a special 'table sort' description attribute to control the order of rows
and/or columns created dynamically from an attribute group.

Though a standard 'attribute display sequence' attribute can be used to sort table rows and columns created from
an attribute group, this approach is not ideal when different attribute sequencing is needed for different product
categories. Due to this, a special 'table sort' attribute should be created to control the sequencing.

| Images & Documents || Commercial ]I Category Profile " Proof View ” Status " State Log ” Tasks ]

| Product || Product Variants ” Sub Products ” References ”_
 Tables
Marme > |Defined At S
Row/Column Type & Content Definition
> |Price Table Local m / P @
» |Specification Table_Dim Dep Local

Column/Row Content definitich iEAttribute Group Attributes vi

* |Add Table Type ] :

Price Table 1 Br

Iormal
Search

Cw Item Description Information

& Advanced B=
1 *Header ‘JI Table H...
2 >MNormal G Local Name
Transformation B

[ ] Apply Recursively
Limit Attributes (to only legal attributes and...)

[] include Attributes from Classifications

\ Only non empty row/columns

Maximum number of rows/columns (10

Sort on :Table Sort Order v: Exclude if empty

0K Cancel
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The steps in this topic assume the following:

« You have created a table type and legalized it

« You have created a table and are working on creating a column / row content definition of Attribute Group
Attributes (see the Attribute Content Definitions section of the Tables documentation for more
information)

« You have an understanding of how to create and populate attributes

Creating a Table Sort Description Attribute

1.

5.

In System Setup, navigate to the attribute group in which you would like to create the new description attribute,
then right click and select New Attribute.

In the Create Attribute dialog, give the attribute an ID and Name (for example, 'Table Sort Order'), then select
Number for Validation Base Type and No for Multi Valued. Click Next.

Click Next two more times to bypass the screens for steps 3 and 4 of the wizard. (No validation rules or units
are needed for this attribute.)

In step 5 (Valid For), expand the Valid for Link Types flipper and tick the Product attribute validation box.
(Also tick Classification attribute validation if you intend to link any of your attribute group attributes to a
classification.) Click Next two more times to skip to step 7.

£3] Create Attribute @
Steps Valid For
1. Select Attribute Group = Valid for Product Types -
2. Enter ID and Name = valid for Classification Types
3. Enter Validation Rule ©-Valid for Asset Types
4, Select Unit(s) ©-Valid for Entity Types
5. valid For = valid for Publication Types

= valid for Version Types
= valid for E-Catalog Types
T valid for Link Types

All

m

6. Apply Dimension Dependencies

7. Link to Hierarchy

Classification attribute validation

v | Product attribute validation

®-valid for Product Reference Types
®-valid for Classification Reference Types 7

| Back || MNext || Finish || Cancel

Link to the Primary Product Hierarchy, then click Finish.
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Populating Values for the Table Sort Attribute

Before the 'table sort' attribute can be used in your table, it must contain values. There are three ways to populate
values for this attribute:

1. Manually enter values on the References tab of the relevant specification attributes within the attribute group
that is being used in the table

2. Manually enter values on the References tab of the product(s) used in the table (values may be entered at a
higher level of the product hierarchy in order to inherit to products below)

3. Import values using a STEPXML file

Note: Because the 'table sort' attribute is not valid for the Attribute object type (unlike a standard 'display
sequence' attribute used to sort attributes in the workbench), the table sort attribute cannot be modified from the
Attribute tab of the attributes that are being used in the table.

Itis recommended to initially set a sequence by using 10, 20, 30, and so forth. To add attributes in between later,
you can then use 15, 25, 35, etc.

Editing from the Attribute Group

1. In System Setup, navigate to the attribute group that you intend to use in your table, then select the attribute
inside the group that you would like to edit. (Note: Only one attribute at a time can be edited using this method.)
2. Onthe References tab, expand the Valid in Products flipper.

3. Enter values for the table sort attribute. Values may be different for the different levels of the product hierarchy
to which the attribute is linked.

m Base Unit of Measure - References ]
-1 Dimensions A 1| Attribute Attribute Transformation || Validity || Profile || Log || State Log || Tasks

=6 Display
-3 Discontinued Product Maintenance = § Valid in Classifications
-3 Image and Document Maintenanc D * |Name ?
E—""E Item Maintenance > |Link to Classification Source fram Attribute
g (3 Item Brand Information ® Valid in Products
"E Item Description Information D * |Name » |Completeness Score  * Product Variant Prior. * Table Sort Order | *
~{|T Base Unit of Measure
T Description Source » 121166 Party Supplies 10
T Description Target * PProductsRoot Products 20
[If Exdlusive? T 1|2 Link to Product  Source from Attribute

i ' || inAftribiite Groups

Editing from the Product Hierarchy

1. Inthe Tree, navigate to the level (node) of the product hierarchy where you would like to populate the table sort
attribute.

2. Onthe References tab, expand the Linked Attributes from Product Hierarchy flipper.

3. Insert the relevant values for the table sort attributes. Multiple attributes can be populated at once from this
view.
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H
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&[5 Food and Beverage o AttributeB Attribute B
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[]__g Wedding ¥ Attributel Attribute C

=[] Party Supplies 4 Attribute Z Attribute Z

-] Party Hat:
EJ E-rg?ap:rsHats 75 » AvailabilityEnd Availability End
: --- Paper Hats vl - [AvailabilityStart Availability Start 4
Il Balloon Hats * 1 - [BaseUnitOfMeasure  |Base Unit of Measure 10
[+l Pet Hats v

4 m | b 715 - [BrandName Brand Name

If all tables in a particular product category (node) should contain the same column / row sequencing, then values
for the 'table sort' attribute should be populated at the highest level of the category in order to inherit to objects
below. However, inherited values for the 'table sort' attribute cannot be overridden at a lower level of the hierarchy
unless the attribute group attributes are linked to the lower level or values for the table sort attribute are imported
through a STEPXML import. For more information on linking attributes to nodes within the product hierarchy, see
the Linking Specification Attributes section of the System Setup / Super User Guide documentation.

Editing by STEPXML Import

When the attribute group attributes are linked to a higher level (node) of the product hierarchy, the field for the sort
attribute on the References tab is yellow on lower levels of the product hierarchy. This means that the table sort
order cannot be edited from this lower level, as shown in the following screenshot.

P Linked Attributes from Product Hierarchy

DisplaySequence *|ID * |Mame * |Completeness Score  * |Product Variant Prio... {[Table Sort Order
¥ AttrDescid (AttrDescid)
x AirTransportationRest... Air Transportation Restr

“

AnnualSalesForecast...

Annual Sales Forecast, B

“

AnnualSalesForecast,...

Annual Sales Forecast, B

“

AttributeA

Attribute A

¥ AttributeB Attribute B
¥ Attributel Attribute C
¥ Attribute Z Attribute Z
x ~ |AvailabilityEnd Availability End

“

AvailabilityStart

Availability Start

BaseUnitOfMeasure

Base Unit of Measure

10
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The field can become editable if the relevant specification attributes are linked to the level of the hierarchy where
you need to set the value of the table sort attribute. However, if this is not possible or not practical, a STEPXML
load will allow you to edit the table sort attribute value on all object(s) where the specification attributes are valid,
whether that was where they were linked or where the link has inherited to. In other words, this STEPXML load
will allow you to enter values into the yellow fields without having to manually relink the specification attributes to
various locations throughout a product hierarchy.

The following is sample XML that could be used to import a value into a metadata 'table sort order' attribute. The
ID of the table sort attribute in the following example is TableSortOrder.

<?xml version="1.0" encoding="utf-8"7?>

<STEP-ProductInformation ImportContext="English US" ContextID="Contextl" WorkspaceID="Main"
UseContextLocale="false">

<Products RejectNewProducts="true">

<Product ID="121168" UserTypelD="Level2" ParentID="121166"> <!--Sample node in the product
hierarchy-->

<Name>Party Hats</Name>

<AttributeLink AttributeID="BaseUnitOfMeasure"> <!--Category-specific specification
attribute linked to the node in the hierarchy-->

<MetaData>

<Value AttributeID="TableSortOrder">100</Value> <!--Table sort description attribute with
value of 100-->

</MetaData>
</AttributeLink>
</Product>
</Products>

</STEP-ProductInformation>

Commercial Data Content Definitions
Commercial Data enables you to reference commercial data from a publication in a table.

1. Onthe Table tab, right-click *** 7% ™! 51 & column or row, and then click Edit. The Row/Column Type &
Content Definition dialog box appears.

2. Inthe Row/Column Type & Content definition list, select Commercial Data, and then select the commercial
list that you want to include in the table.
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E] Row/Celumn Type & Content Definition I&

Column/Row Content definition :Commercial Data v:
:Prir_e -
Break-point Mo 1

() Mame

@D

i Price

() Minimum Quantity (71 Maximum Quantity
(7 Start Date i7) End Date

() Unit Mame () Unit ID

(7 Lead Time

(71 Lot Size

Transformation

3. Inthe Break-point No field, enter the value of the break-point number of the term that you want to reference.
4. Selectthe relevant term type from the available types.

5. To specify an attribute transformation that is applied when the commercial data is resolved, in the
Transformation field, click the ellipsis button (...). The Select Transformation dialog appears.

The dialog shows the attribute transformations that are valid for the selected attribute. You can, for example,
apply an attribute transformation that formats the price when a price in a commercial list is being resolved.

For more information about attribute transformations, see the Applying Attribute Transformations to
Tables section of the STEP Tables documentation.
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'l |
E] Select Transformation I&

Fraction Parser
Bariatric
Sapa_Multi_sep_comma
Price Format USD
Mew_Small

ReplaceText -
|| |SAPA_Change_Case

SAPA_LOV

Environmental friendly conversion
Canada

Extract all after hypen

code dash

Extract all before hypen -

m

[ oK H Mone H Cancel

L

6. Select the relevant transformation, and then click OK.

Commercial Data Aspect Content Definitions

The Commercial Data Aspect extracts a date aspect from the date field stored in the commercial price list of a
publication. This helps you to display, for instance, the name of a weekday without having to store this weekday
explicitly in STEP. For an example of how to use the Commercial Data Aspect, see the Advanced Price Table
Example section of the Tables documentation.

Important: For the Commercial Data Aspect content definition to work, you have to apply the Date Spread
Commercial RowColumn content definition in an opposite row or column.

1. On the Table tab, right-click ** 7% ™t 51 & column or row, and then click Edit. The Row/Column Type &
Content Definition dialog appears.

F -
E] Rew/Column Type & Content Definition ﬁ
Column/Row Content definition :Cummercial data aspect -
Value To Extract Start Date -
Date Aspect FM-BE-Y -

[ OK ] [ Cancel
L
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2. Inthe Row/Column Type & Content definition list, select Commercial Data, and then select the commercial
list that you want to include in the table.

3. Inthe Value To Extract list, select either Start Date or End Date, if you want to use a date aspect. Select
either Minimum Quantity or Maximum Quantity if you want to use a value aspect.

4. Inthe Date Aspect list, select the relevant date aspects. This is not relevant if you selected Minimum Quantity
or Maximum Quantity

Date Aspect Renders

MM-DD-YYYY 06-11-2016

Month 11

Year 2008

Short Month Name | Nov

Day 6

Weekday Thursday

Short Weekday Thu

Month Name November

Date Spread Commercial RowColumn

The Date Spread Commercial RowColumn content definition enables you to use commercial data from a
publication dynamically. If a single product has multiple prices for different time periods, a corresponding number
of rows with these prices can be created dynamically.

For each product in a table, Date Spread Commercial RowColumn pulls all prices in the commercial list, and sorts
them by time periods. For each time period, a row is created dynamically.

Important: Itis not possible to make Date Spread Commercial RowColumn rows and columns non-dynamic.

1. From the Column/Row Content definition list, select Date Spread Commercial RowColumn.
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E] Row/Celumn Type & Content Definition [&J

Column/Row Content definition | Date Spread Commercial data -

Price -

| CK || Cancel

2. Select the commercial list that contains the terms you want to include in the table, and then click OK.

Product Content Definitions
The following describes the content definitions that are related to the selection of products that you want in a table.
To select the products for a table, use one of the following definitions.

« Product/Classification/Asset: Use this when you want to select a specific product, classification or asset. This
selection is not dynamic.

« Subproducts, Classification: Use this when you want to extract all products that are part of specific
classification.

« Subproducts, Family: Use this when you want to extract all products contained within the selected level in the
product hierarchy.

Product/Classification/Asset

The Product/Classification/Asset content definition enables you to select a specific product, classification or asset.
The content selection is not dynamic and remains the same regardless of where the data is mounted in DTP
application.

If you select an asset, the asset is not displayed in the target cells. However, if you select Attribute/Name for the
column, you can specify that you want the name of the asset displayed in the cell.

Likewise, if you select a classification, you can let the target cells display the name or ID of the classification.

In a horizontally read table, a Product/ Classification/Asset row type is typically used with Attribute column types.
For example, if you want to display the name of the object or selected attributes on the object.

1. Onthe Table tab, right-click ** 72 ™t 51 & column or row, and then click Edit. The Row/Column Type &
Content Definition dialog box appears.

2. Inthe Row/Column Type Content definition list, select Product/Classification/Asset.

« Search or browse for the relevant product, classification or asset, and then click OK.
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E] Row/Celumn Type & Content Definition I&
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& & e .
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Subproducts, Classification
The Subproducts, Classification content definition extracts product families either manually from a specific level in
the classification hierarchy or dynamically from where the table is defined.

When you have selected a level in a classification, a row is inserted in the table for each product that the
classification contain. So if a classification contains eight products, eight rows are added to the table.

In a horizontally read table, a Subproducts, Classification row type is typically used with Attribute or Asset
Reference column types. You can, for example, use the Attribute column type to display selected attributes for the
products in the rows.

1. On the Table tab, right-click *** 72 ™! 51 & column or row, and then click Edit. The Row/Column Type &
Content Definition dialog box appears.

2. Inthe Row/Column Type Content definition list, select Subproducts, Classification.

3. Select Local Classification if you want to extract the product families dynamically. The sub-products are
added to the table depending on where the table is extracted.
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E] Row/Celumn Type & Content Definition ﬁ

Column/Row Content definition :Subprodur.ts, Classification

Browse m

& Advanced a=

Marne

[ ak ” Cancel

4. Alternatively, select Specify if you want to select a specific classification from where to extract the product
families. This selection is static, and remains the same regardless of where the table is extracted.

5. Search or browse for the relevant classification, and then click OK.

Subproducts, Family
The Subproducts, Family content definition extracts product families either manually from a specific level in the

product hierarchy or dynamically from where the table is defined.

When you have selected a level in the product hierarchy, a row is inserted in the table for each product that the
product level contains. So if a product level (family) contains eight products, eight rows are added to the table.

In a horizontally read table, a SubProducts, Family row type is typically used with Attribute or Asset Reference
column types, for example, if you want to display selected attributes for the products in the rows.

1. Onthe Table tab, right-click ** 72 ™ 51 & column or row, and then click Edit. The Row/Column Type &

Content Definition dialog box appears.
2. Inthe Row/Column Type Content definition list, select Subproducts, Family.
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3. Select Local Product if you want to extract the product families dynamically. The sub-products are added to
the table depending on where the table is extracted.

E3 Row/Colurm Fpe & contert et S|

Column/Row Content definition :"SubPruducts, Farnily -

i@ Local Product
(7 Spedfy

Browse m

@ Advanced =
[ Mame *

Level
[] Indude Intermediate Levels

Object Type :.ﬁ.JI Types -

[ Ok ][ Cancel

4. Alternatively, select Specify if you want to select a specific product level from where to extract the product
families. This selection is static, and remains the same regardless of where the table is extracted.

5. Optionally, enter the level from where you want the products to be extracted.
6. If youwant the intermediate levels to be included as well, click the Include Intermediate Levels checkbox.

7. Optionally, select an object type from the Object Type list, to limit the number of extracted products to a
specific object type.
8. Click OK.
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Parent Name
The Parent Name content definition inserts the name of the parent product of the selected product.
The parent name that is displayed comes either from the product or the classification hierarchy. Because product

can be linked to both a product hierarchy and a classification hierarchy, the parent name depends on whether the
product was inserted as a classification or a product.

1. Onthe Table tab, right-click ** 72 ™ 51 & column or row, and then click Edit. The Row/Column Type &
Content Definition dialog box appears.

2. Inthe Row/Column Type Content definition list, select Parent Name.

r -
E] Row/Column Type & Content Definition ﬁ
Column/Raow Content definition :Parent Marme v:

Transformation

]

[ Ok, H Cancel ]

3. Inthe Transformation field, click the ellipsis button (...). The Select Transformation dialog appears.

E] Select Transformation Iﬁ

Fraction Parser
Bariatric
Sapa_Multi_sep_comma
Price Format USD
Mew_Small

ReplaceText -
|| |SAPA_Change_Case

SAPA_LOV

| |Environmental friendly conwversion
Canada

Extract all after hypen

code dash

Extract all before hypen -

m

[ 0K H Mone H Cancel

4. Selectthe relevant transformation, and then click OK.
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For more information about attribute transformations, see Applying Attribute Transformations to Tables on
page 78.

Referenced Node

The Referenced Node content definition extracts values from a referenced product, classification or asset.

For example, if the product that you have created the table on has a product reference to another product , adding
a Referenced Node row type enables you to extract values from the referenced product.

1. Onthe Table tab, right-click ** 72 ™ 51 & column or row, and then click Edit. The Row/Column Type &
Content Definition dialog box appears.

2. Inthe Row/Column Type Content definition list, select Referenced Node.

3. Inthe Resolve list, select the relevant object type.

4. Fromthe Select Reference Type list, select the relevant reference type.

[ E] Row/Celumn Type & Content Definition [—Li-f
Column/Row Content definition :Nude Reference -
Resolve
:Prudur_t -
Select Reference Type
:P.Jternaﬁue product -

Reference number (0=All)

Search
-6 .

- g EJER_Product001

- gl EJER_Product002

- fgg EJER_Product003

- fgg EJER_Productd04

- gl EJER_Productdl

- g EJER_Productd2 il

-

2= Details

[ oK ” Cancel

5. Inthe Reference Number field, specify the number of the reference type to resolve. This field is only relevant if
there are more referenced objects with the selected reference type. You can leave the field empty.

6. Click OK.
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Asset Content Definitions

Two content definitions are used to display assets in STEP Tables: Asset and Asset Reference. In most cases,
assets that are displayed in tables are images.

Asset

Use the Asset content definition to point to a specific asset. This is not a dynamic content type.

The Asset definition is most often used at the cell level in combination with the Cell Override setting. This is
because, if applied to an entire column or row, an identical image will appear in every cell across the row or

column. Asset cells take priority over any selection that has been made at the row or column level with the
exception of Free Text.

Applying the Asset Content Definition to a STEP Table Row or Column

1. Inthe Tree, navigate to the product or classification that contains the table you would like to edit, then click the
Tables tab.

2. Under the Tables flipper, select the relevant table, then click on the Definition tab.

3. Right-click in the content definition cell on the column or row that you would like to edit, then click Edit. (In the
following screenshot, the content definition cell has a preexisting content definition of abe Free Text ).

 Tables

Marme > |Defined At
> |Price Table Local
> AhAd Tahla "ype

Price Table 1 » (2 |3

MNormal ormal ormal
abe Free Text 1T Product Na... [1I ID
Add Column Befare

1 >Header  IT Name Add Column at End
2 »Normal ‘Ea Local

Copy Columns
Paste Columns
Duplicate
Remove Column

Expand
Edit
Change Settings

4. The Row/Column Type & Content Definition dialog box displays.
5. Inthe Column/Row Content definition list, select Asset.
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£33 Row/Column Type & Content Definition @

4

Column/Row Content definition Free Text

Asset Reference
Attribute

Attribute Group Attributes
Blank

Commercial Data
Commercial data aspect
Current Object

[ | »

6. Browse or search for the preferred asset, and then click OK. Only one asset may be selected.

£33 Row/Column Type & Content Definition @

Column/Row Content definition ihsset vi

Search

E-{ ] Assets it
#-[T] Assets
=[] Icons
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-7 Dlustrations
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--rj Logos -
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l 0K ” Cancel

7. The Content Definition of the row or column is now set to Asset. The STEP Name of the asset (e.g.,
Trucklcon) appears in the Content Definition cell on the Definition tab.

8. The selected asset is visible in the table, both on the Definition tab and the Preview tab.

Price Table 1 jz j
Normal Mormal
TruckIcon I o
1 * Header [1F name JPar‘t No. J
2 *|Normal & Local u
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1211593-4

121182-A

Asset Reference

The Asset Reference content definition is also typically used to insert images into table cells. However, unlike the
Asset content definition, which only allows the selection of a specific asset, the Asset Reference content
definition is a dynamic content type.

The Asset Reference content definition is used to insert assets that are linked to products or classifications by an
asset Reference Type.

In a horizontally read table, the Asset Reference content definition is typically used in a table column in
conjunction with one or more table rows that use one of the following content definitions:

o Current Object

o SubProducts, Classification

o SubProducts, Family

» Product/Classification/Asset

Applying the Asset Reference Content Definition to a STEP Table Row or Column

1. Inthe Tree, navigate to the product or classification that contains the table you would like to edit, then click the
Tables tab.

2. Under the Tables flipper, select the relevant table, then click on the Definition tab.

3. Right-click in the content definition cell on the column or row that you would like to edit, then click Edit. (In the
following screenshot, the content definition cell has a preexisting content definition of abe Free Text ).
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4. The Row/Column Type & Content Definition dialog box appears.
5.

 Tables
Mame
> |Price Table
> AhAd Tahla "ype

> |Defined At
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Price Table

1 *Header ST Hame
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In the Column/Row Content definition list, select Asset Reference.
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Copy Columns
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Duplicate
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Edit
Change Settings

Select Reference Type

E] Row/Column Type & Content Definition

Column/Row Content definition :Asset Reference

EX5

-

iEPrimarv Product Image

[ Extract all

[ OK H Cancel

StiboSystems

Inthe Select Reference Type list, select the relevant reference type (for example, Primary Product Image).

Check Extract All to extract all referenced images of the selected type. This is only relevant if a product or
classification has multiple images referenced using the same Reference Type. If there are multiple images

referenced, all of the images will be inserted into the same table cell.
8. Click OK.

9. The content definition of the row or column is now set to Asset Reference. The STEP Name of the asset

reference type (e.g., Primary Product Image) appears in the content definition cell on the Definition tab.
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Price Table 1 > (2

W

MNormal hormal

/7 Primary Product Image || Product Name

1 *Header ST Hame Product Name
2 *|Normal ‘Ea Local h

10. The referenced images / assets appear in the table on the Preview tab.

Definition w

Select version iAcme Party Supplies_comr

Product Name
Christmas Party Hat

iif=
it =

G

Cosmic Party Hat

F .
o
® 4

Pink & Green Party Hat

Pink & Green Pom-Pom Hat

Political Party Hat

Purple & White Party Hat

ZHE">

For More Information

For more information on the Cell Override setting, which is typically how the Asset content definition is applied to
table cells, see the Modifying Tables section of the STEP Tables documentation.

For information on how to control the sizing of images in tables, see the Formatting Tables section of the STEP
Tables documentation.

Applying Attribute Transformations to Tables

An attribute transformation performs a task on an attribute such as inserting a prefix or converting periods to
commas. You can apply attribute transformations to attributes in a table.

You can apply attribute transformations to the following rows or columns.
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Icon Description

13 Attributes, Object Names and Object IDs

T Attributes in an Attribute Group

& Commercial Data

To Apply Attribute Transformations
1. Inthe Tree, click the relevant product, and then click the Tables tab.
2. Click the relevant table, and then click the Definition tab. The table definition appears.

3. Right-click one of the row or column icons, and then click Edit. The Row/Column type and content
definition dialog appears.

P

-

E] Row/Column Type & Content Definition @

Column/Row Content definition :httribute v:
'.:_.' MName

@ D

©) Attribute | Value & Unit -

[ Search ” Legal Atfributes

=0 Attribute Groups
=+E0 ATTGroup

------ % Air gauge included

1]

------ [ Hose length

------ % Primary Color

== Details

Default Attribute

=
Append -A [;]

’ 0K ” Cancel ]

Transformation
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4. Inthe Transformation field, click the ellipsis button (...). The Select Transformation dialog appears.

P o

m Select Transformation @

MewProductyM
Append -A
UOM Print
Exclusive

| oK || Select None || Cancel

5. Select the preferred attribute transformation from the list, and then click OK. The transformation is applied to
the selected attribute.

Only attribute transformations that have been specified in System Setup are available. For more information,
see the Attribute Transformations section of the in the System Setup / Super User Guide
documentation.

To Remove Attribute Transformations

« Inthe Select Transformation dialog, select None.

Modifying Tables

This topic explains how to make changes to cells, rows, and columns in a table. Also described is how to override
content definitions; add, delete, and resequence columns and rows; copy and paste columns, rows, and cells; and
how to span or merge multiple table cells.

To Override Content Definitions

Row content definitions and column content definitions can be overridden at the cell level. Content definitions
specify the type of content that appears in a row or column. To override row or column definitions at the cell level,
follow these steps:

1. Inthe Tree, navigate to the Product or a Classification that contains the table you wish to edit.

2. Clickthe Tables tab, then expand the Tables flipper and select the relevant Table Type. The table displays.

3. Onthe table Definition tab, right-click inside the cell(s) that you want to edit, and then choose Edit. The
Override Cell dialog displays. Here you can override either the row or the column contents definition or both.
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Column Type
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Column/Row Content definition | None x|
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4. Select the preferred content definition, and then click OK. The dialog changes according to the content

definition you have selected.

For information about the available content definitions and how to set them up, see the Content Definitions

section of the Tables documentation.

To Remove Cell Overrides

1. Toremove a cell override, follow steps 1 - 3 above.
2. Inthe Override Cell dialog, choose None from the desired Column/Row Content definition dropdown list.

3. Click OK.

To Add Rows or Columns

1. Inthe Tree, navigate to the Product or Classification that contains the table you wish to edit.
2. Clickthe Tables tab, then expand the Tables flipper and select the relevant Table Type. The table displays.
3. Onthe table Definition tab, right-click a row or a column and then choose where you want to create the new

row or column. The Row/Column Type & Content Definition dialog displays.

You can create columns and rows before the current column or row or as the final row or column of the table.

m Row/Column Type & Content Definition

Column/Row Type Normal

=5

-

Column/Row Content definition _Eﬂsset

iw

Browse m

& pdvanced

Name

Search
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4. Inthe Column/Row Type list, select the relevant type.

5. Inthe Column/Row Content definition list, select the relevant content definition.

6. Click OK to add the row or column.

To Duplicate Rows and Columns
1. Right-click a row or a column and then select Duplicate.

2. A duplicate of the source row or column appears directly to the right of the source column or beneath the
source row.

Any local formatting applied to the source row is also applied to the duplicate row or column.

To Copy and Paste Rows, Columns, and Cells
Rows, columns, and cells may be copied and pasted within the same table or from one table to another table.

1. Select the row, column, or cell that you would like to duplicate, then right-click and select the applicable option
from the menu:

o CopyRows

o Copy Columns

« Copy Cell Overrides
» Copy Cell Settings

2. Selectarow, column, or cell in the destination location, then right-click and select the applicable option from the
menu:

« Paste Rows
« Paste Columns
» Paste Cell Overrides
« Paste Cell Settings
3. The copied row is pasted beneath the destination row. The copied column is pasted to the right of the

destination column. The copied cell overrides or cell settings are pasted directly into the destination cell and
overwrite the destination cell.

To multi-select rows or columns, click on the content definition cell of the row or column and hold the Shift or
Ctrl key while making selections.

Price Table 1 » (2 (3 > |4 >
Normal Shormal Shormal Sprice
1T Product Name [JT ID 7 Primary Prod... 35 Price
1 *|Header 0T name Product Name N
2 *|Normal ‘I_?;’, Local h h h
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Considerations for Copying and Pasting From One Table to Another
When copying and pasting rows, columns, and cells from one table to another, keep in mind the following:

« Any formatting settings (text, color, rules, etc.) applied to the source row, column, or cell will be copied along
with it to the destination table

« Ifthe pasted row or column uses a row type or column type that is not valid in the destination table type,
the row type / column type will display in red, as seen in the below screenshot. In this instance, either the
column type must be changed in the destination table to a column type that is valid for the destination table
type, or the column type itself must be made valid for the destination table type.

P Tables
Name * |Defined At >
* |Price Table Local
* Specification Table_Dim Dep Local
* |Add Table Type
Specification Table_Dim Dep 1 (2 |3 >
Spec Column ‘_Spec Column h
o [1F Product Mame &5 Price
h

1 >[SpecRow |abe Free Text| [Heading text
2  »|SpecRow |k Free Text| |Subheading text h
3 *|Spec Row ‘Ef‘;*, Local

To Remove Rows and Columns
« Right-click a row or a column and then select Remove Row or Remove Column.

To Expand Rows and Columns
This option only applies to rows or columns with the following dynamic objects:

« Subproducts, Classification

o SubProducts, Family

« Attribute Group Attributes
When you expand a column or row, the column or row is no longer dynamic. The content of the column or row
remains as it is even if more products are added to the product family.

« Right-click a row or a column and then select Expand.

Note: You cannot expand dynamic rows created using the Date Spread Commercial RowColumn definition.

To Edit Content Definitions
« Right-click a row or a column, and then select Edit.

Use this option to specify content definitions at cell level if you want a cell to have different content than other cells
in the row or column.
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For more information about content definitions, see the Content Definitions section of the Tables
documentation.

To Change the Sequence of Columns and Rows
Columns and rows can be resequenced within a table using drag and drop.

1. Inthe Tree, navigate to the Product or a Classification that contains the table you wish to edit.
2. Clickthe Tables tab, then expand the Tables flipper and select the relevant Table Type. The table displays.

3. Onthe table Definition tab, select the column or row that you want to move by clicking on its number.

Price Table Fz NE Ta §
ormal Nnormal Shormal Price

(1 Product Name [JI ID 2 Primary Prod... &5 Price

1 » Header NIT name Product Name
2 »|Normal ‘Cf‘;a Local

4. Drag the column or row to its new location.

To Span Cells

Two or more cells may be merged into one by using the span option. When cells are spanned (merged), the cell in
the upper left corner will span the full area and overwrite content in all other cells in the spanned area.

1. While viewing your table on the Definition tab, select the cells that you want to span.

2. Right-click, and then select Span.

To Remove Spans

« Right-click anywhere within the spanned area, and then click Remove Span(s).

To Suppress Tables
You can suppress inherited tables, but table that are created locally cannot be suppressed.

1. Inthe Tree, click a Product or Classification, and then click the Tables tab.

2. Right-click the Table Type that you want to suppress, and then click Suppress Table.

To Unsuppress Tables
You can unsuppress tables if required.

1. Inthe Tree, click a Product or Classification, click the Tables tab.

2. Right-click the Table Type that you want to unsuppress, and then click Remove Suppression.
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To Delete Tables
1. Inthe Tree, click a Product or Classification, and then click the Tables tab.
2. Right-click the table you want to delete, and then click Delete Table.

The table is deleted, and the text under the Defined At column turns into Not Defined.

Table Header Attributes Best Practice

Creating a description attribute that is valid on attributes—and exclusively used for creating table header values—
is a best practice when generating table headers. Using this type of attribute is a more flexible and dynamic way to
generate table headers instead of using non-dynamic free text or cumbersome transformations to change an
attribute name into a value suitable for a table header. Free text is too easily removed or edited by a workbench
user, and language translation is difficult to set up and maintain.

In addition, such an attribute can be used in product templates if table headers must be placed onto the template
instead.

The instructions in this topic assume the following:

« You have created a table and understand how to define content definitions.

« You have an understanding of how to create and populate attributes.

Example Table Using a Table Header Attribute

In this basic example, the table has four columns containing specification attributes, each with a content definition
of Attribute. The header row is using a content definition of Meta Data Attribute.

Price Table 1 (2 |3 > |4 >

Mormal Snormal Srormal Normal
1T Product Name (I Primary Color || Short tem Description |1 Long Ttem Description

1 *|Header NIT Table Header Name Color Summary “Tpetails
2 *|Normal & Local h h h

The values in the header row—Name, Color, Summary, and Details—are populated by the values of a description
attribute named 'Table Header.' This attribute is valid on the Attribute object type.

If attribute '"Name' were used instead of 'Table Header' for the header row's content definition, then the names of
the attributes would be pulled for the values instead—Product Name, Primary Color, Short Iltem Description, and
Long Item Description. In all likelihood, these would not be the preferred values for the column headers.
Creating a Table Header Description Attribute

1. In System Setup, navigate to the attribute group in which you would like to create your attribute, then right-click
and select New Attribute.
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In the Create Attribute dialog, give the attribute an ID and Name (for example, 'Table Header'), then select
Text for Validation Base Type and No for Multi Valued. Click Next.

Provide a Maximum Length that aligns with the typical number of characters currently used as a column header
in step 3 (Enter Validation Rule). This will probably be around 30 or 40 characters rather than the default 100.

Click Next two more times to bypass the screens for steps 4 and 5 of the wizard. (As this attribute will only be
valid on attributes, there is no need to make it valid on product types. However, you may later make it valid on
additional objects if a need arises.)

In step 6 (Apply Dimension Dependencies), choose Country and/or Language if you want the values of this
attribute to be translatable.

Click Finish. No additional steps are needed, as this is a description attribute valid only on attributes.

Applying Attribute Validity to the Table Header Attribute

1.

Next, navigate to the Attribute object type, located in System Setup > Object Types & Structures > Basic
Object Types > Attribute Group > Attribute.

2. Onthe Object Type tab, expand the 'Valid Attributes' flipper, then click Add Attribute.
3. Inthe'Please Select Attribute' dialog that displays, browse to or search for the table header attribute that you

just created, then click Select.

The table header attribute is now valid on attributes.
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Populating Values for the Table Header Attribute

Now that the table header attribute is valid on attributes, you will see it appear under the Description flipper on all

attribut

es.

In System Setup, navigate to the specification attributes that you will be using in your table.

header for this attribute.

attribute named 'Short Item Description.'
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4. Now, onthe table, the value of 'Summary' appears as the header for the 'Short Iltem Description' column.

Price Table 1 jg jg > g >
Normal Normal MNormal MNormal
(13 Product Name [T Primary Calor [IT short Ttem Description [ Long Ttem Description
1 *Header ‘l]I Table Header Mame Color Summary etails
2 »|Normal & Local

Standard Price Table Example

The following is an example of a standard price table with basic information. The table is a horizontal price table
with different attributes assigned to each column.
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Definition | previgw

Order Table Style 1 |
Order Col Marmal Crder Col Mormal Order Cal Marmal order Col Mormal
JI Matme 0 _I Manufacturer P@;?J Primaty Image e JI P1 e_|
Tahle Head !JI hame 6 ‘ 'JI Rraduct Code Wanufacturer Part M. P1
| | Product Code o
Product Row E__‘, Local @ | ---------------- __|

The following are the key parameters of this table:

(1) Column 1 displays the value of the attribute Name. In the table, the name of each product that the system
creates a row for is displayed.

(2) Column 2 displays the value of the attribute Manufacturers Part No.

(3) Column 3 is an asset reference column. If a product has an image that is linked as a primary image, the
physical image is displayed in this column.

(4) Column 4 is price attribute column that displays the price P1.If a product has a value for this attribute, it is
displayed in this column.

(5) The first row is a header row.The header row is defined as the attribute Name. This creates a header row
that contains the names of the attributes assigned to the columns.

(6) Below the header row are the actual product rows. The row type is specified as SubProduct. When this
row type is used, one row is inserted for each child-product of the family product.

(7) This cell contains a local cell override. This override means that in this column the name of the attribute
Product Code is displayed instead of the Name attribute.

Price Table Preview

The following shows you the resulting table. Product rows are added dynamically for each product. There is a
column that displays the product code, a column that displays the manufacturer part number, and column that
displays the list price. One product is linked to an image, which is inserted.

The name of the price attribute, P1, has been replaced with the column header List Price. This is achieved by
applying a Row/Column Text Formatting transformation where P1 is replaced by List Price.

For more information about transformations, see About Table Transformations on page 113.
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Product Code fahufacturer Part List Price
Murnbet
ABC-2500-1004 ¥BR-44001-13 "!E 73499
ABC-2500-1011 ¥BR-44001-20 G544 .99
ABC-2E00-3005 ¥BR-44001-30 E11.99
ABC-2500-1006 ¥BR-44001-15 23499
AEC-2500-1000 HER-44001-15 4.00
Tranztformation Parameters
|7| EH [Remove Emgaty RovesiColuimtis Femove Rows Remove Columns Hea
Ei FowiColumn Text Formatting Far "4" do; Replace the whale value

dd Transformation

Advanced Price Table Example

The following example shows an advanced price table where the same product (“Toronto”) has different pricing
depending on date intervals and on the type of transport (“Land only” or “Land & Air”).
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i-SeIect YEFSian ITraveI Brochure 1)First wersion

Returns
Toronto
sun 1e Maw 1950

Land Onl

Thu 13 Mow  Sun 23 Mow 1950

Thu  z0 Moy 5Sun 30 1950

Thu 27 Mo 0
T D Fold 1 5
Thu 11 D

Thu 13 Dec  5Sun 23 Dec
Fri Z6 Lec Mom 5 Jan
2009
Thu 1 n  Sun 11 Jan

Thu & Jan  Sun 18 Jan

m 15 Jan  Sun 25 Jan

The table has the following characteristics:

e (1)The productis "Toronto".

12

19

Z6

12

19

Z6

Returns Land Only Land + Air \

Toronto
Jan Sun 1 Feb 1935 2509
Jan Sun 8 Feb 1935 2599
Feb Sun 15 Feh 1935 2599
Fell - 2150 2520
Fe Fold 2 1935 2599
Fet ______FE 1935 2599
Mar  3un 15 Mar 1935 2599
Mar 3un 22 Mar 1935 2599
Mar  3un 29 Mar 2099 27
Mar 5Sun S apr 2099 2770
apr Sun 12 apr 2199 2870
Apr Sun 19 apr 2275 2950

o (2) The product price varies depending on whether the type of transport is "Land Only” or “Land + Air”. In

Step, the product structure looks like the following:

=123 Travel Destinations
=3 Toronko

Hald fg Land + &ir

« (3) The Fold Table transformation is applied to the table so that the dates flow from one column within the

table to the next column and the Heading is repeated.

o (4) Prices for 2008 and 2009 must be displayed in groups. You therefore have to make a row from a

column.

« The pricing Start and End Date are loaded as a commercial list at publication level. Prices are loaded for the
product Toronto, and the price Land Only and for the product Toronto and the price Land + Air.

The following screenshot shows you how dates and prices are referenced.
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J-Select WETSIOn ITraveI Brochure 1/First version

Product Y References | Referenced By | Ima#&s&Dncuments

mercial | Tables | Prof Yiew

heparts Returns Land Only Land + Air Departs Returns Land Only Land + &ir
Taronto Toronto Toronto Toronto

Thige 6 Mov  Sun 16 MNov 19 * 2620 Thu 22 Jan Sun 1 Feb 1935 2599
T N, 23 193 2620 Thu 29 Jan S B Feb 1938 2599
Thu 1950 2620 Tho & Feb Sun 15  Feb 1935 2599
Thu 27 Mov Thu 12 Feb Sun 22 Feb 2150 2820
Thu 4 Dec Feb Sunm 1 Mar 1935 2599
Thu 11 Dec Sun 8 Mar 1933 2399
Thu 18 Dec 1933 2599
Fri 26 Dec & 2599
2009 0
Thu Jan Sum 11 Jan 1935 2599

@ LPGR Prike List (Price) ] l

Owner | Product ~| Prige = | LI = T ™ | Start Dat | End Date
= [Travel Brcu:l\e 1 {publication) |Land On'f?, 1950\ 1 200571-06 00:00:00 2008-11-16 00:00:00
= [Travel Brcu:huN {publication) |Land Only 1950 1 2005-11-13 00:00:00 2008-11-23 00:00:00
* Travel Brochure 1 ¥gublication)  [Land Cnly 1950 1 2008-11-20 00:00:00 2008-11-30 00:00:00
~ MTravel Brochure 1 (pu)a;etiun) Land Only 1950 | 2008-11-27 00:00:00 2008-12-07 00:00:00
~ [Travel Brochure 1 publicat\L Land Crily 2025 1 2008-12-04 00:00:00 2008-12-14 00:00:00

-

Travel Brochure 1 {publication Wnly 1950

2008-12-11 00:00:00

2008-12-21 00:00:00

-

2005-12-15 00:00:00

2005-12-25 00:00:00

-

Travel Brochure 1 {publication

Land Only \ﬂﬂ‘;l
———

{
(pbiceto) |
Travel Brochure 1 (publication)  Land Cﬂ%\- 1950
{ )
{ )

-

Travel Brochure 1 {publication)  Land Crly 1935

2008-12-26 00:00:00

2003-01-03 00:00:00

ZR05-01-01 00:00:00

2003-01-11 00:00:00

The Start Date 2008-11-06 is used to extract the weekday both as a short name (Thu) and a number (6). The
short name is calculated dynamically, so you do not have to store the value.

Definition | Preview |

Trael Pricing Table . \

TraveDateCol TraeDatzCol TraveDateCal

TravelDateCol

TravelDatzCol

TraveDateCal

TraveDateCal TraelDateCol

TravelDateCal TravePriceCal

abe Free Text Start Date - Shart ., (Start Date - Day

Statt Date - Shart

StartDate-Year  |abe Frea Text

End Diate - Shart ... [End Date - Day

End Date - Short .., ] Local

-

Travekeadng | N Departs Curenk

Returms

Current

r

Traveboml.. (4 Price
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1. Inthe Tree select the product or product group where you want to create the table, and then create a table with

one column and one row.

2. Specify the relevant content definitions for the column. Select the Subproducts/Family content definition, and
then indicate the level where you want the products to be extracted from. The level depends on where the

parent product is located. In this example, it is level 1, which is the Toronto level.

E] Row/Column Type & Content Definition

==

Column/Row Content definition :"SubPruducts, Farnily

i@ Local Product
(7 Spedfy

Browse m

& Advanced

[ Mame

Level 1

[] Indude Intermediate Levels

Ohject Type :.ﬁ.]l Types

[ K ][ Cancel

3. Specify the relevant contents definition for the row. Select the Date Spread Commercial RowColumn
content definition and the commercial list Price. In this example, this displays all the different price variables for

the sub-products Land only and Land + air.
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. Insert a new column before the Subproducts column. Select the Commercial data aspect. Specify that the

Value To Extract is Start Date, and that the date aspect is Short Weekday.

E] Row/Ceolumn Type & Content Definition I&

Column/Row Type :ColumnType

Column/Row Content definition ‘Commercial data aspect

Value To Extract Start Date

Date Aspect :'Shurt Weekday

[ Ok H Cancel

. Right-click the column, and choose duplicate, and then change the date aspect of the new column to Day.
Duplicate as many columns as you need, and change the date aspect to month, year and so on.

. Add a new row before the one that is already added. Select the attribute Name. This will display the names of

the local Subproducts in the final table.

. Add a new first column, and a sixth column where the content definition for both columns is Free Text. In this
example, Departs and Returns are entered as free text.

. Double-click the cells where the first row intersects with the 2nd and the 7th column, and change the content

definition to Current Object.

. Apply transformations. The following general transformations are applied to the table in this example.
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» * [Transformation * |Parameters
» [ 7] 1T Merge Rows/Columns Merge columnz 12
> | Ji Merge Fows/Columns Merge columns 5 6
» [7] |1 Make Header Row from Column Colurmn 4 Heading rows2
» [¥] (1 Remove Rows/Columns Remove Row™ 3"
> |7 Fold Table Folds 2 Repeat All Heading 1's at top. “true”™ Repeat Last Heading 2 “true”
> | I_ﬂ;# Merge Over Empty Cells Row

* | Add Transformation

To see how the transformations impact each other, you can clear the transformation boxes, and then click the first
check box, see what happens, then click the next and so on.

10.

» Merge Rows/Columns: This transformation merges column 1 and 2 so that “Departs” and “Toronto”
appear in one cell. Remember to set the correct Column Type.

o Merge Rows/Columns: This transformation merges column 5 and 6 so that “Returns” and “Toronto” are
merged into one cell.

« Make header row from column: This transformation makes the year column appear as a row. Remember
to select a normal row type. Otherwise, the subsequent transformations will not work properly.

Important: A transformation takes effect upon the result of the previous transformations. So in this example
where the previous transformation merged columns, the column number is 4, although the column number in
the definition of the table is 5.

« Remove row/columns: In this example, the year 2008 is implicit so the row that contains the year 2008 is
removed.

« Fold Table. This transformation makes the content of the table flow from one table column to another
Repeat Heading 1 and 2 are selected and number of folds is 2.

Apply formatting to the table. In this example, the row header has the background color Blue.

We recommend that you set the background color on the cells and not on the row or the type. This is because if
you set the color on the type or on the row and use the Fold Table transformation, the color is shown on the first
row of the second fold even if you do not want to repeat the heading.

In this example, the normal row has now background color and therefore appears as white. If you apply a
background color to the table, remember also to specify the background color on the transformations so that all
rows appear with the same background color. For example, if you specify a background color for the entire
table but not on the Make header row from column transformation, this row will display without the
background color.

In this example, the bold text style is applied to the header row cells and to the transformation Make header
row from column.
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Formatting Tables
When you create tables, you can apply formatting rules that determine how the table looks in InDesign.

To format a table, you have to configure the table in both STEP and InDesign. In STEP, you assign formatting
rules and in InDesign the rules are interpreted.

For example, if you have specified a light green background color and a thin border, the actual color and thickness
of the border depends on how the master document is set up in InDesign.

Formatting Rules

Table formatting is based on the principle of inheritance. When you apply rules at a higher level in the product
hierarchy, those rule are inherited down in the hierarchy. However, general rules can be overwritten at a lower
level.

Formatting inheritance enables you to define table formatting once, and have that formatting apply to all tables of
the specific type.

Selecting Where to Apply Formatting Rules
It is recommended to apply all general formatting rules in System Setup and limit the amount of local formatting on

individual tables. This makes it easier for you to gain an overview of all table formatting.
« Define general formatting rules in System Setup on table types, row types, and column types.

« Define local rules in the Tree on a specific product or product group.

You can apply table formatting on the following elements:

o Table types

o Column types

« Row types

« Tablein product hierarchy
o Tablerows

« Table cells

For example, in System Setup, you have a table type where the row height is set to 10 mm on the row type.
However, on the actual table that you link to the October catalog, you set the row height of all rows to 9 mm, and
then within the October catalog you have a specific table where you set the row height to 11 mm instead.

Important: When you apply transformations, you sometimes have to apply the formatting rules at the cell level
and on the transformation itself. For more information, see About Table Transformations in the STEP Tables
documentation.
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Specifying Local Table Formatting

When table formatting is changed locally, any default formatting inherited from the table type in System Setup is
overridden. Local changes to formatting that applies to an entire table are made using the Change Table
Settings dialog. To access this dialog and apply local formatting to a table, follow these steps

1. Inthe Tree, click the relevant product, and then click the Tables tab.

2. Select atable, and then click the Definition tab.

3. Right-click inside any table cell, and then click Change Table Settings. The Change Table Settings dialog
displays.

E] Change Table Settings @
Width | in -
Text Style Not Defined -
Background Color | Mot Defined -
Rule Above 0.5 pt -
Rule Below 0.5 pt -
Rule Left 0.5 pt -
Rule Right 0.5 pt -
Vertical Alignment | Inherited: Top * | Table Type
Cell Rotation Mot Defined -
Process Flag Mot Defined -
Cell Story Direction  Not Defined -
Cell Image Scale
[ OK ] | Cancel

4. Adjust the formatting of the table using the following settings:

« Width: Sets the width of the entire table. Available units are inches, millimeters, picas, and points. Though
Proportional is also available in the dropdown, this setting only applies to columns. (See Specifying Local
Column Formatting for more information.)

To prevent having to select a unit every time a width is set, a default unit can be set in System Settings. See
the Table Defaults section of the System Settings documentation for more information.

« Text Style: Sets the text style for the entire table. Contents of the dropdown list are populated by style tags
created in System Setup.

« Background Color: Sets the background color of the entire table. Contents of the dropdown list are
populated by table colors created in System Setup.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 97



StiboSystems

Rule Above: Controls which line style is used as the top border of the table. Contents of the dropdown list
are populated by table rules created in System Setup.

Rule Below: Controls which the line style is used as the bottom border of the table. Contents of the
dropdown list are populated by table rules created in System Setup.

Rule Left: Controls which line style is used as the left border of the table. Contents of the dropdown list are
populated by table rules created in System Setup.

Rule Right: Controls which line style is used as the right border of the table. Contents of the dropdown list
are populated by table rules created in System Setup.

Vertical Alignment: Controls the vertical alignment of cell contents (text and images) as follows:

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat

Purple & White Party Hat

Center Centers contents vertically

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat

Cell Rotation: Controls the orientation of cell contents (text orimages). Cell contents can be rotated 0, 90,
180, or 270 degrees as follows:
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Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

90

1eH Aped

ajuM g sjding
1eH Aued

8juM g 8ding
1eH Aued

S}IU ' Sjding

180

1eH Aued anypp g 3jding
1eH Aued anypp g 3jding
1eH Aued apyp g 2(ding

270

Purple & White

Party Hat
Purple & White

Party Hat
Purple & White

Party Hat

« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store
custom table settings.

« Cell Story Direction: Determines whether the contents of the cells in the table (text and images) are
displayed horizontally or vertically.

Cell Story Direction Direction

Horizontal (default) Sets the text direction to horizontal:| ABCDE
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Cell Story Direction Direction

Vertical

3028V

Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the cell. Images may be scaled from 25% to
500%.

By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

5. Click OK when complete.

Considerations and Limitations
The following settings are not visible in the STEP Tables Preview:

« Vertical Alignment

« Cell Rotation

o Cell Story Direction
To preview these settings in the table, you must either use the Proof View in the workbench or mount the table in
InDesign.

For more information on Proof View, see the Generating Proof Views topicin the STEP'n'design
documentation. For more information on mounting products in InDesign, see Mounting Products in the
STEP'n'design documentation.

Specifying Local Column Formatting

When column formatting is changed locally, all inherited formatting is overridden. Local changes to column
formatting are made using the Change Column Settings dialog. To access this dialog and apply local formatting
to a column, follow these steps:

1. Inthe Tree, click the relevant product or classification, and then click the Tables tab.

2. Select atable, and then click the Definition tab.

3. Select a column, right-click, and then click Change Settings. The Change Column Settings dialog displays.
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£33 Change Column Settings @
Width | in v
Text Style ot Defined v
Background Color iNot Defined vi
Cell Vertical Alignment ilnherited: Top vi Column Type
Rule Left iNot Defined vi
Rule Right 1pt v
Cell Rotation iNot Defined vi
Process Flag iNot Defined vi
Cell Story Direction iNot Defined vi
Cell Image Scale
l oK l l Cancel

4. Adjust the formatting of the column using the following settings:

« Width: Sets the width of the column. Available units are inches, millimeters, picas, and points. Also included
in the dropdown is Proportion, which allows the option to specify proportionality to other columns in the table.

Example: When Table X is mounted, then Column type B will be twice as wide as Column Type A. The
proportionis 2 to 1.

Table X

Column A | Proportionalis setto 1

Column B | Proportional is set to 2

To prevent having to select a unit every time a width is set, a default unit can be set in System Settings. See
the Table Defaults section of the System Settings documentation for more information.

o Text Style: Sets the text style of the column. Contents of the dropdown list are populated by style tags
created in System Setup.

« Background Color: Sets the background color of the column. Contents of the dropdown list are populated
by table colors created in System Setup.

« Cell Vertical Alignment: Controls the vertical alignment of cell contents (text and images) within the
column as follows:

© Stibo Systems - Confidential - STEP Trailblazer 8.2 101



StiboSystems

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat

Purple & White Party Hat

Center Centers contents vertically

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat

« Rule Left: Controls which line style is used as the left border of the column. Contents of the dropdown list
are populated by table rules created in System Setup.

« Rule Right: Controls which line style is used as the right border of the column. Contents of the dropdown list
are populated by table rules created in System Setup.

« Cell Rotation: Controls the orientation of cell contents (text orimages) within the column. Cell contents can
be rotated 0, 90, 180, or 270 degrees as follows:
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Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

90

1eH Aped

ajuM g sjding
1eH Aued

8juM g 8ding
1eH Aued

S}IU ' Sjding

180

1eH Aued anypp g 3jding
1eH Aued anypp g 3jding
1eH Aued apyp g 2(ding

270

Purple & White

Party Hat
Purple & White

Party Hat
Purple & White

Party Hat

« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store
custom table settings.

« Cell Story Direction: Determines whether the contents of the cells in a column (text and images) are
displayed horizontally or vertically.

Cell Story Direction Direction

Horizontal (default) Sets the text direction to horizontal:| ABCDE
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Cell Story Direction Direction

Vertical

3028V

Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the cells within the column. Images may be scaled
from 25% to 500%.

By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

5. Click OK when complete.

Considerations and Limitations
The following cell settings are not visible in the STEP Tables Preview:

« Vertical Alignment

« Cell Rotation

o Cell Story Direction
To preview these settings in the table, you must either use the Proof View in the workbench or mount the table in
InDesign.

For more information on Proof View, see the Generating Proof Views topicin the STEP'n'design
documentation. For more information on mounting products in InDesign, see Mounting Products in the
STEP'n'design documentation.

Specifying Local Row Formatting

When row formatting is changed locally, all inherited formatting is overridden. Local changes to row formatting are
made using the Change Row Settings dialog. To access this dialog and apply local formatting to a row, follow
these steps:

1. Inthe Tree, click the relevant product, and then click the Tables tab.

2. Select atable, and then click the Definition tab.

3. Selectarow, right-click, and then click Change Settings. The Change Row Settings dialog displays.
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m Change Row Settings @
Height | in v
Text Style bold >
Background Color iNot Defined vi
Vertical Alignment iInherited: Top vi Rowr Type
Rule Above :Not Defined v:
Rule Below :[nherited: 1pt v: Row Type
Cell Rotation :Not Defined v:
Process Flag :Not Defined v:
Cell Story Direction :Not Defined v:
Cell Image Scale

[ keep with Next Rowr Type

[ oK ] [ Cancel

To prevent having to select a unit every time a height is set, a default unit can be set in System Settings. See the
Table Defaults section of the System Settings documentation for more information.

4. Adjust the formatting of the row using the following settings:

« Height: Sets the height of the row. Available units are inches, millimeters, picas, and points.

« Text Style: Sets the text style of the row. Contents of the dropdown list are populated by style tags created
in System Setup.

« Background Color: Sets the background color of the row. Contents of the dropdown list are populated by
table colors created in System Setup.

« Vertical Alignment: Controls the alignment of the cell contents (text and images) in the row as follows:

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

© Stibo Systems - Confidential - STEP Trailblazer 8.2 105



StiboSystems

Alignment Description Example

Center Centers contents vertically

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat

« Rule Above: Controls which line style is used as the top border of the row. Contents of the dropdown list are
populated by table rules created in System Setup.

« Rule Below: Controls which line style is used as the bottom border of the row. Contents of the dropdown list
are populated by table rules created in System Setup.

« Cell Rotation: Controls the orientation of cell contents (text orimages) in the row. Cell contents can be
rotated 0, 90, 180, or 270 degrees as follows:

Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

© Stibo Systems - Confidential - STEP Trailblazer 8.2 106



StiboSystems

Cell Rotation Example

. §73232
PRI
8 ® &
180
JeH Aped apyp @ 3jding
JeH Aped apyp @ 3jding
1eH Aped apypn @ apding
270 L o o
O
EEEFETD
M0 3 M 3 @
ooododd

« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store
custom table settings.

« Cell Story Direction: Determines whether the cell contents (text and images) in the row are displayed
horizontally or vertically.

Cell Story Direction Direction

Horizontal (default) Sets the text direction to horizontal:| ABCDE

Vertical

3028V

Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the row. Images may be scaled from 25% to
500%.
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By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

« Keep With Next: Check this box if the selected row should remain with the next row in the table if the
mounted table splits across a column or page. (A table will split across a column or page if it is too large to
fully mount in a single column or page.) The row will be mounted onto the following column or page in order
to keep it with the next row.

5. Click OK when complete.

Considerations and Limitations
The following cell settings are not visible in the STEP Tables Preview:

« Vertical Alignment
» Cell Rotation
« Cell Story Direction

To preview these settings in the table, you must either use the Proof View in the workbench or mount the table in
InDesign.

For more information on Proof View, see the Generating Proof Views topicin the STEP'n'design
documentation. For more information on mounting products in InDesign, see Mounting Products in the
STEP'n'design documentation.

Specifying Local Cell Formatting

When cell formatting is changed locally, all inherited formatting is overridden. Local changes to cell formatting are
made using the Change Cell Settings dialog. To access this dialog and apply local formatting to a cell, follow
these steps:

1. Inthe Tree, click the relevant product or classification, and then click the Tables tab.
2. Select atable, and then click the Definition tab.

3. Right-click a cell, and then click Change Cell Settings. The Change Cell Settings dialog displays.
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£%3 Change Cell Settings [l
Text Style iENormaI C vi
Background Color :Not Defined v:

Vertical Alignment :Inherited: Top v: Row Type

Rule Above :Not Defined v:

Rule Below :Inherited: 0.5 pt v: Table

Rule Left :Not Defined v:

Rule Right :Inherited: 1pt v: Column

Cell Rotation :Not Defined v:

Process Flag iNot Defined vi

Cell Story Direction iNot Defined vi

Cell Image Scale |25% Table Type
[ oK ] [ Cancel

4. Adjust the formatting of the cell using the following settings:

o Text Style: Sets the text style of the cell. Contents of the dropdown list are populated by Style Tags created
in System Setup.

« Background Color: Sets the background color of the cell. Contents of the dropdown list are populated by
table colors created in System Setup.

« Vertical Alignment: Controls the vertical alignment of cell contents (text and images) as follows:

Alignment Description Example

Top Aligns contents to top Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Center Centers contents vertically

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat
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Alignment Description Example

Bottom Aligns contents to bottom

Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat

Justify Aligns content evenly from top to bottom | | Purple & White Party Hat

Purple & White Party Hat

Purple & White Party Hat

Rule Above: Controls which line style is used as the top border of the cell. Contents of the dropdown list are
populated by table rules created in System Setup.

Rule Below: Controls which line style is used as the bottom border of the cell. Contents of the dropdown list
are populated by table rules created in System Setup.

Rule Left: Controls which line style is used as the left border of the cell. Contents of the dropdown list are
populated by table rules created in System Setup.

Rule Right: Controls which line style is used as the right border of the cell. Contents of the dropdown list are
populated by table rules created in System Setup.

Cell Rotation: Controls the orientation of cell contents (text or images). Cell contents can be rotated 0, 90,
180, or 270 degrees as follows:

Cell Rotation Example

0 Purple & White Party Hat
Purple & White Party Hat
Purple & White Party Hat
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. §73232
PRI
8 ® &
180
JeH Aped apyp @ 3jding
JeH Aped apyp @ 3jding
1eH Aped apypn @ apding
270 L o o
O
EEEFETD
M0 3 M 3 @
ooododd

StiboSystems

« Process Flag: Nothing is typically available in this dropdown list. This area is sometimes used to store

custom table settings.

« Cell Story Direction: Determines whether the contents of the cell (text and images) are displayed

horizontally or vertically.

Cell Story Direction Direction
Horizontal (default) Sets the text direction to horizontal:| ABCDE
Vertical >
m
(2)
w)
m
Sets the text direction to vertical:

« Cell Image Scale: Controls the size of images linked into the cell. Images may be scaled from 25% to

500%.

© Stibo Systems - Confidential - STEP Trailblazer 8.2

111



StiboSystems

By default, the Cell Image Scale field is blank. If this field is left blank, and a width or height has not been set
on the column or row containing the image, the image will mount at 100% (actual size). If a scale value is
entered, the image will mount at the specified size, even if a width or height has been set on the column or
row.

5. Click OK when complete.

Considerations and Limitations
The following cell settings are not visible in the STEP Tables Preview:

« Vertical Alignment

« Cell Rotation

o Cell Story Direction
To preview these settings in the table, you must either use the Proof View in the workbench or mount the table in
InDesign.

For more information on Proof View, see the Generating Proof Views topic in the STEP'n'design
documentation. For more information on mounting products in InDesign, see Mounting Products in the
STEP'n'design documentation.

Previewing Tables

The table preview shows preview of what your table currently looks like. Note that he preview displays the text,
colors and lines based on how they are defined in System Setup. It does not show you what the table will look like
in the final publication. This is determined by the InDesign settings. So while the formatting options enable you to
assign graphical attributes such as bold, italic or color to your tables, it is not a true rendering of the final output.

To Preview a Table

Before you can preview table, you have to select a specific publication version because a table can include rows
and columns that are only valid in specific publication types.

The table preview only shows the columns and rows that are valid in the selected publication and filters away any
other tables and rows. Likewise, commercial data is specified for a specific publication version, and is therefore
only displayed in the table if the relevant publication version is selected.

The attribute values, references and images that are displayed in the preview depend on the selected context.
1. Inthe Tree, click the relevant product or classification, and then click the Tables tab.

Click the table that you want to preview. The table appears.

Click the Preview tab.

> w0 D

Inthe Select Version list, select the preferred publication version. If you cannot see the relevant version, click
Other, and then search or browse for the relevant publication.
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- 1
Product || Sub Products | References || Referenced By || Images & Documents || Commercial Cateqary Profile
@ Tables
Mame » |Defined At
» Description Table BETool PIMautopage
* Horizontal Table Local
» Horizontal Table Small Wheels CP1
* thltype Customer Cases
> | Add Table Type
Definition |l
Select version or market ;.ﬁ.ub:page Publication Only/Autopage only version - i5E|EEt Preview Mode :Current Mode
Autopage Publication Only fautopage only wersion
dkdkdkdk pags ny/Autopage only
IABR. MobilePhone Publication/Global version
MobilePhone Publication/Global version
03 PIM Autopage Copy/PIM Autopage
02 PIM Autopage Pagination/FPIM Autopage
> * [Transformation * |Parameters
> 1T Rule when Different On Column Add Rule Below ™ Ignore Headings

Note: The Select Version text is displayed in red, if the version points to a different context and workspace
than the ones selected in the toolbar. In this case, you have to change the context and workspace in the
toolbar to match the context and workspace defined on the version.

You can assign local table transformations to the table that you are previewing. The table transformations that you
add here are only added locally and do not override the table transformations on the table type.

For information about adding table transformations, see About Table Transformations below.

About Table Transformations

You can use table transformations to manipulate the content and appearance of a table. A table transformation
can perform operations on an entire table or part of a table, such as applying color to certain rows or merging cells
with equal values.

General Transformation Information

When you use transformations, be aware of the following:

« Most transformations are applied in a two-step process: First you add the transformation, and then you
modify the parameters.
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« Transformations are cumulative, which means that you can add a range of transformations to your table.
The transformations are executed in the sequence they are listed, and a transformation takes effect upon the
result of the previous transformation. To change the sequence of transformations, you can drag and drop a
transformation row to a new location.

« Transformations can impact the table formatting such as the text style or background color of a row or
column. In some cases, you may have to set the formatting on the transformation as well.

Important: You can only change the sequence of table transformations on a table type from the table type itself in
System Setup. When you change the sequence of transformations on the table type, it affects all tables that are
based on the table type.

Adding Transformations
You can apply table transformations locally and globally:

« Local transformation are added on the Preview tab of the selected table on the Table tab.

« Global transformations are added in the Default Transformations area on the Table Types tab.

Note: The following describes how you add transformations to an individual table. However, the process for
adding transformations to a table type is similar, except that you add the transformation on the table type in
System Setup.

For information about available transformations, see List of Transformations on page 116.

To Add a Transformation to a Table
1. Inthe Tree, click the relevant product, and then click the Tables tab.

2. Click a table type, and then click the Preview tab.

3. Click Add Transformation. The Select Transformation dialog appears.
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E] Select Transformation

Browse

=-£3 Layout Transformations

-[EE] Alternate Row Calors

E Repeated Fule

-[]T Rule When Different

B3 Sortings

tw Standard Sorting

=51 Formatting

1T Attribute Formatting

~[I¥ Row/Column Text Formatting
JI Tab Formatting

~[1¥ cell Formatting

[=-£31 Transformations

- [& Merge Equal Cells

- [& Merge Over Empty Cells

-] Remove Attribute Rows/Columns in Group
~[I§ Make Header Row from Column
-EH Remove Empty Rows/Columns
~[]§ Merge Rows/Columns

~[1¥ suppress Rows/Columns

Ji Remove Fows,/Columns

--[EEH Fold Table

-] Footnote Transformation
- Pivot Transformation

- Details

[ oK H Cancel
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Click the preferred transformation, and then click OK.

If no parameters need to be set, the transformation is applied instantly. However, most transformations require
that you modify some parameters.

To Modify Transformation Parameters
On the Preview tab, click the ellipsis button (...)next to the transformation whose parameters you want to

1.

modify.

2. Make the desired changes, and then click OK.

To Remove a Transformation

1.

Inthe Tree, click the relevant product, and then click the Tables tab.
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2. Click atable type, and then click the Preview tab.

3. Click the arrow in front of the transformation that you want to remove, and then click Remove
Transformation.

List of Transformations

These tables list the available transformations in the table component. Each transformation is described in further
detail in the sections that follow.

Layout Transformations

Transformation Description

Apply Alternate Row Colors Shades alternate rows according to a specified frequency.
Repeated Rule Inserts specified rule styles as top and bottom borders of a row.
Rule When Different Inserts a specific rule style for a specific type of content.

Sorting Transformations

Transformation Description

Table Sorting Transformations Sorts the rows in a table according to the specified settings.

Formatting Transformations

Transformation Description

Attribute Formatting Transformations Applies a transformation to a specific attribute.

Row/Column Text Formatting Applies text formatting to a specific column or row. The
transformation also calculates, replaces, and applies prefixes
and suffixes to values.

Tab Formatting Inserts a tab stop in a row or column.

Cell Formatting Formats cells with specific content.
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General Transformations

Transformation Description

Table Transformation: Merge Over
Equal Cells

Merges adjacent cells with identical values. The transformation
merges equal cells in the entire table or in specific rows or columns.
Both horizontally and vertically adjacent cells are merged.

Table Transformation: Merge Over
Empty Cells

Merges row or column contents with empty cells. Use this
transformation when you want to span dynamically created cell
content.

Table Transformation: Remove
Attribute Rows/Columns in Group

Removes all attributes that belong to a specific attribute group.

Table Transformation: Make Header
Row from Column

Transforms column content into subheadings.

Table Transformation: Remove Empty
Rows/Columns

Removes empty rows or columns. The entire row or column must be
empty.

Table Transformation: Merge Rows
and Columns

Merges the content of the specified rows or columns.

Advanced Price Table Example

Suppresses a row or column if a specified string matches a value in
the selected column or row.

Table Transformation: Remove
Rows/Columns

Removes a specific row or column.

Table Transformation: Fold Table

Divides a table into two or more side-by-side tables where the
content flows across the tables.

Table Transformation: Horizontal Fold
Table

Splits a wide table into two or more vertical 'folds' based on a
designated number of folds.

Table Transformation: Horizontal
Wrap Table

Splits a wide table into two or more vertical 'wraps' based on a
specified column type.

Footnote Transformations

Controls how footnotes are displayed in a table

Pivot Table Transformations

Creates a pivot table that allows you to summarize and analyze the
data in you table independent of the original data layout of your table.
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General Table Transformations
These available general transformations are defined in detail below:

« Table Transformation: Merge Over Equal Cells

« Table Transformation: Merge Over Empty Cells

« Table Transformation: Remove Attribute Rows/Columns in Group
« Table Transformation: Make Header Row from Column

« Table Transformation: Remove Empty Rows/Columns

« Table Transformation: Merge Rows/Columns

« Advanced Price Table Example

« Table Transformation: Remove Rows/Columns

» Table Transformation: Fold Table

« Footnote Transformations

« Pivot Table Transformations

Table Transformation: Make Header Row from Column

The Make Header Row from Column enables you to transform the contents of a selected column to header
rows. This is useful, for example, if you want to save space by removing a column, and instead have the contents
of that column display as header rows in the table.

Example: In the following example,the Media Capacity column is transformed in to header rows.

Before the transformation, the Media Capacity column is sorted ascending.

Defintion | Preview

Medis RAM Installed Ppricet
Capacity
HP Color LaserJet 26000 - prirter - color - laser Sheets: 250 16 246
HP Laserlet 1320 - printer - B - laser Sheets: 250 16 299
HP Laserlet 42500 - printer - BAY - laser Sheets: 250 16 299
HP Laserlet 13200 - printer - BAY - kaser Sheets: 500 64 439
HP Laserlet 2420 - printer - BAM - laser Sheets: 1000 64 549
HP Laserlet 4250tn - printer - BAAY - laser Sheets: 1000 64 1249
Transfornation Paratreters
£ |Standard Sorting Sorting on Column 2 Mumeric
JI Attribute Formatting For atttibute "Media Capacty do: Insert text betore
||E Alternate Row Colors Color 1 rovwes "White" then 1 "Light Blue". Restart after Headings abaoy.
D |_jI Make header row fram column Colurnr 2 lgnore Heading1
dd Transfarmation

After the transformation, the Media Capacity column has been removed. Instead, header rows have been created
based on the contents Media Capacity column. A new header row is created every time the value changes, for
example from 250 to 500 sheets.
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Definition | Preview

RAM Installed Ppricet
Sheets: 250
HP Color LaserJet 26000 - prirter - color - laser 16 246
HP LaserJet 1320 - prirter - B - laser 16 299
HP LazerJet 4250n - prirter - 304 - laser 16 299
Sheets: 500
HP LaserJet 13200 - prirter - S04 - laser 64 493
Sheets: 1000
HP Laserdet 2420 - printer - B - lazer B4 549
HP Laszerlet 4250th - printer - BAA - lazer 64 1249
Transfarmation Parameters

4 |Standard Sorting Sorting o Colurmn 2 Numeric

_JI Attribute Formatting For attribute "Media Capacity do: Inserttext before

[E3 |thernate Row Colors Color 1 rows "White" then 1 "Light Blue". Restart after Headings ahoy

‘JI Make header row from calumn Colurn 2 Ignore Headingl
lact¥Transfommation

In the Tree, click the relevant product, and then click the Tables tab.
Click a table type, and then click the Preview tab.
Click Add Transformation. The Select Transformation dialog appears.

Select Make Header Row from Column, and then click OK.

o o bh -

Under Parameters, click the ellipsis button (...). The Make Header Row from Column dialog appears.

E] Make Header Row from Column I&

Heading raws _?.Ignare Mone -
Column D
Row Type o

Text Style Mot Defined -

Background Color Mot Defined |

Rule Above Mot Defined -
Rule Below Mot Defined -
[ QK ] I Cancel

6. Fromthe Heading rows list, click Ignore None, 1 or 2.

The Ignore None option excludes heading levels from being processed by this transformation.

7. Inthe Columns field, click the ellipsis (...) button. The Select Row/Column dialog opens. Here you select the
column you want to use for this transformation.

« Select Attributes to apply the transformation to the column that contains the specified attribute. Click the
ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

» Select Heading to identify a column by typing the header text of the relevant column.
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« Select Type to identify the column or row by selecting Column Type.

« Select Number to identify the column by entering the sequence number of the relevant column. For
example, if you want to apply the transformation the second column, then simply type 2.

« Click OK to close the dialog.

8. Inthe Row Type list, select the relevant row type.

9. Inthe Text style list, select text styles you want to use the header rows that are created by the transformation.

10.

11.

12.

13.

In the Background Color list, select the background color you want to use for the header rows that are
created by the transformation.

In the Rule Above list, select the line style you want to use as the top border of the header row created by the
transformation.

From the Rule Below list, select the line style you want to use as the bottom border of the header row created
by the transformation.

Click OK.

Table Transformation: Merge Over Empty Cells

The Merge Over Empty Cells transformation merges row or column contents over empty cells. This
transformation is useful when you want to span cells with dynamically created content where you can not use the
Span Cells functionality.

o & 0 bd -

In the Tree, click the relevant product, and then click the Tables tab.

Click a table type, and then click the Preview tab.

Click Add Transformation. The Select Transformation dialog appears.
Select Merge Over Empty Cells, and then click OK.

Under Parameters, click the ellipsis button (...). The Merge Over Empty Cells dialog appears.

E] Merge Over Empty Cells [-Zhj

Rowfcolumn to span:
|

| Ok || Cancel |

Click the ellipsis (...) button. The Select Row/Column dialog opens.
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[ E] Select Row/Column &Jﬁ

@ Row Colurmn

Attribute

) )

Product/Classification/Asset
Heading
Type -

Mumber

| QK || Cancel

« Select Row or Column to specify whether the transformation applies to a row or a column.

« Select Attributes to apply the transformation to the column that contains the specified attribute. Click the
ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

« Select Heading to identify a column or row by typing the header text of the relevant column or row.
» Select Type to identify the column or row by selecting Column Type or Row Type.

« Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then simply type 2.

Note: This transformation also merges equal spanned cells.

Table Transformation: Merge Over Equal Cells

Merges adjacent cells that contain identical values. The transformation merges equal cells in the entire table or in
specific rows or columns. Both horizontally and vertically adjacent cells are merged. The transformation also
merges adjacent spanned cells that contain identical values.

If two equal cells appear from merging other cells, they are also merged. The transformation repeats the merging
process until there are no more cells to merge.

In the Tree, click the relevant product, and then click the Tables tab.

Click a table type, and then click the Preview tab.
Click Add Transformation. The Select Transformation dialog appears.

Select Merge Equal Cells, and then click OK.

ok D -

Under Parameters, click the ellipsis button (...). The Merge Equal Cells dialog appears.
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FE] Merge Equal Cells Iﬁﬂ

| -

[ oK ][ Cancel ]

6. Check Limit to row/column to apply the transformation to a specific row/column.

If you leave the Limit to row/column box blank, the transformation is applied to the entire table.

7. Click the ellipsis button [...]. The Select Row/Column dialog opens.

[ E] Select Row/Column Iﬁ1

@ Rowé () Column

") Attribute

) &)

) Product/ClassificationfAsset
1 Heading
~) Type v:

) Number

[ OK H Cancel

« Select Row or Column to specify whether the transformation applies to a row or a column.

« Select Attributes to apply the transformation to the column that contains the specified attribute. Click the
ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

« Select Heading to identify a column or row by typing the header text of the relevant column or row.
» Select Type to identify the column or row by selecting Column Type or Row Type.

« Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then simply type 2.

Table Transformation: Merge Rows/Columns
The Merge Rows and Columns transformation enables you to merge two rows or two columns into one.
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When you merge columns or rows the values of both rows or columns are retained. After the merge, it will look as
if two attributes are placed in the same column.

Example: In the following example, the First Color and Second Color columns are merged.

Before the merge, the First Color and Second Color attributes are maintained in two separate columns.

Definition

Preview

First Color Second Color Pprice
HP Color LaserJet 2600 - prirter - color - laser Red Blug 245
HP Laseret 2420 - printer - BAY - laser Red Blug 549
HP LaserJet 13200 - printer - BAAY - laser Dark Gray Blug 499
HP La=erJet 1320 - printer - BAY - laser Dark Gray Blue 299
HP LaserJet 4250n - printer - BAY - laser Yellow Blue 209
HP LazerJet 4250t - printer - BAY - laser Red Elue 1249
[ Transtormation Parameters
r |:| 4 Standardd Sorting orting on Colurmn 2 Murmeric
| Alternate Row Colors Color 1 roves "White! then 1 "Light Blue". Restart after Headings above 0
|:| |JI Merge Rows/Columns Merge columns 2 + 3

dd Transformation

After the merge the contents of the two columns are now merged into one column. In this example, a “+”-sign is

used as separator.

Preview

Definition

First Color + Second Color — Ppriced

:HP Color LaserJet 26800n - printer - color - laser Red + Bluz 246
HP LaserJet 2420 - printer - BMY - laser Red + Bluz 249
HP LaserJet 1320n - printer - BiM - laser Dark Gray + Blue 499
HP LaserJet 1320 - printer - BAY - lsser Dark Gray + Blue 293
HP LaserJet 4250n - printer - B - laser Yelow + 3lue 299
HP LaserJet 4250tn - prirter - B - laser Red + Bluz 1248
Transformation Parameters
D 4 [Standard Sorting [Sorting on Colurn 2 hurneric
E2 |aternate Row Colors Color 1 rowes "White" then 1 "Light Blug". Restart after Headings above 0
‘_II Merge Rows/Columns Merge columns 2+ 3

g Transformation
The Merge Rows and Columns transformation is set up in a three-step wizard.

Inthe Tree, click the relevant product, and then click the Tables tab.

Click a table type, and then click the Preview tab.

Click Add Transformation. The Select Transformation dialog appears.

Select Merge Rows and Columns, and then click OK.

Under Parameters, click the ellipsis button (...). The Merge Rows/Columns wizard appears.

o g A~ w N~

In step 1, Orientation, specify whether you want to merge columns or rows.
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[ E] Merge Rows/Columns ﬁﬂ

Steps Orientation

1. Orientation
2. RowsfColumns
3. Result

i@ Merge Rows

7. Instep 2, Rows/Columns, choose the rows or columns that you want to merge.

Merge Raws
[
5

8. Instep 3, Result, specify the row or column type you want to base the merged column or row on. In this step,
you can also specify a separator to be inserted between the attribute values of the merged columns or rows.

Row Type e o TypelSettings From First Merged Row E ]
Separator |,

() Always insert separator
@ Do not insert separatar if only one value is empty

() Do not insert separataor if both walues are emply

9. Click Finish.
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Table Transformation: Remove Empty Rows/Columns

The Remove Empty Rows/Columns transformation removes empty rows or columns. This is useful, for
example, if several product ranges use the same table definitions but some attribute columns only apply to a few of
the actual tables.

o M 0 b=

In the Tree, click the relevant product, and then click the Tables tab.

Click a table type, and then click the Preview tab.

Click Add Transformation. The Select Transformation dialog appears.

Select Remove Empty Rows/Columns and then click OK.

Under Parameters, click the ellipsis button (...). The Remove Empty Rows/Columns dialog appears.

E] Remove Empty Rows/Columns I,iE-J

Heading Rows 0|
Heading Columns i]

W[ Remowve Rows

| Remove Columns

[ QK ]| Cancel

In the Heading Rows field, enter the number of header and sub-header rows to be removed even if they
contain data.

In the Heading Columns field, enter the number of header and sub-header columns to be removed even if
they contain data.

8. Select Remove Rows to remove empty rows.

9. Select Remove Columns to remove empty columns.

10.

Click OK.

Table Transformation: Remove Attribute Rows/Columns in Group

The Remove Attribute Rows/Columns in Group transformation enables you to remove all attributes from the
table that belongs to an attribute group. This transformation is useful, for example, when you want to ensure that
specific attributes do not appear in the table in the final publication.

o & 0 bd -

In the Tree, click the relevant product, and then click the Tables tab.

Click a table type, and then click the Preview tab.

Click Add Transformation. The Select Transformation dialog appears.

Select Remove Attribute Rows/Columns in Group, and then click OK.

Under Parameters, click the ellipsis button (...). The Merge Over Empty Cells dialog appears.
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E] Remowve Attribute Rows/Columns in Group @

Browse m

& Advanced @

Mame >

I [ oK H Cancel

6. Search or browse for the relevant attribute group, and then click OK.
When you have selected an attribute group, the transformation is applied to all attributes in the table that
belongs to the Attribute Group.

Table Transformation: Remove Rows/Columns

1. Inthe Tree, click the relevant product, and then click the Tables tab.

. Click a table type, and then click the Preview tab.

2
3. Click Add Transformation. The Select Transformation dialog appears.
4. Select Remove Rows/Columns, and then click OK.

5

. Under Parameters, click the ellipsis button (...). The Remove Rows/Columns dialog appears.

I )

E] Rermowe Rows/Columns @
i

[ Ok ][ Cancel ]

6. Click the ellipsis button (...). The Select Row/Column dialog appears.
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[ E] Select Row/Column &Jﬁ

@ Row Colurmn

Attribute
Product/Classification/Asset
Heading

Type -

Mumber

I QK H Cancel

« Select Row or Column to specify whether the transformation applies to a row or a column.

« Select Attributes to apply the transformation to the column or row that contains the specified attribute.
Click the ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column or row that contains the
specified object. Click the ellipsis button (...) to search or browse for the relevant object.

« Select Heading to identify a column or row by typing the header text of the relevant column or row.
» Select Type to identify the column or row by selecting Column Type or Row Type.

« Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then simply type 2.

7. Click OK.

Table Transformation: Suppress Rows/Columns

The Suppress Rows / Columns transformation suppresses a row or a column if a value in the selected column
or row matches a specified string of text.

Inthe Tree, click the relevant product, and then click the Tables tab.

Click a table type, and then click the Preview tab.

Click Add Transformation. The Select Transformation dialog appears.

Select Suppress Rows/Columns, and then click OK.

o k> 0N =

Under Parameters, click the ellipsis button (...). The Suppress Rows/Columns dialog appears.
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E] Suppress Rows/Columns l&

Suppress Rows,Columns 7

Where
Undefined E] @is () isn't

[ Ok, H Cancel

6. Selectlgnore Headings if you do not want to apply the transformation to headings.
7. Inthe Undefined field, click the ellipsis button (...). The Select Row/Column dialog appears.

[ E] Select Row/Colurmn I& )

@ How () Column

() Attribute E]
() Product/Classification/Asset E]
(71 Heading

@ Type =

() Number

[ OK H Cancel

You will typically specify an attribute or a column or row type, however, other options are available.

« Select Row or Column to specify whether the transformation applies to a row or a column.

« Select Attributes to apply the transformation to the column or row that contains the specified attribute.
Click the ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column or row that contains the
specified object. Click the ellipsis button (...) to search or browse for the relevant object.

« Select Heading to identify a column or row by typing the header text of the relevant column or row.
« Select Type to identify the column or row by selecting Column Type or Row Type.

« Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then simply type 2.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 128



StiboSystems

8. Inthe String to match field, enter the string of text that you want to match with a value in the selected column
or row, and then click OK.

Table Transformation: Fold Table

The Fold Table transformation enables you to split a table into two or more equal table columns. The
transformation breaks the table so that the content flows from one column to the next.

Important: Rows in the table align over the folded table and space in between rows is divided evenly. If the
number of rows does not divide fully with the number of folds, empty rows are added at the end of the last fold.
This means that if there is an uneven number of rows Fold 2 will have 1 price row less than Fold 1.

Definition ~ Preview |

| Select version ITraveI Brachure 1)Firsk wersion

eparts Returns Land Only Land + Evfparts Returns Land Only Land + &ir \
oronto Toronto Toronto Toronto

Thu & Mow  Sun 16 Mow 1930 a0 T 2 Jan un 1 Feb 1935 2599

Thu 13 Moy Sun 23 Mow 1950 2620 29 Jan  Sun 3 Feb 1935 2599

Thu 20 Mow  Sun 30 Mow 1950 2620 Thu & Feb Sun 15 Feh 1935 2599

Thu 27 N 1950 26 Thy 12 Fe 2150 2820

Thu 4 D Fold 1 2025 o2 |thu 12 Fe Fold 2 P 1935 2599

Thy 11 O : = = 1950 E20 IThu 26 Fe C 1935 2599

Thu 13 Dec Sun 28 Dec 1930 799 IThy 5 Mar 3un 15 Mar 1935 2599

Fri 26 Dec Mon 5 Jan  Z150 Z0 IThu 12 Mar 3un 22 Mar 1935 2599

2009 | Thu 19 Mar 5Sun 29 Mar 2099 27

Thu 1 Jan Ssun 11 Jan IThu 26 Mar Sun 5 apr 2099 2770

Thu 3 Jan  Sun 13 Jan T Apr Sun 12 Apr 2199 2370

w 15 Jan  Sun 25 Jan Thu 9 aApr Sun 19 apr 2275 2950 _/

In the Tree, click the relevant product, and then click the Tables tab.

Click a table type, and then click the Preview tab.

Click Add Transformation. The Select Transformation dialog appears.
Select Fold Table, and then click OK.

o 0 0w N =

Under Parameters, click the ellipsis button (...). The Fold Table dialog appears.
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=

£+1 Fald Table ==

[] Repeat Al Heading 1's at top.

Repeat Last Heading 2
Praotect against arphans.

Crphans ko move

Falds 1

[ ok ]| Cancel

6. Select Repeat AllHeading 1's at top and or Repeat Last Heading 2 depending on whether one or two table
headings need to be repeated in the next fold.

7. Inthe Folds field, enter the relevant number of folds, and then click OK.

Important: if you do not select one of the Repeat Heading 1 or Repeat Heading 2 boxes any table formatting
applied on the header row type or on the header row, will still be displayed throughout the entire header row.

If you want to display the table formatting only on the header rows in Fold 1, you must apply the table formatting to
the cells instead.

Table Transformation: Horizontal Fold Table

The Horizontal Fold Table transformation is used to 'fold' wide tables that contain a large number of columns
into a taller, vertically oriented table. Users may have a need for the Horizontal Fold Table transformation if the
table is so wide that it either cannot fit within a single InDesign page column or page, or if a vertical layout is
desired.

This transformation works similarly to the 'Horizontal Wrap Table' transformation (documented in the Table
Transformation: Horizontal Wrap Table topic), as both facilitate the ability to 'fold' a wide table into multiple
table sections ('folds' or 'wraps') that stack on top of one another. However, unlike the Horizontal Wrap Table
transformation, a table folded using the Horizontal Fold Table transformation is folded based on a designated
number of folds, not on particular column types. This transformation is also similar to the Fold Table
transformation (documented in the Table Transformation: Fold Table topic), except the Fold Table
transformation takes a table that is very tall and folds it over into a horizontally oriented table.

Though there are many combinations of configurations that can be applied within the transformation, the following
two screenshots show a sample 'before' and "after’ of a table (as previewed within the workbench) after applying
the Horizontal Fold Table transformation.

Before:
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e It Bithday 10103 - Tables
ij Safety A (| Product || SubProducts || References || Referenced By || Images & Documents || Commercial Categary Profie || Proof View || Status

rj Hardware 9 Tebles -
; ) Nameg » |Defined At
[+-[7) Displays
E Furniture » Price Table Products
r_=| Automotive » Sales Price Table Local
rj Budng Products » Bpedfication Table Party Supplies
[ 7] Blectrical and Electronics
ij Food and Beverage » Table Guide Mot Defined
i [ Kitchen > | Add Tae Tupe
) Party Supples ey || Preview |
E Party Hats Select version | Acme Party Supplies/English US « Select Preview Node | Current Node
E Masks
--ﬁ Streamers Part Number |Short ltem Description Size Product Weight |Product Width |Product Height |List Price | Sale Price
=[] Chid Birthday Parties 123456 1st Birthday Boy Blue Cupcake Kit [N/A 2b 12in 5in 49,99 $7.99
-] IstBirthday 789112 istBirthday Boy Cupcake kit N/ 2 12in Sin 49,99 £7.99
rj Sweet 16 543216 1st Brthday Boy Party Hat Al Sizes |5 4in 3in £4.99 £3.99
[+ 7] Wedding 957416 1st Birthday Boy Paper Plates  [NJA 1 12in 12in £5.99 44,99
#-[5) Alarms 301897 1st Birthday Boy Party Banner ~ |NJ/A 2b ¥in 24in §12.99 49,99
- Alarm Clocks 5522836 1st Birthday Girl Cake Kit NJA 3k 12in 3in £12.99 $9.99
e[ Bectronics 1144885 1st Birthday Gil Cupcake kit /A 3b 12in 3in §299 3.9
[ Discontinued Products 541531 1stBirthday Girl Paper Plates  |Assorted  |1lb 8in ain £7.99 45,99
[ Product Overrides 4421255 1st Birthday Girl Party Invitation |Assorted  |1lb 10in 5in £14.99 49,99
i Packaing 44416 1st Birthday Girl Tiara OneSize 2 8in 3in £24,99 £14.99

After (preview only pictured):
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Select version | Acme Party Supplies/English LIS

Part Number |Short tem Description Size Product Weight
123456 izt Birthday Boy Blue Cupcake Kit ~ |M/A 2lb
739112 izt Birthday Boy Cupcake Kit M/A 2lb
543216 izt Birthday Boy Party Hat All Sizes Slb
957416 izt Birthday Boy Paper Plates M/A 1lb
301897 1zt Birthday Boy Party Banner M/A 2lb
5522886 1zt Birthday Girl Cake Kit M/A 3k
1144885 1zt Birthday Girl Cupcake Kit M/A 3lb
541531 1zt Birthday Girl Paper Plates Assorted 1lb
4421255 1zt Birthday Girl Party Invitation Assorted 1lb
4646416 1zt Birthday Girl Tiara One Size 2lb
Part Number |Short tem Description Product Width |Product Height
123456 1st Birthday Boy Elue Cupcake Kit 12in 5in
789112 1st Birthday Boy Cupcake Kit 12in 5in
543216 1st Birthday Boy Party Hat 4in ain
A57416 1st Birthday Boy Paper Plates 12in 12in
301897 1st Birthday Boy Party Banner 36 in 24in
5522586 1st Birthday Girl Cake Kit 12in 3in
1144585 1st Birthday Girl Cupcake Kit 12in 3in
541531 1st Birthday Girl Paper Plates &in & in
4421255 1st Birthday Girl Party Invitation 10in 5in
4546416 1st Birthday Girl Tiara ain 3in
Part Humber |Short ltem Description List Price Sdle Price
123456 1st Birthday Boy Elue Cupcake Kit 3,93 5 7.99
789112 1st Birthday Boy Cupcake Kit 3,93 5 7.99
543216 1st Birthday Boy Party Hat 4,93 5 3.99
a57416 1zt Birthday Boy Paper Flates 599 5 4,99
301897 1st Birthday Boy Party Banner 1299 § 9,99
5522886 1st Birthday Girl Cake Kit 12,99 % .99
1144585 1st Birthday Girl Cupcake Kit 1299 § 9,99
541531 1zt Birthday Girl Faper Plates 7995 5.99
4421755 1st Birthday Girl Party Invitation 14,99 § 9,99
4546416 1st Birthday Girl Tiara 2499 § 14.99
Preconditions

StiboSystems

In order to take full advantage of this transformation, the table should meet these conditions:

Required:

« The table has a minimum of three columns

Optional:

« Though not required to use the transformation, tables using the Horizontal Fold Table transformation typically
use at least one column type of Heading (1) and/or Sub Heading (2).
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System Setup < Header Column - Column Type

e z

G- Ly Pivot Tables

E] % Price Tables Mame >| > |value

- @[] Price Table » Name Header Column
=8 [l sales Price Table > Defaults Vertical Adjustment:T

...... i i T
------ b | =
...... i Part Mumber * Publication Types Al

=[] Sales Price Table Column Type
m Dimensions
~{fif] Header Column Mame >| > |value
] Part Mumber * Mame Subheader Column
(] Price Before » Defaults Vertical Adjustment:
~{fif] Price NOW oy oo |
1) Ebheader Coumn] ey ie2000 00 | pibHeadn @
[} Bubheade — |
[ weight » Publication Types All
- Head
[ Header = Legal for Table Types
~T] Mormal

This topic assumes the following:

« You have already built the table to which you will be applying the Horizontal Fold Table transformation.
(Instructions on how to build the table itself are not provided in this topic; see the Creating Tables
documentation for more information.)

« You have already designated which columns should be used as the header(s) and/or subheader(s). (This topic

does not describe how to designate columns as such; for information, see the Configuring Column Type
Setting and Formatting topic.)

Applying and Configuring the Horizontal Fold Table Transformation

For this topic, the example table has eight columns, two of which are headers (a header column and subheader
column), and the remainder of which are 'Normal Row' columns. (Even though the setting is Normal 'Row,' this
setting applies to both rows and columns and simply means that the column / row is not used as a header, a
subheader, or a footnote column / row.)

Preview

Sales Price Table 1 32 >3 > 14 3|5 sl 37 » 18 >

Header Column  Subheader Column Dimensions  Weight Dimensions Dimensions Price Before  Price NOW

1§ Parthumber  (Jf Short Item De...| | Size 1§ Product Weight [ Product width ] Product Height |] ListPrice |3 Sale Price

Header ‘UI Mame | PartNumber Short Item Descri... Size Product Weight  |Product Width ProductHeight  |List Price Sale Price

—_
"

(=]
"

Mormal ) Local
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The Preview of the table looks like this before any transformations are applied:

Select version | Acme Party Supplies/English U3 + Select Preview Node | Current Mode
Part Number  |Short ltem Description Size Product Weight |Product Width  |Product Height |List Price Sale Price
[123456 1st Birthday Boy Blue Cupcake  |M/A 2lb 12in 5in §9.99 £7.99
Kit

739112 1st Birthday Boy Cupcake Kit ~ [N/A 2lb 12in 5in £9.99 §7.99
543215 1st Birthday Boy Party Hat All Sizes Sl 4in Bin §4.99 §3.99
357415 1st Birthday Boy Paper Plates  [N/A 1b 12in 12in §5.99 §4.99
301897 1st Birthday Boy Party Banner  [N/A 2lb 36 in 24in §12.99 §3.99
5522886 1st Birthday Girl Cake Kit H/A 3lb 12in 3in £12,99 £9.99
[1144885 1st Birthday Girl Cupcake Kit  [N/A 3lb 12in 3in £12,99 £9.99
541531 1st Birthday Girl Paper Plates  |Assorted 1b gin &in §7.99 §5.99
|4421255 1st Birthday Girl Party Invitation |Assorted 1b 101in 5in §14.99 §3.99
“4p4e416 1st Birthday Girl Tiara One Size 2lb gin 3in §24.99 §14.99

To apply the Horizontal Fold Table transformation:

1. Inthe Tree, navigate to the product or classification object that contains the table to which you would like to
apply the transformation, then click the Tables tab.
Select the table type to which you would like to apply the transformation, then click the Preview tab.
Beneath the table preview, click 'Add Transformation' to display the Select Transformation dialog.

Select the Horizontal Fold Table transformation, then click OK to apply the transformation.
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el 32 Select Transformation
543216
957416 ist Bil
Browse
301397 ist Bif -
iiﬁag E: :Ii -3 Layout Transformations
541531 1st E:‘ ﬁ Sortings
4421255 1stp| | 23 Formatting
4546416 stEl | =3 Transformations

IZ‘;F Merge Equal Cells

- [[§ Merge Over Empty Cells

|]I Remove Attribute Fows/Columns in Group
|]I Make Header Row from Column
- Remove Empty Rows/Columns
~[]¥ Merge Rows/Columns

~[1¥ suppress Rows/Columns

ﬂi Femove Rows/Columns

--[EEH Fold Table

-EH Horizontal Fold Ta_bIE.rI

- [ Horizontal Wrap Table

|]I Footnote Transformation

- Pivot Transformation

- W

» | » [Transformat
] EH Remove Emp
> 1T RowjcColumn| f @ seesi
> 1 Row/Colum
ﬂ Add Transformation Cancel

Next, the transformation itself must be configured. Click the ellipsis on the transformation to launch the
Horizontal Fold Table configuration dialog.

541531 1st Birthday 3% Horizontal Fold Table 5in £7.99 £5.99
Paper Plates
4471755 1st Birthday — , 5in $14.99 £9.99
Party Invitai ] Repeat Al Heading 1's at left.
4546416 1st Birthday []Repeat Last Heading 2 3in £24,99 214,99
Tiara "\.
[ ] Protect against orphans.
ax Orphans to move
¥ | ¥ [Transformation .
» [Ed Remove Empty R Folds 1 mns Heading Rows 0 Hea olumns 0
» I Row/Column Tex] Cancel e unit from value Insert text befor
» 13 Row/Column Tex] ext before
> [ Horizontal Fold Table [Fulds 1Repeat All Heading 1's at left. “false™ Repeat Last Heading 2 "false™ _IZ'
ﬂ Add Transformation
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6. The options within the Horizontal Wrap Table transformation dialog and their functions are as follows. The

options are described in the logical order in which they are typically selected.

« Folds: Inthe Folds field, enter a number to designate how many times the table should be folded. The

pefinition |l

following screenshot shows a preview of the table with (3) entered in this field.

Select version | Acme Party Supplies/English US . Select Preview Node | Current Mo

Part Number Short ltem Description Size
123456 1st Birthday Boy Elue Cupcake Kit M fA
789112 1st Birthday Boy Cupcake Kit M fA
543216 1st Birthday Boy Party Hat All Sizes
957416 1zt Birthday Boy Paper Plates M fA
301897 1st Birthday Boy Party Banner M fA
5522886 1st Birthday Girl Cake Kit M fA
1144885 1st Birthday Girl Cupcake Kit M fA
541531 1zt Birthday Girl Paper Plates Assorted
4421255 1st Birthday Girl Party Invitation Assorted
4546416 1st Birthday Girl Tiara One Size
Product Weight Product Width Product Height
2lb 12im 5in

2lb 12im 5in

Sl 4in 2in

1lb 12im 12in
2lb 35in 24in
3lb 12im 3in

3lb 12im 3in

1lb ain Gin

1lb 10im 5in

2lb ain 3in

List Price Sale Price

£9.99 £7.99

£9.99 £7.99

£4.99 £3.99

£2.99 £4.99

£12.99 £9.99

£12.99 £9.99

£12.99 £9.99

57.99 £2.99

£14.99 £9.99

£24.99 £14.99
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Repeat All Heading 1's at left.: Check this box to repeat all Heading (1) columns at the beginning of each
wrap. The below example shows how this table looks with the settings configured as follows:
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3% Horizontal Wrap Table

Repeat All Heading 1's at left.

[] Repeat Last Heading 2

Wrap on column type |Dimensions o |

Repeats |2 |

[k || cancel |

Preview

StiboSystems

Sales Price Table 1 3 (2 3 (3 4 3|5 & (7 3
eader Column | Subheader Column  [imensions  Weight Dimensions Dimensions Price Before  Price NOW
1§ Parttumber  |]F shortttemDe...[]f Sizz []T Product weight [T Product width |]f Product Height |]f Ustrice || Sale Price
1 »Header ‘HI Name | |Part Number Short Item Desari... Size Product Weight  Product Width ProductHeight  [List Price Sale Price
2 > Normal 5 Local
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Select version | Acme Party Supplies/English US  « Select Preview Mode | Current Mode

| Short tem Description Size Product Weight
123456 1st Birthday Boy Blue Cupcake Kit  |N/A 2lb
789112 1st Birthday Boy Cupcake Kit M/A 2lb
543216 1st Birthday Boy Party Hat all Sizes Sl
957416 1st Birthday Boy Paper Plates M/A 1l
301897 1st Birthday Boy Party Banner M/A 2lb
5522836 1st Birthday Girl Cake Kit M/A 3lb
1144885 1st Birthday Girl Cupcake Kit M/A 3lb
541531 1st Birthday Girl Paper Plates Assorted 1l
4421255 1st Birthday Girl Party Invitation Assorted 1l
4596415 1st Birthday Girl Tiara One Size 2lb
| Product Width Product Height List Price
123456 12in Sin £9.99
739112 12in Sin £9.99
543216 4in ain £4.99
957416 12in 12in £5.99
301897 36in 24in £12.99
5522886 12in 3in £12.99
1144885 12in 3in £12.99
541531 3in Gin £7.99
4421255 10in Sin £14.99
4546416 3in 3in £24.99
| Sale Price
123456 £7.99
739112 £7.99
543216 £3.99
957416 £4.99
301897 £9.99
5522886 £9.99
1144885 £9.99
541531 £5.99
4421255 £9.99
4540416 £14.99

» Repeat Last Heading 2: Tick this box to repeat the last subheader column at the beginning of each wrap. A
typical setup includes only one header and one subheader column. The below example shows how this table
looks with the settings configured as follows:
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3! Horizontal Fold Table

Repeat All Heading 1's at left.

Fepeat Last Heading 2

[] Protect against orphans.

Orphans to move | |

Folds |3 |

| ok || cancel |

Preview

Salles Price Table i 3 (2 |3 ¥ |4 ¥ (5 > (6 |7 > (8

Header Column  Subheader Column [Dimensions  Weight Dimensions Dimensions Price Before  Price NOW

T Parthumber |[3, Short ltem De...||] Size | Product weight |§ Product Width || Product Height |3 ListPrice [T Sale Price

Header ‘UI Name | |Part Number Shart Item Desdri... Size Product Weight  [Product Width ProductHeight  |List Price Sale Price

=y
w

2 »Normal (g Local
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STl Preview |
Select wersion | Acme Party Supplies/English US w Select Previ
IPart Number |Short ltem Description | Size Product Weight

123456 1st Birthday Boy Blue Cupcake Kit  |N/A 2lb
739112 1st Birthday Boy Cupcake Kit M/A 2lb
543216 1st Birthday Boy Party Hat all Sizes Slb
957416 1st Birthday Boy Paper Plates M/A 1lb
301897 1st Birthday Boy Party Banner M/A 2lb
5522856 1st Birthday Girl Cake Kit M/A 3lb
1144335 1st Birthday Girl Cupcake Kit M/A 3lb
541531 1st Birthday Girl Paper Plates Assorted 1lb
4421255 1st Birthday Girl Party Invitation Assorted 1lb
4546416 1st Birthday Girl Tiara One Size 2lb
Part Number |Short ltem Description Product Width |Product Height
123456 1st Birthday Boy Blue Cupcake Kit  |12in 5in
789112 1st Birthday Boy Cupcake Kit 12in 5in
543216 1st Birthday Boy Party Hat 4in ain
957416 1st Birthday Boy Faper Plates 12in 12in
301897 1st Birthday Boy Party Banner 36 in 24in
5522886 1st Birthday Girl Cake Kit 12in 3in
1144885 1st Birthday Girl Cupcake Kit 12in 3in
541531 1st Birthday Girl Paper Plates ain G in
4421255 1st Birthday Girl Party Invitation 10in 5in
4546416 1zt Bi i ain 3in
Part Number |Short ltem Description List Price Sale Price
123456 1st Birthday Boy Blue Cupcake Kit 59,99 £7.99
739112 1st Birthday Boy Cupcake Kit £9.99 £7.99
543216 1st Birthday Boy Party Hat £4.99 £3.99
957416 1st Birthday Boy Paper Plates £5.99 £4.99
301897 1st Birthday Boy Party Banner £12.99 £9.99
55228586 1st Birthday Girl Cake Kit £12.99 £9.99
1144885 1st Birthday Girl Cupcake Kit £12.99 £9.99
541531 1st Birthday Girl Paper Plates £7.99 £5.99
4421255 1st Birthday Girl Party Invitation £14.99 £9.99
4546416 1st Birthday Girl Tiara £24.99 £14.99

« Protect against orphans. and Orphans to Move: 'Orphan'is a typographical term that refersto a
paragraph-opening line that appears by itself at the bottom of a page or column, thus separated from the rest
of the text. The same concept applies to 'orphaned’ columns in folded tables.

Sometimes a'Normal' (non-header) column can end up by itself on a fold when the headers are repeated,

causing it to be 'orphaned,' as such:
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Definition | Rl

Select version | Acme Party Supplies/English IS « Gelect Preview MNode | Current Mode

Part Number Short tem Description Size Product Weight Product Width
123456 1st Birthday Boy Blue Cupcake Kit A 2lb 12in
739112 1st Birthday Boy Cupcake Kit A 2lb 12in
543216 1st Birthday Boy Party Hat Al Sizes Sl 4in
957416 1st Birthday Boy Paper Plates A 1lb 12in
301897 1st Birthday Boy Party Banner A 2lb 36in
5522830 1st Birthday Girl Cake Kit A 3lb 12in
1144885 1st Birthday Girl Cupcake Kit A 3lb 12in
541531 1st Birthday Girl Paper Plates Assorted 1lb gin
4421255 1st Birthday Girl Party Invitation Assorted 1lb 10in
4546416 1st Birthday Girl Tiara One Size 2lb gin
Part Number Short ltem Description Product Width Product Height List Price
123456 15t Birthday Boy Blue Cupcake Kit 12in 5in £9,99
739112 15t Birthday Boy Cupcake Kit 12in 5in £9,99
543216 15t Birthday Boy Party Hat 4in ain £4,99
857416 15t Birthday Boy Paper Flates 12in 12in £5.99
301397 15t Birthday Boy Party Banner 36in 24in £12,99
5527886 15t Birthday Girl Cake Kit 12in 3in £12.99
1144385 15t Birthday Girl Cupcake Kit 12in 3in £12,99
541531 15t Birthday Girl Paper Plates 3in G6in £7.99
4421255 1st Birthday Girl Party Invitation 10in 5in £14.99
4646416 15t Birthday Girl Tiara 2in 3in £24,99
Part Number Short ltem Description Sale Price

123456 1st Birthday Boy Blue Cupcake Kit £7.99

789112 1st Birthday Boy Cupcake Kit £7.99

543216 1st Birthday Boy Party Hat £3.99

857416 1st Birthday Boy Paper Plates £4.99

301897 1st Birthday Boy Party Banner £9.99

5527886 1st Birthday Girl Cake Kit £9.99

1144885 1st Birthday Girl Cupcake Kit £9.99
541531 1st Birthday Girl Paper Plates 40,99

Note: Number of folds takes precedence over orphan protection, so this option is more of a 'protect if possible'
option. In addition, this option only works when Sub Heading (2) columns are repeated; it will not work if only
Heading (1) level columns are repeated.

For the table pictured in the previous screenshot, ticking 'protect against orphans' will move the orphaned
column (Sale Price) up to the previous fold so it is no longer by itself. For this configuration, (1) has been
entered for Orphans to move.
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3! Horizontal Fold Table

Repeat All Heading 1's at left.

Fepeat Last Heading 2

Protect against orphans.

Orphans to move |1

Folds 3

Cancel

The 'orphan' Sale Price column is now moved to the previous fold:

Definition |l

Select version | Acme Party Supplies/English US + Select Preview Mode | Current Node

Part Number Short ltem Description Size Product Weight Product Width

123456 1st Birthday Boy Blue Cupcake Kit A 2lb 12in

789112 1st Birthday Boy Cupcake Kit A 2lb 12in

543216 1st Birthday Boy Party Hat All Sizes Sl 4in

357416 1st Birthday Boy Paper Plates A ilb 12in

301897 1st Birthday Boy Party Banner A 2lb 36in

5522886 1st Birthday Girl Cake Kit A 3lb 12in

1144885 1st Birthday Girl Cupcake Kit A 3lb 12in

541531 1st Birthday Girl Paper Plates Assorted ilb 3in

4421255 1st Birthday Girl Party Invitation Assorted ilb 10in

4646416 1st Birthday Girl Tiara One Size 2lb 3in

Part Number Short tem Description Product Width Product Height List Price Sale Price
123456 1st Birthday Boy Blue Cupcake Kit 12in 5in £9.99 57.99
789112 1st Birthday Boy Cupcake Kit 12in 5in £9.99 57.99
543216 1st Birthday Boy Party Hat 4in ain 4,99 £3.99
957416 1st Birthday Boy Paper Plates 12in 12in £5.99 24,99
301897 1st Birthday Boy Party Banner 36in 24in 512,99 53,99
5522886 1st Birthday Girl Cake Kit 12in 3in £12.99 £9.99
1144885 1st Birthday Girl Cupcake Kit 12in 3in £12.99 £9.99
541531 1st Birthday Girl Paper Plates ain 6in £7.99 £5.99
4421255 1st Birthday Girl Party Invitation 10in 5in 514,99 53,99
4546416 1st Birthday Girl Tiara ain 3in £24.99 £14.99
Part Number

'123456

789112

543216

957416

301897

5522886

1144385
A5-1:1531
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Orphaned Header Columns

As illustrated in the preceding section, moving an orphaned 'Normal' column can sometimes create an orphaned
header. In this example, it is the 'Part Number' Heading (1) column that has been orphaned and now appears by
itself on the last fold. Removing it will require a separate table transformation. (It is not unusual, however, to have
multiple transformations stacked on one another, as this is common with tables in order to manipulate them to their
final form.)

To remove this 'empty' header, the 'Remove Empty Rows/Columns' transformation must be added after the
Horizontal Fold Table transformation. Full instructions on how to configure this transformation are described in the
Table Transformation: Remove Empty Rows/Columns topic. But, to illustrate the configuration for this
example, a value of '1' is entered in the 'Heading Columns' field and the 'Remove Rows' box is ticked.

$2 Remove Empty Rows/Columns

Heading Rows 0|

Heading Columns 1

Remaove Rows

[ ] rRemove Columns

Cancel

The table now looks like this:
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Select version | Acme Party Supplies /English US « Select Preview Mode | Current Mode
Part Humber Short Item Description Size Product Weight Product Width

123456 1zt Birthday Boy Blue Cupcake Kit A 2lb 12in
789112 1st Birthday Boy Cupcake Kit /A 2lb 12in
543216 1st Birthday Boy Party Hat all Sizes Sl 4in
957416 1st Birthday Boy Paper Plates /A 1lb 12in
301857 1st Birthday Boy Party Banner /A 2lb 36 in
55228560 1st Birthday Girl Cake Kit /A 3lb 12in

1144885 1st Birthday Girl Cupcake Kit /A 3lb 12in
541531 1st Birthday Girl Paper Flates Assorted 1lb gin
4421255 1st Birthday Girl Party Invitation Assorted 1lb 10in
4646416 1st Birthday Girl Tiara One Size 2lb gin
Part Number Short item Description Product Width Product Height List Price Sale Price
123456 1st Birthday Boy Blue Cupcake Kit 12in 5in 9.99% 7.99
789112 1st Birthday Boy Cupcake Kit 12in 5in 9.99% 7.99
543216 1st Birthday Boy Party Hat 4in ain 4995 3.99
957416 1zt Birthday Boy Paper Plates 12in 12in 5.99% 4,99
301397 1st Birthday Boy Party Banner 36in 24in 12,995 9.99
5522386 1st Birthday Girl Cake Kit 12in 3in 12,995 9.99
11448585 1st Birthday Girl Cupcake Kit 12in 3in 12,99 § 9,99
541531 1=t Birthday Girl Paper Plates ain Gin 7.99% 5,99
4421255 1st Birthday Girl Party Invitation 101n 5in 14,99 § 9,99
4546416 1st Birthday Girl Tiara ain 3in 24,99 § 14,99

Table Transformation: Horizontal Wrap Table

The Horizontal Wrap Table transformation is used to 'wrap' wide tables that contain a large number of columns
into a taller, vertically oriented table. Users may have a need for the Horizontal Wrap Table transformation if the
table is so wide that it either cannot fit within a single InDesign page column or page, or if a vertical layout is
desired.

This transformation works similarly to the 'Horizontal Fold Table' transformation (documented in the Table
Transformation: Horizontal Fold Table topic), as both facilitate the ability to 'fold' a wide table into multiple
table sections ('folds' or 'wraps') that stack on top of one another. However, unlike the Horizontal Fold Table
transformation, a table folded using the Horizontal Wrap Table transformation is not folded based on a designated
number of folds, but rather on particular column types, providing control over where these particular column types
land within the folds.

Though there are many combinations of configurations that can be applied within the transformation, the following
two screenshots show a sample 'before' and "after’ of a table (as previewed within the workbench) after applying
the Horizontal Wrap Table transformation.

Before:
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e It Bithday 10103 - Tables
A (| Product || SubProducts || References || Referenced By || Images & Documents || Commercial Categary Profie || Proof View || Status

(-7 Safety
(+-[7) Hardware Q Tables e
; ) Nameg » |Defined At
[+-[7) Displays
E Furniture » Price Table Products
r_=| Automotive » Sales Price Table Local
rj Budng Products » Bpedfication Table Party Supplies
[ 7] Blectrical and Electronics
ij Food and Beverage » TTable Guide Not Defined
i [ Kitchen > |Add Tahle Tupe
- st sies oo
g ;arst:sHats Select version  Acme Party Supplies/Enalish US « Select Preview Node | Current Node
g a
--ﬁ Streamers Part Number |Short ltem Description Size Product Weight |Product Width |Product Height |List Price | Sale Price
=[] Chid Birthday Parties 123456 1st Birthday Boy Blue Cupcake Kit [N/A 2b 12in 5in 49,99 $7.99
-] IstBirthday 789112 istBirthday Boy Cupcake kit N/ 2 12in Sin 49,99 £7.99
rj Sweet 16 543216 1st Brthday Boy Party Hat Al Sizes |5 4in 3in £4.99 £3.99
[+ 7] Wedding 957416 1st Birthday Boy Paper Plates  [NJA 1 12in 12in £5.99 44,99
#-[5) Alarms 301897 1st Birthday Boy Party Banner ~ |NJ/A 2b ¥in 24in §12.99 49,99
- Alarm Clocks 5522836 1st Birthday Girl Cake Kit NJA 3k 12in 3in £12.99 $9.99
e[ Bectronics 1144885 1st Birthday Gil Cupcake kit /A 3b 12in 3in §299 3.9
[ Discontinued Products 541531 1stBirthday Girl Paper Plates  |Assorted  |1lb 8in ain £7.99 45,99
[ Product Overrides 4421255 1st Birthday Girl Party Invitation |Assorted  |1lb 10in 5in £14.99 49,99
i Packaing 44416 1st Birthday Girl Tiara OneSize 2 8in 3in £24,99 £14.99

After (preview only pictured):

© Stibo Systems - Confidential - STEP Trailblazer 8.2 145



pefinition |

StiboSystems

Select version | Acme Party Supplies/English LIS

w Select Preview Mode | Current M

Part Number |Short ltem Description Size Product Weight |Product Width
123456 1st Birthday Boy Blue Cupcake Kit  |N/A 2lb 12in
789112 1st Birthday Boy Cupcake Kit M/A 2lb 12in
543216 1st Birthday Boy Party Hat all Sizes Sl 4in
957416 1st Birthday Boy Paper Flates M/A 1lb 12in
301897 1st Birthday Boy Party Banner M/A 2lb 36in
5522886 1st Birthday Girl Cake Kit M/A 3lb 12in
1144885 1st Birthday Girl Cupcake Kit M/A 3lb 12in
541531 1st Birthday Girl Paper Plates Assorted 1lb 3in
4421255 1st Birthday Girl Party Invitation Assorted 1lb 10in
4546416 1st Birthday Girl Tiara one Size 2lb 3in
Part Humber |Short ltem Description Product Height  |List Price Sale Price
123456 1st Birthday Boy Blue Cupcake Kit  |5in 9,99 £7.99
739112 1st Birthday Boy Cupcake Kit 5in 9,99 £7.99
543216 1st Birthday Boy Party Hat 3in £4,99 £3.99
a57416 1st Birthday Boy Paper Flates 12in £5.99 £4,99
301897 1st Birthday Boy Party Banner 24in £12.99 £9.,99
5522886 1st Birthday Girl Cake Kit 3in £12.99 £9.,99
1144885 1st Birthday Girl Cupcake Kit 3in £12.99 £9.99
541531 1st Birthday Girl Faper Plates Gin £7.99 £5.99
4421755 1st Birthday Girl Party Invitation 5in £14.99 £9.,99
4546416 1st Birthday Girl Tiara 3in £74,99 £14,99

Preconditions

In order to take full advantage of this transformation, the table should meet these conditions:

Required:

« The table has a minimum of three columns

« The table uses the same column type in at least two places within the table. This is the column type on which the
table will be wrapped and must be a column type of 'Normal Row.'

Optional:

« Though not required to use the transformation, tables using the Horizontal Wrap Table transformation typically
use at least one column type of Heading (1) and/or Sub Heading (2).

System Setup Header Column - Column Type

Eﬁ Table Types Eulumn T'yrpE

I Eﬁ Pivot Tables

E] Eﬁ Price Tables Mame > |Value

- [ Price Table * Name Header Column
B [l sales Price Table > Defaults Vertical Adjustment:T

------ m Dimensions N P i-
------ | Freader Column | Meadng
...... i Part Mumber * Publication Types Al

© Stibo Systems - Confidential - STEP Trailblazer 8.2

146



StiboSystems

€ Subheader Column - Column Typ

=[] Sales Price Table s Column Type
m Dimensions
—{fff] Header Column Name > > |value
~{flf] Part Mumber * Mame Subheader Column
~{fi] Price Before » Defaults Vertical Adjustment:
] Price NOW |
- L eadng/ro | Pibreadng )
- — I ———
| Weight * Publication Types All
A Head
T Header &= Laaal for Table T
E Nurmal

This topic assumes the following:

« You have already built the table to which you will be applying the Horizontal Wrap Table transformation.
(Instructions on how to build the table itself are not provided in this topic; see the Creating Tables
documentation for more information.)

« You have already designated which columns should be used as the header(s) and/or subheader(s). (This topic
does not describe how to designate columns as such; for information, see the Configuring Column Type
Setting and Formatting topic.)

Applying and Configuring the Horizontal Wrap Table Transformation

For this topic, the example table has eight columns, which includes the repeating column type of 'Dimensions.' The
Dimensions column is a 'Normal Row' column. (Even though the setting is Normal 'Row,' this setting applies to
both rows and columns and simply means that the column / row is not used as a header, a subheader, or a
footnote column / row.)

System Setup L 4 Dimensions - Column Type

EI% Price Tahles ~ Column Type

[#-[ff] Price Table |

H > >

E}--ﬂjj Sales Price Table Mame Value
b » Name Dimensions
) Dimensions] eee _|] > |
e flf] Header Column > Vertical Adjustment:Tap
e Part Mumber
i ] » Heading/Footer Mormal Row
-[lf] Price Before
- m Price NOW » Publication Types all

The 'Dimensions’ column type is used in three places in the table. The attributes used for the 'Dimensions' column
are Size, Product Width, and Product Height.
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Preview

Sales Price Table { > [z 5 (3 3 |4 5[5 3l (7 > >

Header Column  Subheader Column | Dimensions | Weight Dimensions Dimensions Price Before  Price NOW

1f Parttumber || shortttemDe... ] Size  |[|T Product weight | [ Product Width [[] Product Height || ListPrice  []T Sale Price

1 »Header ‘JI Mame | [PartMumber Short Ttem Descri... |Size Product Weight  |Product Width ProductHeight  |List Price Sale Price
2 > Normal (5 Local

Before applying the transformation, the table looks like this in the Preview view (Dimensions columns types are
outlined):

Definition |

Select version | Acme Party Supplies/English US «w Select Preview Node | Current Mode

Part Humber |Short ltem Description |5i1e~ | Product Weight ||Product Width |Product Height | List Price | Sale Price
t

123456 1st Birthday Boy Blue Cupcake Ki 2lb TTZn 5N £9.99 £7.99
739112 1st Birthday Boy Cupcake Kit A 2b 12in 5in 29,99 £7.99
543216 1st Birthday Boy Party Hat All Sizes s 4in ain 24,99 £3.99
957416 1st Birthday Boy Paper Flates A 1b 12in 12in £5.99 24,99
301897 1st Birthday Boy Party Banner A 2b 36in 24in 212,99 29,99
5522886 1st Birthday Girl Cake Kit A ib 12in 3in $12.99 £9.99
1144885 1st Birthday Girl Cupcake Kit A ib 12in 3in $12.99 £9.99
541531 1st Birthday Girl Paper Flates Assorted  |1lb ain G in £7.99 £5.99
4421255 1st Birthday Girl Party Invitation |Assorted [1lb 10in 5in 214,99 29,99
4546416 1st Birthday Girl Tiara CneSize 2b ain 3in 274,99 214,99

To apply the Horizontal Wrap Table transformation:

1. Inthe Tree, navigate to the product or classification object that contains the table to which you would like to
apply the transformation, then click the Tables tab.

Select the table type to which you would like to apply the transformation, then click the Preview tab.
Beneath the table preview, click 'Add Transformation' to display the Select Transformation dialog.

Select the Horizontal Wrap Table transformation, then click OK to apply the transformation.
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123456

f@9112

543216

957416

301897

5522580
1144685

541531

4421255

4046416

.

}ﬂ
> 13
>[4 |13

ﬂ Add Transformation

Transformai

Remove Emg

Row/Calumn

Row/Caolumn

31 Select Transformation

Browse

|°_="I Layout Transformations

|'='_='I Sortings

-3 Formatting

-3 Transformations

D* Merge Equal Cells

- [ Merge Over Empty Cells

~[]3 Remove Attribute Rows/Columns in Groug
|]I Make Header Row from Column
- Remowve Empty Rows/Columns
(1§ Merge Rows/Columns

~[]¥ suppress Rows/Columns

~[]¥ remove Rows/Columns

-[EEH Fold Table

--[EH Horizontal Fold Table

lﬁ Horizontal Wrap Table I

L|_I_ Footnote Transformation

-[EH Pivot Transformation

®- Details

Cancel

StiboSystems

5. Next, the transformation itself must be configured. Click the ellipsis on the transformation to launch the
Horizontal Wrap Table configuration dialog.

11443885 1st Birtd 3in 512,99 $9.99
Cupcaks 3 Horizontal Wrap Table

541531 1st Birth & in £7.99 £5.99
Paper P| [ ] Repeat All Heading 1's at left.

4421255 1st Birth Sin £14.99 £3.99
Party I [ ] Repeat Last Heading 2

4545416 1st Birth 3in £24.,99 £14.99

P - Wrap on column type |Dimensions e

» | * [Transformati >

> [E] Remove Emp| Repeats 2] Columns Heading Rows 0 Columns 0

» I Row/Column Cancel emove unit from value Insert text be

» I Row/Column ert text before

1
> [FH Horizontal Wrap Table IF.epeats 1 Repeat All Heading 1's at left. “false™ Repeat Last Heading 2 “false”
ﬂﬁu:lu:l Transformation

6. The options on the Horizontal Wrap Table and their functions are as follows. The options are described in the
logical order in which they are typically applied.
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« Wrap on column type: Select the column type on which the table should be wrapped. This is a dropdown
list that contains all column types used in the table. For the example table in this topic, the Dimensions
column type is used.

« Repeats: Enter the number of times the chosen 'wrap on' column type should appear in each wrap (fold) of
the table. If (1) is entered, one 'Dimensions' column will appear on each table wrap:

pefinition | Il

Select version | Acme Party Supplies/English US
Part Number Short ltem Description | Sire | Product Weight
123456 1st Birthday Boy Blue Cupcake Kit Z2lb
789112 1st Birthday Boy Cupcake Kit M A Z2lb
543216 1st Birthday Boy Party Hat All Sizes Sl
957416 1st Birthday Boy Paper Flates M A 1lb
301897 1st Birthday Boy Party Banner M A Z2lb
5522886 1st Birthday Girl Cake Kit M A 3b
1144585 1st Birthday Girl Cupcake Kit M A 3b
541531 1st Birthday Girl Paper Flates Assorted 1lb
4421255 1st Birthday Girl Party Invitation Assorted 1lb
4546416 1st Birthday Girl Tiara One Size Z2lb
Product Width

in
12in
4in
12in
35in
12in
12in
3in
100in
3 in
List Price Sale Price

] 5£9.95 £7.99
Sin 5£9.95 £7.99
3in 54199 £3.99
12in 5£3.99 £4.99
24in 5£12.99 £9.99
3in 5£12.99 £9.99
3in 5£12.99 £9.99
Gin 57.99 £5.99
Sin 5£14.99 £9.99
3in 524.99 514,99

If (2) is entered, there will be two Dimensions columns on each 'wrap.' (Only one Dimensions column
appears on the second wrap in this example since there are only three Dimensions columns in the table.)
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pefinition |l

Select version | Acme Party Supplies/English LS « Select Preview Mode | Current Mode

Part Number Short tem Description Product Weight Product Width

123456 1st Birthday Boy Blue Cupcake Kit|N/A 2lb 12in
739112 1st Birthday Boy Cupcake Kit M/A 2lb 12in
543216 1st Birthday Boy Party Hat all Sizes Slb 4in
957416 1st Birthday Boy Paper Plates M/A 1lb 12in
301897 1st Birthday Boy Party Banner  |N/A 2lb 35 in
5522886 1st Birthday Girl Cake Kit M/A 3lb 12in
1144335 1st Birthday Girl Cupcake Kit M/A 3lb 12in
541531 1st Birthday Girl Paper Plates Assorted 1lb gin
4421255 1st Birthday Girl Party Invitation |Assorted 1lb 10in
4646416 1st Birthday Girl Tiara One Size 2lb gin
IProduct Height I List Price Sale Price

Sin £3.99 $7.99

Sin £3.99 $7.99

gin 54.99 £3.99

12in £3.99 $4.99

24in £12.99 $9.99

3in £12.99 $9.99

3in £12.99 $9.99

gin £7.99 £3.99

Sin £14.99 $9.99

3in £24.99 £14.99

» Repeat All Heading 1's at left.: Check this box to repeat all Heading (1) columns at the beginning of each
wrap. The below example shows how this table looks with the settings configured as follows:

32 Horizontal Wrap Table

Repeat All Heading 1's at left.

[ ] Repeat Last Heading 2

Wrap on column type | Dimensions w

Repeats 2

Cancel
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Preview

Sales Price Table 1 3 (2 3 (3 > 4 3 (5 3 (5 (7 3 (3
Header Column | Subheader Column  [imensions — Weight Dimensions Dimensions Price Before  Price NOW

1§ Parttumber  |[|f Short ttem De... | Size |f Product weight ||§ Product width |]§ Product Height |]f UstPrice || Sale Price

1 Header ‘E Name | PartMumber Short Item Descri... (Size Product Weight  Product Width ProductHeight  [List Price Sale Price
2 » Normal (G Local

| efinition |

Select version | Acme Party Supplies/English US « Select Preview Mode | Current Made
I Part Number I Short Item Description Sire Product Weight Product Width
1st Birthday Boy Blue Cupcake Kit |M/A 2lb 12in

|739112 1st Birthday Boy Cupcake Kit A 2lb 12in
|543216 1st Birthday Boy Party Hat All Sizes 1] 4in
|357416 1st Birthday Boy Paper Plates A 1lb 12in
|301897 1st Birthday Boy Party Banner  |M/A 2lb 36 in
|9522886 1st Birthday Girl Cake Kit A 3lb 12in
|1144855 1st Birthday Girl Cupcake Kit A 3lb 12in
|541531 1st Birthday Girl Paper Flates Assorted 1lb ain
|4421255 1st Birthday Girl Party Invitation |Assorted 1lb 10in

4640416 1st Birthday Girl Tiara One Size 2lb ain
Product Height List Price sale Price

| 456 Sin £9.99 £7.99

|789112 Sin £9.99 £7.99

|543216 8in £4.99 £3.99

1957416 12in £5.99 £4.99

|301897 24in £12.99 £9.99

|5522886 3in £12.99 £9.99

11144885 3in £12.99 £9.99

|541531 & in £7.99 £5.99

|4421255 Sin £14.99 £9.99

|4646416 3in £24.99 £14.99

« Repeat Last Heading 2: Check this box to repeat the last subheader column at the beginning of each wrap. A
typical setup includes only one header and one subheader column. The below example shows how this table
looks with the settings configured as follows:
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¥ Horizontal Wrap Table

Repeat All Heading 1's at left.

Repeat Last Heading 2

Wrap on column type | Dimensions o

Repeats 2

Cancel

Preview

Sales Price Table i s s |3 s |4 3|5 3 |6 37 5B
Header Column  Subheader Column [Dimensions  Weight Dimensions Dimensions Price Before  Price NOW
Part Number JI Shart Ttem De... | Size 1 Product weight |Jf Product width || Product Height || ListPrice [T Sale Price
1 »Header ‘JI Name | |Part Number Short Item Desri... [Size ProductWeight  [Product Width  |ProductHeight |List Price Sale Price
2 »Normal (5 Local

T | Preview |

Select version | Acme Party Supplies /English US « Select Preview Mode | Current Mode

Part Number Size Product Weight |Product Width
123456 1st Birthday Boy Blue Cupcake Kit |N/A 2l 12in
739112 1st Birthday Boy Cupcake Kit M A 2l 12in
543216 1st Birthday Boy Party Hat All Sizes 5lb 4in
957416 1st Birthday Boy Paper Plates M A 1lb 12in
301397 1st Birthday Boy Party Banner  |N/A 2l 3ain
5522886 1st Birthday Girl Cake Kit M A 3l 12in
11445885 1st Birthday Girl Cupcake Kit M A 3l 12in
541531 1st Birthday Girl Paper Plates Assorted 1lb gin
4421255 1st Birthday Girl Party Invitation |Assorted 1lb 10in
4545416 1st Birthday Girl Tiara One Size 2l gin
Short ltem Description Product Height __|List Price sale Price
123456 1st Birthday Boy Blue Cupcake Kit|5in £9.99 £7.99
739112 1st Birthday Boy Cupcake Kit 5in £9.99 £7.99
543216 1st Birthday Boy Party Hat 3in £4.99 £3.99
257416 1st Birthday Boy Paper Plates 12in £5.99 £4.99
301897 1st Birthday Boy Party Banner  |24in £12.99 £9.99
‘5522886 1st Birthday Girl Cake Kit 3in £12.99 £9.99
1144835 1st Birthday Girl Cupcake Kit 3in £12.99 £9.99
541531 1st Birthday Girl Paper Plates & in £7.99 £5.99
4421255 1st Birthday Girl Party Invitation |5in £14.99 £9.99
4545416 1st Birthday Girl Tiara 3in £24.99 £14.99
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Table Layout Transformations

When you add a transformation, you typically need to specify parameters for the transformation to work. The
following describes the parameters for the layout transformations.

« Apply Alternate Row Colors
« Repeated Rule
« Rule When Different

Before you can specify any parameters, you have to add the transformation.
In the Tree, click the relevant product, and then click the Tables tab.
Click a table type, and then click the Preview tab.

Click Add Transformation. The Select Transformation dialog appears.

A w0 Db~

Select the relevant transformation, and then click OK.

Apply Alternate Row Colors
Alternates the background shading of rows at a specified frequency.

1. Under Parameters, click the ellipsis button (...). The Alternate Row Color dialog appears.

E] Alternate Row Colors I&

Restart count after Headings | Ignore Headings P w

[] Ignore Footers

Maormal Colored Rows 1
Alternate Colored Rows 1
Mormal Color _White -
Alternate Color _Light Blue -

[ OK, H Cancel

2. Inthe Restart after Headings above list, select either Ignore Headings, 1 or 2.

Selecting 1 or 2 enables you to restart the application of alternate shading after each header row of a certain
level number.

3. Inthe Normal Colored Rows field, enter the number of rows to shade in normal color before shading rows
with the alternate color.

4. Inthe Alternate Colored Rows field, enter the number of rows to shade in alternate color before shading
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rows with the normal color again.

In the Normal Color list, select the relevant color.
In Alternate Color list, select the relevant color.

Click OK.

Note: For a more complex level of control over the appearance of alternate-colored rows in lengthy, split tables
with multiple repeated headers, the Alternating row colors settings available in the Header Repeating
Pagination Plugin may be a better option than using the Alternate Colored Rows transformation. For more
information, see the Header Repeating Pagination Plugin section of the Tables documentation.

Repeated Rule

Inserts a specified line style.

1.

N o o ko

Under Parameters, click the ellipsis button (...). The Repeated Rule dialog appears.
FE] Repeated Rule I&w

Restart Heading Level |Mone e

Restart when other rule found

Add rule per raws 1
Rule Above Mone -
Rule Below Mone -

[ Ok ]| Cancel

From the Restart Heading Level list, choose either None, 1 or 2.

None is the default setting. No line style is inserted at heading level.

When you select 1 or 2, the line style is applied again after each header row of the specified level number.

Check Restart when other rule if you want to reset the count when another line style is found in the table.
In the Add rule pr rows field, enter a relevant number of rows to putin a line style.

From the Rule Above list, select the relevant line style to be used as the top border of the row.

From the Rule Below list, select the relevant line style to be used as the bottom border of the row.

Click OK.

Rule When Different

Inserts a specified line style when column content changes.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 155



StiboSystems

1. Click Rule When Different, and then click OK.

. Under Parameters, click the ellipsis button (...).

The Rule When Different dialog appears.

[ E] Rule When Different [—L?-f

Ignore Headings

Column |

Rule Below |Mone -

[ K H Cancel ]

. Check the Ignore Headings check box if you do not want the transformation to consider contents in Header
Columns Types.

. Inthe Column field,click the ellipsis button (...). The Select Row/Column dialog opens.

[ E] Select Row/Calumn Iﬁ1

@ Rowé () Columnn

(™) Attribute E]
(7 ProductfClassificationfAsset [Z]
(71 Heading

@ Type =

) Number

[ oK H Cancel

« Select Row or Column to specify whether the transformation applies to a row or a column.

« Select Attributes to apply the transformation to the column that contains the specified attribute. Click the
ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

» Select Heading to identify a column or row by typing the header text of the relevant column or row.

» Select Type to identify the column or row by selecting Column Type or Row Type.
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« Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then simply type 2.

5. Fromthe Rule Below list, click the relevant Line Style to be used as the bottom border of the row.

6. Click OK.

Table Sorting Transformations

The Standard Sorting transformation enables you to sort the rows in your table according to the contents of one
or more columns.

1. Click Standard Sorting, and then click OK.
2. Under Parameters, click the [...] button. The Standard Sorting dialog appears.
3. Click Add Sorting Row/Column to display sorting priority options.

r -
E] Standard Sorting I&
Heading Rows |0 Trailing Rows |0

Undefined Q [/] Ascending @ Alphabetic ) Mumeric  (7) Fraction

Add Sorting Row,Column ]

[ oK ” Cancel ]

4. Inthe Heading Rows field, enter the number of heading rows that you want to exclude from the sorting
transformation.

5. Inthe Trailing Rows field, enter the number of trailing rows that you want to exclude from the sorting
transformation.

6. InUndefined, click the ellipsis button (...). The Select Row/Column dialog appears.
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[ E] Select Row/Column &Jﬁ

@ Row Colurmn

Attribute
Product/Classification/Asset
Heading

Type -

Mumber

I QK H Cancel

Select Row or Column to specify whether the transformation applies to a row or a column.

Select Attributes to apply the transformation to the column that contains the specified attribute.Click the
ellipsis button (...) to search or browse for the relevant attribute.

Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

Select Heading to identify a column or row by typing the header text of the relevant column or row.
Select Type to identify the column or row by selecting Column Type or Row Type.

Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then simply type 2.

Click OK.

7. Check Ascending if you want sort the rows in ascending order.

8. Select Alphabetic, Numeric, or Fraction to specify the sorting type.
9. Click OK.

Table Formatting Transformations
Formatting transformations enable you to apply a transformation to attribute values and to rows, tabs and cells.

Ao Dd -

In the Tree, click the relevant product, and then click the Tables tab.
Select a table, and then click the Preview tab.
Click Add Transformation.

Select the relevant transformation, and then click OK.

The following transformations are available:
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« Attribute Formatting Transformations below
« Row/Column Text Formatting on page 163
« Tab Formatting on page 164
» Cell Formatting on page 165

Attribute Formatting Transformations

These transformations perform a task on an attribute such as calculating or replacing a value or applying a prefix
or a suffix.

1. Under Parameters, click the ellipsis button (...). The Attribute Formatting dialog appears.

F5] Attribute Formatting  ——. -
Browse m Legal Attributes

& Advanced @

| Mame »|

Attribute Formatting

Add Trans fermation

[ oK ” Cancel

e

2. Search or browse for the attribute you want to apply a transformation to.

3. Click Add Transformation. The Select Transformation dialog appears.

4. Selectthe relevant transformation, and then click OK.
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r N
E] Select Transformation ﬁ

Append text

Change case

Choose hash function

Convert fractions to parsable tags

Extract characters after a given text in the value
Extract characters at position

Extract characters before a given text in the value
Extract characters between two pieces of text in the value -

[ m | »

[ oK ][ Cancel

List of text transformations

Transformations Description

B
Append text % append [yy

Adds the specified text as a suffix to the end of the value. For an example using this
transformation, see Concatenate Data Using Variables Example.

Change case ]
% Change to |Lower W | CAse

Sets values to all upper case, all lower case, or mixed case. Mixed case sets the first
letter of the value to upper case and the remainder to lower case. For an example using
this transformation, see Split, Extract, and Convert Data Example.

Convert fractions to

*
'+ Convert fractions to parsable tags using mode | Mormal
parsable tags ) he

Scans a text string for fractions. If a fraction is found, then the fraction is converted into
parsable tags.

A text string that contains the fraction 1/2 cm is transformed to:
<StartNumerator/><bfldin/>1<FractionBar/><StartDenominator/>2<EndFraction/>cm

You have to set up an output formatting to Indesign for <StartNumerator/>, <bfldin/>,
<FractionBar/>, <StartDenominator/> and <EndFraction/> to mount the fractions.

Extract characters

=)
. . [+ Extract characters after | end
after a given text in [+]
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Transformations Description

the value Extracts a part of the value, starting after the occurrence of the specified text string.
Extract characters ] _ o
.Y '+ Starting from position |1 extract |3 characters

at position [+l
Extracts a specified number of characters after a specified position in a text string. For
an example using this transformation, see Split, Extract, and Convert Data
Example.

Extract Ch.araCters % Extract characters before |end

before a given text [+

in the value
Extracts a part of the value, starting from the beginning of the text string and ending at
the occurrence of the specified text string. For an example using this transformation,
see Split, Extract, and Convert Data Example.

Extract characters

=]
% Extract characters between ab and |cd

between two pieces
of text in the value

Extracts the texts between the specified starting text string and the specified ending text
string. The start and end text string cannot be the same.

Extract the last N
characters of the
value

=]
% Extract the last |2 characters

Extracts a specified number of characters of a value, counting from the end. For an
example using this transformation, see Split, Extract, and Convert Data Example.

Format number ]
% Format number according to format | #.00 | Localize False

Formats the number to only have a specified number of decimals, and enables you to
localize the number.

Format the number

=)
. . '+] Format number according to format |#.00 | Localize False
with unit |

Formats the number with a unit to only have a specified number of decimals, and
enables you to localize the number.
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Transformations Description

Inserttextatagiven | [ y
i ] Insert |abc at position |1
position [+
Inserts a series of characters into the attribute value at the specified position.
Insert text before ]

% Insert | wx before

Adds the specified text as a prefix before the value.

Math operation % Value = Value |+ ]
(+,=%1) El -
Performs the standard math operations on the value: addition, subtraction,
multiplication, and division. Only valid for integer and number attributes.
Replace substrings | [ _ _
7] .
of the value H Replace sub-strings | x with |y
Changes the specified text string or empty value with the replacement text string or
empty value. All matches on the value in the 'Replace sub-strings' text box are replaced.
For example, all instances of 'Personal Computer' could be replaced with 'PC".
Replace substrings

]
%F‘.Eplace it matches - ||x™ with

of the value using a
regular expression

Uses regular expression to change the specified find value (in the first text box) with the
replacement value (in the second text box). From the dropdown, select a replace
option: 'if matches', 'first match of', or 'every match'. The if matches option must be set
so that the find field defines the entire string to be replaced because it operates like the
'Replace the whole value' transformation. The first match of and every match
options operate like the 'Replace substrings of the value' transformation and they
replace only the text specified in the find field. For more information on regular
expression and practical examples, see the Regular Expression topic in System
Setup / Super User Guide documentation.

Replace the whole
value

]
%F‘.Eplace X with |y

Replaces the specified text or empty value with a different value. You must enter the
entire value, or leave the Replace field blank. Only works on text-based attributes. For
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Transformations Description

an example using this transformation, see Split, Extract, and Convert Data
Example.

i =
Spllt and extract % Split by |x and extract field |1 "

Split the value where a given string is found and returns one of the created fields. You
can, for example extract data from a value after the 4th occurrence of a hyphen, and
before the 5th occurrence. So if the value is 179-245-Y-MYGR-TG105P-FDSJ-198, the
resultis TG105P. For an example using this transformation, see Split and Extract
Data Example.

Row/Column Text Formatting

The Row/Column Text Formatting transformation enables you to transform data in specific columns or rows.
You can calculate or replace values or apply prefixes and suffixes to values in entire columns and rows in one
operation.

1. Under Parameters, click the ellipsis button (...). The Row/Column Text Formatting dialog appears.

F ™
F+] Row/Column Text Formatting ﬁ

Ignore Headings

Row,/Column Text Formatting

Add Trans formation

[ oK H Cancel

2. Select Ignore Headings if you want the transformation to ignore contents in header column types.

3. Click the ellipsis button (...). The Select Row/Column dialog opens.

« Select Row or Column to specify whether the transformation applies to a row or a column.

« Select Attributes to apply the transformation to the column that contains the specified attribute. Click the
ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

« Select Heading to identify a column or row by typing the header text of the relevant column or row.
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« Select Type to identify the column or row by selecting Column Type or Row Type.
« Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then simply type 2.
4. Click Add Transformation. The Select Transformation dialog appears.

The transformations that are available are the same as described in Attribute Formatting Transformations on
page 159.

il |
E] Select Transformation I&
Append text -
Change case =

Choose hash function

Convert fractions to parsable tags

Extract characters after a given text in the value

Extract characters at position

Extract characters before a given text in the value

Extract characters between two pieces of text in the value -

[ oK ][ Cancel ]

5. Select the relevant transformation, and then click OK.

Tab Formatting
The Tab Formatting transformation inserts a tabulator in a row or column.

1. Under Parameters, click the ellipsis button (...). The Tab Formatting dialog appears.

FE] Tab Formatting ﬁ1

| )

[ OK H Cancel ]

L

2. Select Ignore Headings if you want the transformation to ignore contents in header column types or header
row types.

3. Click the ellipsis button (...). The Select Row/Column dialog opens.
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[ E] Select Row/Column &1

@ Rowé () Columnn

() Attribute

) &)

(7 Product/ClassificationfAsset
(7 Heading
i) Type b

() Number

[ OK H Cancel

« Select Row or Column to specify whether the transformation applies to a row or a column.

« Select Attributes to apply the transformation to the column that contains the specified attribute. Click the
ellipsis button (...) to search or browse for the relevant attribute.

« Select Product/Classification/Asset to apply the transformation to the column that contains the specified
object. Click the ellipsis button (...) to search or browse for the relevant object.

« Select Heading to identify a column or row by typing the header text of the relevant column or row.
» Select Type to identify the column or row by selecting Column Type or Row Type.

« Select Number to identify the column or row by entering the sequence number of the relevant column or
row. For example, if you want to apply the transformation the second column, then simply type 2.

4. Click OK.

Cell Formatting
Allows you to format cells in a table.

1. Under Parameters, click the ellipsis button (...). The Cell Formatting dialog appears.
FE] Cell Formatting ﬁ1

Search Expression |

Only for rowsfcolumns 7] |

Color to apply :Dn not change background color
Style to apply :Dn not change text style -
[ QK ] [ Cancel
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2. In Search Expression enter a regular expression to find specific cells.

3. Select for rows/columns if you want the formatting to apply only for cells in specific rows or columns. Click the
ellipsis button (...) to search or browse for the relevant rows or columns.

4. Inthe Color to apply list, select the color you want to apply to the cells.
5. Inthe Style to apply list, select the style that you want to apply to the cells, and then click OK.

Footnote Transformations

The Footnote transformation enables you to control how footnotes are displayed in a table.

If no footnote tag exists, you must create one in System Setup. For more information, see the Tags section of the
System Setup / Super User Guide documentation.

Before you can add the footnote transformation, you first have to add footnote text to an attribute value.

To add Footnote Texts to an Attribute Value

1. Inthe Tree, expand the product hierarchy, select the relevant product, and then click the Product tab.
2. Click the attribute value that you want to add a footnote to.

3. Right click the attribute value, and then select Insert Footnote. The Insert Footnote dialog appears.

[ E] Insert Footnote [ﬁr

Spell Chen:k| Style v| Character Tag v“ B FI |ﬁ.

Footnote type |asdasdl P

Footnote

| oK || Cancel

4. Selectthe desired Footnote type.

5. Enter the footnote text as either free text or as a character tag, and then click OK.

Note: If the same free text footnote is used for different products in same table, the footnote signs are the same
for all footnotes. If the text does not match a 100% , then different footnote signs are displayed.

If the same long text is used many times throughout a catalog, you can create the footnote text as a character tag
that you can insert in all the places where you want to use the text.
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Adding a Table Footnote Transformation to a Table Type

1.

o > 0N

In the Tree, click the relevant product, and then click the Tables tab.

Click a table type, and then click the Preview tab.

Click Add Transformation. The Select Transformation dialog appears.
Expand Transformations, select Footnote Transformation, and then click OK.

Under Parameters, click the ellipsis button (...). The Footnote Transformation dialog appears.
E] Footnote Transformaticn [ﬁj

Footnote Tag 17312312333333333 e
Footote Row Type

-

Start below column =

Footnote Separator

Footnote Marker

| Style Settings

| Ok || Cancel

L

In the dialog, specify the following:

« Footnote Tag: Select the relevant footnote type from the list. This is the footnote type you used when you
added the footnote text to the attribute value.

« Footnote Row Type: Select the relevant footnote row type from the list.

Important: The selected row type must only be used for footnotes.

« Start below column: Specify the column that you want to place the footnote below. It is typically column 1,
and then it spans all columns.

« Footnote separator: Specify the separator to be used in between the different footnote texts when different
footnote texts with the same footnote tag are found in same table.

« Footnote Marker: Specify how to mark the footnotes the table, for example, 1,2, 3, 4, 5. When all footnote
markers have been used in same table, then it start over from the beginning again.

Click the Style Settings button to specify text styles, background color, alignment, borders and so on, and
then click OK.

Footnotes Based on Calculated Attribute Values

You can use footnotes based on calculated attribute values to handle new symbols in front of order numbers and
generate footnote text below the tables that contain the new symbols.

1.
2.

Create a calculated attribute.

Add the value template for the calculation as shown in the following example.
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if (exack(PRODVAL ("Brand Mame"), 'Pilot pens"), 'Pilot
pens <ReqgistrationFoot = <FootnoteR eqgistration) = < [ReqistrationFook =,
(PRODYAL ("Brand Mame")))

In this example the calculation does the following:

If the brand name is Pilot pens, then the attribute value is "Pilot pens” with a footnote sign. The footnote sign is
defined as: <RegistrationFoot><FootnoteRegistration/></RegistrationFoot> where the tags are:

<RegistrationFoot> and </RegistrationFoot>: The footnote tag types. There is a start and an end tag.

<FootnoteRegistration/>: The character tag that defines the output of the footnote text.

3. Make the calculated attribute valid for the part of the product hierarchy where you want the calculated attribute
to result in table footnotes.

For more information about calculated values, see the Calculated Attributes section of the System Setup /
Super User Guide documentation.

Pivot Table Transformations

Pivot tables (sometimes referred to as Compact or Compacted Tables), are useful in print applications to display
product data in a compact manner. They allow more products and product data to be presented in a smaller
physical area than a non-compacted table. Not only does this type of table require less space on a printed page, it
also enables the reader to compare similar products. Although it is not always the case, pivot tables usually show
more than one product in a single row. In addition to the table's compactness, another purpose of this type of
presentation is to allow the reader to see both the common attribute values of similar products as well as their
differences.

Pivot tables in STEP are created using the Pivot Transformation. You can apply pivot transformations to any table.
However, this transformation does require a high degree of data accuracy and consistency. The following
approach is recommended when working with this transformation.

« Create a pivot table type in System Setup if it does not already exist. For more information, see Creating
Table Types in System SetupCreating Table Types on page 21

« Create atable on a productin the Tree based on the pivot table type.
« Apply a Pivot Transformation to the table, experimenting with different setups.

This initial approach to learning about pivot transformations should help in understanding the functionality of the
transformation. It is very likely that you will need to create new row types and/or column types during your initial
experiments, so creating these new row/column types on this new table type will be easier to implement, as
opposed to modifying an existing table type. After learning the features and capabilities of the transformation, then
you may decide to modify your existing table types accordingly.
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Areas of a Pivot Table — Introducing the Table Guide

The following figure shows a pivot table that has been specifically created to show how a pivoted table is built. The
different areas of the pivot table are identified by the use of background colors. There are seven areas. This table
is the same as that which is displayed in the Pivot Transformation Wizard, and is called the Table Guide. As you
progress through each step of the Pivot Transformation Wizard the Table Guide will help you visually by
highlighting the area that will be affected by the options you select.

Acme Drill Co. PSV Co.

Titanium Carbide Tipped

The Table Guide, as used in the Pivot Table Wizard

One of the purposes for presenting information in this manner is to allow the reader to easily compare similar
products, viewing both their common specification values and their differences. For example, a reader looking at
the first part number in the table (8J5H1), can see that there are some similar products, (8J5F4 and 8J6S4). They
have the same specifications for Diameter, Length, # Flutes, Angle, and Grade, but have different specifications
for the Material and the Brand Name. Since there are differences between these three products, the Price will
usually reflect that by also having a different value.

The different background colors identify seven areas. Each of these areas has a separate setup screen in the
Pivot Transformation Wizard. The name and purpose of each of these different areas are defined as follows, in the
order that they are presented in the Wizard:

Diameter Length # Flutes
15 12 mm
2.0 16 mm 2
2.5 20 mirmn
3.0 24 mm 9
3.5 28 mim 5
4.0 30 mim

The yellow cells denote the Left Common Values area. You may define the attributes that are common to all the
products in the same row. The attributes will be located on the left side of the table. There is a similar capability to
define attributes that should be placed on the right side of the table (in the brown area). If within the Pivot
Transformation no attributes are defined in either of these areas (yellow or brown), then table compaction cannot
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be accomplished. That is, there must be at least one attribute declared as being a 'common value' attribute for the
transformation to function. In the Table Guide, the attributes used in this area are: Diameter, Length, and Number
of Flutes (# Flutes).

Acme Drill Co. PSV Co.
HSS | Titanium Carbide Tipped

The light blue cells denote the Top Pivotal Values area. In the Wizard you can identify the attributes that you wish
to be 'promoted' into one or more header rows and these header rows will be created and placed at the top of the
table. There is a similar ability to define one or more attributes to be located in an automatically generated row (or
rows) at the bottom of the table, (the dark pink area). For any Pivot Transformation to work, there must be at least
one attribute declared as either a Top or Bottom Pivotal Value. In the Table Guide, the 'promoted' attributes in this
top area are: Brand and Material.

SKU Price SKU Price SKU Price
8J5H1 13.99 8J5F4 13.99 8l6s4 14.99
815H2 16.99 BIS5F5 16.99 81655 17.99
8I5H3 18.99 BI5FG 18.99 81656 19.99
8J5H4 22.99 BISFT 22.99 81657 23.99
8I5H5 23.99 8J5F8 23.99 8]658 24.99
8I5HG 31.99 8J5F9 31.99 81659 32.99

The greencells denote the Compacted Values area. In the transformation you can state which attributes should
be placed in this area and these attributes will be rearranged so that products with the same common values will
be placed on the same row, and that they will be placed in the appropriate column corresponding to the promoted
attributes in the header rows. In the Table Guide the attributes that will be used are the SKU and the Price.

Brand
Material
| Diameter | Length | #Futes | SKU | Price | SKU | Price | SKU | Price | Angle | Grade |

The dark blue cells denote the Column Heading area. In the Table Definition tab a standard setup will have one
header row that holds all the column headings for the attributes that are called out in each column. In the Pivot
Transformation you can declare certain attributes to use for the table compaction (the 'promoted' attributes), and
the system will generate the appropriate number of header rows at the top and/or bottom of the table. In our
example, the attributes Brand and Material were the promoted attributes (and Box Type was promoted to the
Bottom Pivotal Values area, not shown). Since the cells with the attribute names in the generated top and bottom
header rows originated from the first row in the table definition (the column headings row), they are still considered
as 'column headings', thus the reason for showing them in their dark blue color. It is easy to suppress these
attribute names from appearing.
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Angle Grade
c7
a2e
Ca
ag=
(95

The brown cells denote the Right Common Values area. This is an identical setup to that of the Left Common
Values area. In any Pivot Transformation there must be a minimum of one attribute defined in either the Left
Common Values or the Right Column Values. If no attributes are defined in either of these areas, (yellow or
brown), table compaction cannot be accomplished. In the Table Guide, the attributes used in this area are: Angle
and Grade.

Wooden Case

Pop-Open Plastic

The dark pinkcells denote the Bottom Pivotal Values area. This is similar to the Top Pivotal values area, with the
exception that the system will generate an appropriate number of header rows at the bottom of the table
depending on the attributes selected. For any Pivot Transformation to work, there must be at least one attribute
declared as either a Top or Bottom Pivotal Value. In the Table Guide, the attribute in this bottom area is: Box Type.

The red cells denote the table's Corners area. These areas are really independent of one another and may be
used for a variety of purposes. You may enter free text into any of these areas, or you may access attribute values
or image references from the original defined table. In the Table Guide, the information in the top left, top right, and
bottom right corners are all free text. In the bottom left corner an attribute has been called out to display the
'Quantity per Package type' attribute.

Preparing Tables for Pivot Transformation

The contents of table cells may be free text, product attribute values, product Names or IDs, meta-data, product
references, or asset references. In order to simplify this documentation only product attributes and free text are
used for the cell contents. But the other cell content types are equally valid and may be used in the Pivot
Transformation.

Itis recommended that the tables that are going to be involved with pivot transformations are all constructed in a
similar manner. That is, products in rows and attributes in columns are shown in the following general example
that matches that shown in the Table Guide.
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Pivot Table 1 312 >3 14 8 > 6 7 > 39 > |10 (11 12 )
Redgold ‘Sold Spec Column  Spec Column  Spec Column  Spec Column  Spec Column Spec Column  Spec Column  Spec Column Spec Column Spec Column
fsko [|ferice []f Dameter |fLength [If #Fiutes [|f BoxType Jf6rand  []§ Materia |[f EndType [|f Ange ] Grade |§ QuantityPerPack

1 »Column Head... ﬁ Mame SKU Price Diameter  Length # Flutes fBoxType  Brand Material EndType  lAngle Grade QuantityPerPack

2 »BpecRow (g Loca

In the example shown, there is only one header row used for the Attribute Names. It is of no use to set up a Table
Definition with more than one header row, since it will conflict with the Pivot Transformation. The transformation
will create additional header rows according to the setup within the transformation. It will only accept one header
row in the original Table Definition.

In the above example, the elements are organized in the following way. The first two columns will be used in the
Compacted Values area, the next three columns will be used for the Left Common Values, columns 6, 7, and 8 will
be used to generate header rows at the top and bottom of the table, and columns 10 and 11 will be used for the
Right Common Values. Column 9 is included in the table definition (attribute = End Type), but if an attribute is not
'mentioned' in the Pivot Transformation then it will be ignored (filtered out) and will not appear anywhere in the
resultant transformed table. Thus column 9 is included only to demonstrate that it is not present in the transformed
table, regardless of whether or not there are attribute values in that column. As far as the Table Guide is
concerned, column 9 is redundant. And as far as the Pivot Transformation is concerned, it does not exist. The
attribute in column 12 will be used in the bottom left corner of the pivoted table.

Notes:

The product attributes are all called out individually in this table definition, and the content definition of 'Attribute
Groups Attributes' has not been used. That option may be used if it is desired that the table is more 'dynamic', and
to reduce the number of localized tables. However, the Pivot Transformation does require that you state exactly
which attributes are to be used in the different areas of the table, either by attribute, Column Number, or Column
Type. So if you do use the 'Attribute Group Attributes' method you must know beforehand which attributes in that
group you wish to include within the transformation. Empty attribute columns can be easily discarded either within
the Pivot Transformation or via the standard transformation that removes empty columns and rows.

The above setup does make use of the content definition 'SubProducts, Family', so that the number of rows that
initially make up the table is dynamically sized according to the number of child products in the product family. If a
successful table compaction is done, there will be fewer rows after the pivot transformation.

If you wish you may create different column types for the different 'areas' in which the attributes will be used. But
you should be aware that no matter what you set up in the table definition tab you will still need to declare the
different row and column types within the transformation, since during the transformation all the original row and
column types are basically 'discarded'. So for the Table Definition, whether or not you organize your tables with
different column types is a matter of personal choice. However, there is one major advantage to assigning the
column types to match their intended 'area’ in the pivoted table, and that will also be explained later in the Working
with the Pivot Transformation Wizard.
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Pivot Transformation Step 1 Left Common Values

Steps 1.5 mm 12 mm 5
< 2.0 mm 16 mm
1. Left Common Values TP T
2. Top Pivatal Values 3
3.0 mm 24 mm
3. Compacted Values
4, Column Headings 3.5 mm 28 mm -
5. Right Common Values 4.0 mm 30 mm

¢ Botom Potal Vakes __Quantity = 100/Box _Box Type|

In the Table Guide, the Left Common Values will be the attributes for Diameter, Length, and # Flutes.

Reminder: The contents of table cells may be free text, product attribute values, product Names or IDs, meta-
data, product references, or asset references. But for purposes of simplicity in this document the terms "attribute”
and "attributes values" are used when referring to a cell's content.

() None

(® Column Selector | IZI

Farmat |

In this step you choose the attributes whose values are common to all the products in the same row and that will be
positioned on the left hand side of the table. You have the following options:

« Select None if you do not want any attributes in this area. If you choose this option, you will need to define at
least one attribute in the Right Common Values area. Otherwise the transformation cannot be
accomplished.

« If you wish to choose one or more attributes to be placed on the left side of the table, select the button with
the ellipsis symbol (the three dots) to open up the window where you will choose those attributes. When you
hit the ellipsis button the Column Selector radio button will automatically set. You will be presented with the
following screen:
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8 sSelect Column

() Attribute

(") Product/Classification/Asset

(1 Heading

™ Type LCompact Part Column

() Mumber

() Group

The options in this dialog box should be familiar, they are used for identifying columns or rows of attributes in
several other table transformations. If you know that you will be defining more than one attribute in the Left
Common Values area then you should immediately select Group and continue with the options that are brought
up. If you know that you will only be defining one single attribute in the Left Common Values area, then you may
make your selection in the usual manner from the options provided.

(7) Attribute
() Product/ClassificationfAsset ct Row/Columns to be grouped
(") Heading

() Type Compact Part Column

| OK || Cancel

() Mumber

(%) Group Setup |

| Ok || Cancel |

Selecting the Group option will cause a new window to launch ('Select Row/Columns to be Grouped'). Here you
may define as many attributes as you wish.
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32 Select Row/Columns to be grouped

Undefined

O Attribute

() Product/Classification/Asset
(") Heading

(O Type

() Mumber

(%) Group |

| Ok || Cancel |

Each time that you select the 'Add' button (top picture) you will be presented with the options for identifying the
attribute that you wish to appear on the left side of the table, (bottom picture). Note that the attributes will display in
the pivoted table in the same order they appear in this setup. So the order in which the columns appear in the
Table Definition is irrelevant. It is at this Wizard Step that you select order of the columns to be displayed.

$2 Select Row/Columns to be grouped

Colurmn Diameter |Z|
Colurmn Length E

Colurmn # Flutes

| oK || Cancel |

The selection of attributes that matches the Table Guide.

When you are finished with your selections, then hit OK to return to the main Wizard screen. Your selections will
appear in the Column Selector line, similar to the following:
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(") Mone

(®) Column Selector piameter:Lengﬂﬁ:# Flutes;

Format |

The Format Button — Left Common Values

The Format Button is available in seven of the Wizard screens. The options within the Format window are very
similar.

After making your selections as to which attributes will be placed on the left side of the table you need to define
how the attribute values in the newly formed columns should be displayed. If you click the Format button, you can
control the assignation of all the required Column Types in this area.

£ Format

[]
Text Style Mot Defined = Column types to apply

L]
Background Color | Not Defined = Every Column iH Compact Specifications; w

Vertical Alignment | Center Mone

Rule Above Mot Defined Mane

Rule Below Mot Defined None

= [ = =
3 3 =] 3
= = E =
%] %] 7] %]
m 1] m m
(=8 [= 8 (=9 (=8

Rule Left Mot Defined Mone

Rule Right Mot Defined
Cell Rotation Mot Defined
Process Flag Mot Defined
Cell Story Direction | Mot Defined

Cell Image Scale

The options and selections in this window are the same as those for the Right Common Values.

Note that although the selections in the Format window for the Left Common Values and Right Common Values
windows are exactly the same they are completely separate. So when you are in the Left Common Values area
you will only be establishing setups for that area and not for the Right Common Values area.

The window is divided into two distinct areas, indicated by the vertical dashed line in the above picture. Over on the
right hand side of the Format window you may apply column types to the attributes that you just selected.
However, no matter what setups are defined within those Column Types that you have specified, the settings in
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the area over on the left hand side of the Format window will override those settings. You can therefore consider
the settings on the left side to be 'global overrides'. For more information see the section on Priority of Formatting
Setups.

For example, in the above screenshot, if there is a Background Color of 'Mango' defined in the Column Type = LH
Compact Specification, it will only take effect if there is no Background Color specified on the left.

Summary: Any setting that is not defined in the 'global overrides' area will allow the setting from the Column Type
(specified on the right side) to take effect. However, there are some additional conditions that will influence this,
see the section on Priority of Formatting Setups.

Applying Column Types

Column types to apply

Every Calurmn v | |1H Compact Spedfications;
Unused w | |Mome W
Unused v | |Mone W
Unused v | |Mone W
Unused v | |Mone W

Up to five 'rules' may be applied when assigning column types. Each rule has the same selection of options.

There are different ways of assigning Column Types since the number of attributes selected in the Left Common
Values area may vary from table to table. You have up to five sets of options or "rules" that you can apply to the
assignation of the Column Types:

Column types to apply

Every Column W

Second Column =
ird Column

Fourth Column

Fifth Column

Every First of two Columns w

The available selections within each rule.

o Unused: No Column Type is defined.

» First Column: The specified Column Type will be assigned to the first column in the Left Common Values
area.

« Second Column: The specified Column Type will be assigned to the second column in the Left Common
Values area.
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Third Column: The specified Column Type will be assigned to the third column in the Left Common Values
area.

Fourth Column: The specified Column Type will be assigned to the fourth column in the Left Common
Values area.

Fifth Column: The specified Column Type will be assigned to the fifth column in the Left Common Values
area.

Every Column: Every column in the Left Common Values area will be assigned the specified Column Type.

Every First of Two Columns: Starting at the first column in the Left Common Values area, every alternate
column will be assigned the specified Column Type.

Every Second of Two Columns: Starting at the second column in the Left Common Values area, every
alternate column will be assigned the specified Column Type.

Every First of Three Columns: Starting at the first column in the Left Common Values area, every third
column will be assigned the specified Column Type.

Every Second of Three Columns: Starting at the second column in the Left Common Values area, every
third column will be assigned the specified Column Type.

Every Third of Three Columns: Starting at the third column in the Left Common Values area, every third
column will be assigned the specified Column Type.

Remaining Columns: All columns in the Left Common Values area following the ones affected by the
previous rules will be assigned the specified Column Type. For example, if rules have been applied to the
first three columns, then from column 4 onwards the specified Column Type will be assigned.

Last Column: The last column in the Left Common Values area will be assigned the specified Column

Type.

When column types are applied, the rules are applied in the order they are listed, thus a later rule overrides an
earlier rule. For example, if the first rule is 'Every Column' and the second rule is 'Third Column', then all columns
will be assigned the Column Type defined in the first rule, except the third column, which will be assigned the
Column Type defined in the second rule.

Note that as a result of these different options it is possible to achieve the same result in different ways. For

example, review the setups in the following picture — they accomplish the same thing:

Column types to apply Column types to apply

First Calumn Compact Spedfication W Every Columnn v | | Compact Specification Right

Remaining Columns Compact Specification Rightt First Column v | |Compact Specfication o

Unused MNone W Unused w | |Mone W

Unused Mone W Unused w | |Mone W

Unused Mone W Unused w | |Mone W
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Pivot Transformation Step 2 Top Pivotal Values

In this Step you choose the attributes that you want the system to promote into the table headers, creating as
many header rows as required. The procedure is very similar to Step 1 with the exception being the formatting
options, where instead of Column Types you define the Row Types for the attributes that have been promoted into
row headers.

Steps
: L:"ﬁ ':‘”“”“’”I :a'i s Acme Drill Co. PSV Co.
°or : HSS Titanium | Carbide Tipped

3. Compacted Values

4, Column Headings

5. Right Comman Values
&. Bottom Pivotal Values

7. Corners
8. Sorting
9. Settings

In the Table Guide, the Top Pivotal Values will be the attributes for Brand and Material.

=
Colurmn Material IZI

| (0]4 || Cancel |

The method of selecting the attributes is identical to that in Step 1. The above selection of the attributes Brand and
Material correspond to the attributes shown in the Table Guide.

The Format Button

In Step 1 the functionality of the Format button was described in detail. You may refer back to that section for
further information. The only difference between the Format window presented here and that in Step 1 is that you
will select the Row Types for the attributes that you chose to be promoted into header rows. And the options in the
'Row Types to apply' will reflect row numbers, not column numbers. See the following image for reference.

© Stibo Systems - Confidential - STEP Trailblazer 8.2 179



StiboSystems

$# Format
Text Style Not Defined Row types to apply Row types to apply
i ! | First Row
Backaround Color | Not Defined v First Row Compact Header Row 1 w W
. : Unused A
Vertical Algnment | Not Defined v Second Row Compact Header Row 2w
Unused Mone Second Row E
Rule Above Mot Defined Third Row
Rule Below Mot Defined v Unused None Fourth Row
Unused N Fifth Row
Rule Left Not Defined w use one Every Row
E First of two Fow A
Rule Right Mot Defined VEry TSt Of hwo Rows

Cell Rotation Mot Defined

Process Flag Mot Defined

Cell Story Direction | Mot Defined

Cell Image Scale

In the Table Guide example two different Row Types have been applied, corresponding to the two attributes
Brand and Material that were selected to be promoted into row headers. This would allow for different fonts, point
sizes, background colors, etc. to be applied to the attribute values in the header rows. If the two new header rows
will have thew exact same specifications, there is no real benefit in assigning two different row types. Note that the
row types that you specify here may or may not be the same as that of the first row in the Table Definition, they
could be completely different row types.

oeintion [V
Pivot Table 1 |2 s |3 »
Compact PartMo Compact Price LH Compact Spedifica. ..
Di SEL DI Price DI Diameter
1 » Column Head... ] Name Sk Price Diameter
2 » Bpec Fow (Cg Local

A reminder that in our sample table, the row type used for the column headers is 'Column Header Row'. This may
or may not be the same row type that is desired for the additional header rows that are created by promoting
attributes into those new rows.

If the format specifications will be the same for all header rows, it is perfectly acceptable to apply the row type that
is used in the Table Definition (in this case, 'Column Header Row') to all rows in the Top Pivotal Values, thus:
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Row types to apply

First Row w | | Column Header Row W
Unused w | [ Mone Y
Unused w | |Mone W
Unused w | |Mone W
Unused w | |Mone W

Note that you could also apply setups in the 'global override' area of the Format window. But that does not mean
that you can leave the right side 'blank’, since as a minimum you do need to tell the system that the rows are
header rows and not normal rows. If the table is mounted to a page and the system needs to split the table, then it
needs to know what the header rows are so that the appropriate row(s) can be carried over to the next column or
page. So as a minimum you need to fill in at least one entry for the Row Types, and that Row Type should have its
Header / Footer option set to set to Heading (1). That would be the standard setup.

Note that the options for the Bottom Pivotal Values in step 6 of the Wizard is identical to this one.

Pivot Transformation Step 3 Compacted Values

Steps

1. Left Common Values
2. Top Pivotal Values
3. Compacted Values % o
4. Column Headings

5. Right Common Yalues

8J5H1 | 13.99 | 8J5F4 | 1499 | 8J654 | 16.99

8J5H2 | 16.99 | 8I5F5 | 17.99 | 8655 | 18.99
8J5H3 | 18.99 | 8J5F6 | 20.99 | 8l656 | 21.99
8J5H4 | 22.99 | 8I5F7 | 22.99 | 8J657 | 22.99

&. Bottom Pivotal Values 8J5H5 | 23.99 | 8J5F8 | 27.99 | BJ6S8 | 24.99
7. Corners 8I5H6 | 25.99 | 8J5F9 | 31.99 | 8J659 | 25.99
8. Sorting
9. Setlings

In Step 3, you choose which attributes you want to go into the compacted area. You must select at least one
attribute. The method of selecting the attributes is the same as in the prior steps.
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Compacted Values

(® Column Selector

| Format |

[ Horizontal Values

Value Row III () Collapsd

Colurmn |

Column |

8

() Attribute

3% Select Row/Columns to be grouped

In the Table Guide example the column types of PartNo and Price were selected.

The Format screen dialog is similar to that shown in Step 1 and 2, except here you can specify both Row and

Column Types.

Row types to apply

Text Style | Mot Defined

v | | Unused

W | |Nune

Background Colar |Nnt Defined

v | | Unused

w | |Nune

Vertical Alignment |Nut Defined

hd | | Unused

¥ | |I"~Ior1e

Rule Above |Nut Defined

hd | | Unused

[¥] | |Nune

Fule Below |I"~Iut Defined

v | | Unused

W | |Nune

Rule Left |Nnt Defined

W | Column types to apply

Rule Right |Nut Defined

I | |E'uery First of two Columns

W | |Cum|:|-act Part Column

Cell Rotation | Mot Defined

W | |E':.-'var1,-I Second of two Columns

W | |Cum|:|act Price Column

Process Flag |I"~Iut Defined

W | | Unused

w | |Nune

Cell Story Direction |Nnt Defined

W | | Unused

¥ | |I"~Ior1e

Cell Image Scale |

| | Unused

[¥] | |Nune
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In the above setup each group of compact values will alternatively be assigned the Column Types of Compact Part
Column and Compact Price Column. This matches the settings for the Table Guide, where the column types of
Part No and Price were defined.

Also, in this step, you determine whether the compacted values will display within that area in a left-to-right
manner (as shown in the Table Guide, Price columns next to the SKU columns) or whether the display will show in
a top-to-bottom manner (SKU numbers displayed in one row, prices displayed on the next row). And it is here
where you can request the system to further compact this area if, say, all the prices in the first price column are the
same as the prices in the second price column. For example, in the Table Guide you can see that all the prices for
the HSS and Titanium products are the same, so further compaction is possible. This is accomplished by the
Horizontal Values setting and its attendant options.

Steps Compacted Values

1. Left Common Values
2. Top Pivotal Values

3. Compacted Values
4, Column Headings
5. Right Common Values Horizontal Values
6. Bottom Pivotal Values

(®) Column Selector tiHJ.I:Priu:e: D

Compacted Values Column |- | () Collapseleft () Collapse Right
7. Corners

8. Sorting

9. Settings Update Preview | (® Show Guide () Show Preview () Show Original

8I5H1 | 13.99 | BJ5H4 | 1499 | BleS4 | 16.99
8J5H2 | 16.99 | 8I5F5 | 17.99 | Bl6S5 | 18.99
8J5H3 | 18.99 | BJ5F6 | 20.99 | 8leSe | 21.99
8I5H4 | 22.89 | BI5F7 | 22.99 | BleS7 | 22.99
8I5H5 | 23.99 | BI5R8 | 27.99 | Bl6SE | 24.99
8J5HG | 25.99 | 8I5F9 | 31.99 | 8659 | 25.99

| Back H Mext H Finish H Cancel ‘

The Effect of the Horizontal Values Setting

This is best shown by pictures. The following picture shows the effect on the display of cell contents within the
Compacted Area as a result of selecting the Horizontal Values checkbox. Note that it matches the example of the
Table Guide:
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SKU Price SKU Price SKU Price
8J5H1 13.99 | 2J5F4 13.99 | 8J654 14.99
8J5H2 16.99 | 8J5F5 16.99 | 8J655 17.99
8J5H3 18.99 | 8J5F6 18.99 | 8J6SE6 19.99
8J5H4 22.99 | 8J5F7 2299 | 8J657 23.99
8J5H5 23.99 | 8J5F38 2399 | 8J658 24.99
8J5H6 31.99 | 8J5F9 3199 | 8J659 32.99

StiboSystems

The following picture shows the effect on the display of cell contents within the Compacted Area as a result of
deselecting the Horizontal Values checkbox:

SKU | 8J5H1 8J5F4 2J654
Price 11199 13.99 14.99
SKU | BJSHZ 8J5F5 28J655
Price |16.99 16.99 17.99
SKU | 8J5H3 8J5F6 8JESE
Price |18.99 18.99 19.99
SKU | 8J5H4 8J5F7 8J6S7
Price |22.99 22.99 23.99
SKU | 8J5HS 8J5F8 8J6S8
Price |23.99 23.99 24.99
SKU | 8J5HE 8J5F9 8J6S9
Price |31.99 31.99 32.99

Performing Further Consolidation within the Compacted Area

Consider the following:

SKU Price SKU Price SKU Price
8J5H1 13.99 | 8J5F4 13.99 | 8J654 14.99
8J5H2 16.99 | 8J5F5 16.99 | 8J655 17.99
8J5H3 18.99 | 8J5F6 18.99 | 8J656 19.99
8J5H4 22.99 | 8J5F7 2299 | 8J657 23.99
8J5H5 23.99 | 8J5Fs8 2399 | 8J658 24.99
8J5HG 31.99 | 8J5F9 31.99 | 8J659 32.99

Note that the prices are the same in the first two compacted price columns.

Now review the following setting:
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i® Column Selector

| Format

Horizontal Values

Compacted Values Column |2 w | () Collapse left  (® Edllapse Right

In the Column Selector, the column that held the prices was defined as the second column to compact. By using
the setting for the Compacted Values Column (set to 2, referring to the Compact Price column), the transformation
can then further consolidate the data, thus:

SKU SKU Price SKU Price
8J5H1 BJSF4 13.99 | 8JE54 14.99
8J5H2 8J5F5 16.99 | 8JESS 17.99
8J5H3 BJSFB 18.99 | BJESE 19.99
8J5H4 BJSF7 2299 | BJEST 23.99
8J5HS BJSF8 2399 | 8J658 24.99

I 8J5HE 8J5F9 31.99 | 8JES9 32.99

Note that in the setting, 'Collapse Right' was chosen. This indicates (in this case) that the column furthest to the
right after the compaction should be used. If in this example 'Collapse Left' had been chosen, the price column
would have been positioned between the column starting with part number 8J5H1 and the column starting with
part number 8J5F4, since that would be the 'left-most' of the compacted price columns.

Also note that if you have more than just two attributes in the Compacted Area, you can compact those additional
attribute values. As you enter a value for one Compacted Values Column the system will automatically add
another blank entry for you to make your additional selection. Example:

Compacted Values Column |2 w | () Collapse left (@) Collapse Righﬁ

Compacted Values Calumn |- | () Collapse left () Collapse Right

Note: Merging the column headings of 'SKU' into one cell may be done by a subsequent standard transformation.
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Pivot Transformation Step 4 Column Headings

3% Pivot Transformation

Steps

1, Left Common Values
2. Top Pivotal Values

8. Bottom Pivotal Values
7. Corners

8. Sorting
9, Sefings

In this step you choose which row in the Table Definition is the one to use for the Column Headings. As usual, you
can select that row by specifying the Attribute, Product/Classification/Asset, Heading, Row Type or Row Number.
It is expected that in the vast majority of cases the selection will be made either by Row Type or Row Number.

3% Select Row
() Attribute
() Product/Classification/Asset
() Heading
Column Header Row

() Mumber

() Group Setup |

| oK || Cancel |

Note that it is not at all common for there to be more than one Column Headings row set up in the Table Definition.
Usually, any multi-row table headers are made up of the original header row plus the new header rows that have
been generated as a result of promoting attributes into that area (in Step 2 above).

() Mone

(® Row Selector Fnlumn Header Row

The setup that matches that for the Table Guide.
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Pivot Transformation Step 5 Right Common Values

Pivot Tra nsfcrrmaﬁa

Steps

hngla Grade

. Left Common Walues
. Top Pivotal Values cT
. Compacted Values 827
. Column Headings
. Right Common Values g/ co
. Bottom Pivotal Values a0°
. Corners

. Sorting C5
. Settings

[2=2 == R = I I AL ]

In this step, you choose which attributes that you want to appear on the right hand side of the table, i.e. to the right
of the Compacted Values area. The setup method is essentially the same as that described in Step 1, which
defined the attributes to the left of the Compacted Values area. Refer to Step 1 for more details. Some screen
shots are included here showing the setup that corresponds to the Table Guide.

Since any Pivot Transformation requires at least one attribute to be defined either in the Left Common Values area
or in the Right Common Values area, then if None was selected in Step 1, you will be required to make an entry at
this point because the None radio button option will be disabled.

I:::I NDnE _

(® Column Selector P-I‘IQ|E:GFEI:|E: () Attribute |Z|
_ : () Product/Classification/A...
3 Select Row/Columns to be g... - e / IZ‘
(") Heading
comn [ roge |
) Type Bold »
coam [~ ate [
() Number
(®) Group Setup |

| Ok || Cancel |

| OK || Cancel |

The above picture shows the selection of attributes for the Right Common Values that match the Table Guide.
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¥ Format

Text Style Pot Defined Column types to apply

Background Color | Mot Defined Every Column RH Compact Specifcations
Vertical Alignment | Center Unused Mone

Rule Above Mot Defined Unused Mone

Rule Below Mot Defined Unused Mone

Rule Left Mot Defined Unused Mone

Rule Right Mot Defined

Cell Rotation Mot Defined

Process Flag Mot Defined

Cell Story Direction Mot Defined

Cell Image Scale

The above picture shows the Format screen with all columns being assigned the column type 'RH Compact
Specifications'.

Pivot Transformation Step 6 Bottom Pivotal Values

In Step 6, you choose which columns to use for the bottom header rows. The procedure is the same as in Step 2.
Any new rows generated as a result of promoting an attribute will be placed at the bottom of the table. Please refer
to Step 2 for details, some screen shots are included here to show the setup that corresponds to the Table Guide.

Pivot Transformaﬁa

Steps

1. Left Common Values
2. Top Pivotal Values

3. Compacted Values

4. Column Headings

5. Right Comman Values
6. Bottom Pivotal Values | Box Type | Pop-Open Plastic | Wooden Case |
7. Corners

8. Sorting

9, Seftings

In the Table Guide example, the attribute Box Type is used to create a bottom header row.
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(") Mone 32 Select Column

(®) Column Selector

Format i) Product/Classification/Asset

() Heading

() Type

() Mumber

() Group Setup |

| Ok || Cancel |

The above image shows the selection of the attribute Box Type. Since only one attribute will be promoted to the
Bottom Pivotal Values the group option was not necessary.

3 Format

Text Style #ot Defined Row types to apply
Background Color | Mot Defined Every Row Compact Bottom Row 1+

Vertical Alignment | Mot Defined Unused Mone

Rule Above Mot Defined Unused Mone

Fule Below Mot Defined Unused None
Fule Left Mot Defined Unused None
Rule Right Mot Defined
Cell Rotation Mot Defined
Process Flag Mot Defined
Cell Story Direction Mot Defined

Cell Image Scale

| oK || Cancel

The above shows the setup that matches that for the Table Guide example.

Pivot Transformation Step 7
In Step 7, you define the contents of the four corners of the pivot table.
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3 Pivot Transformation

Steps

1. Left Common Values
2. Top Pivotal Values

3. Compacted Values

4. Column Headings

5. Right Common Values
&. Bottom Pivotal Values
7. Corners

8. Sorting

9, Settings

The information specified in each of the four corners are independent of each other.

Corners

Top Left Corner

() Empty () Take from cell at Row Column

® Value | Ordering Information
Top Right Corner

() Empty () Take from cell at Row Column

® Value | More Sizes Available Online
Bottom Left Corner

() Empty  (® Take from cell at Row |2 Column |11

(") value | Mare Sizes Available Online
Bottom Right Corner

() Empty () Take from cell at Row Column

@) Value | 777 Call Us

The image above shows the setup that matches the Table Guide example. Note that in the example the top left,
top right, and bottom right corner cells will have free text values, and that the bottom left corner cell is set up to
reference a row/cell number in the original Table Definition, thus:
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Table Guide

12

Durnrmy

(1T QuantityPerPack

1
2

e

W

Geflmn Head. . (13 mame

Mormal Row

W

[Cg; Local

For each corner cell, you have the following options:

Click the Format button to define the formatting of the cell in each corner.

« Leave the cell empty.

StiboSystems

« Retrieve the contents of a specific cell in the original table by specifying the intersecting row and column
numbers. The row/column numbers refer to the original table before the Pivot Transformation, and the
contents of the cell in the Table Definition may be an attribute reference, asset reference or free text.

« Enter the value (including any STEP tags) as free text.

Text Style

Background Color
Vertical Alignment
Rule Above

Rule Below

Rule Left

Rule Right

Cell Rotation

Process Flag

Mot Defined
Cherry Red
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined
Mot Defined

Mot Defined

Cell Story Direction | Mot Defined

Cell Image Scale

| 0K || Cancel

The above picture reflects the setup for the top left corner cell of the Table Guide example.

The format of the cells in the corners does not have anything to do with any row or column type formatting. Thus
each of the four Format windows allows a different format style to be applied to the four corner cells.
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Pivot Transformation Step 8
In Step 8, click the Add Sorting Option button to define the sorting of the information in the Top or Bottom Pivotal
Values area and/or information in the Left or Right Common Values areas.

The sorting mechanism is similar to that of the Table Sorting Options, except that instead of specifying the sort
criteria by row / column type or attribute, instead you specify the column number in the Left or Right Common
values, or by row number for the columns that are in the Compacted Values area.

Example 1, sorting via the Left Common Values area:

Sorting

Comman Values Sorting

Left Side v 1w | [+]Ascending

| Add Sorting Option |

The above setup specifies that you wish to sort the 'body' rows of the table (i.e. the non-header rows) according to
the values in the second column in the Left Common Values Area, and in descending order. In the Table Guide
example the second column is the 'Length’. With this setup, if you have a table that matches the sample Table
Guide, it would look like this:

Brand ~ AcmeDrill Co. PSVCo. |
' Material HSS Titanium Carbide Tipped |

Diameter | Length | #Flutes | SKU | Price | SKU Price | SKU | Price | Angle | Grade
4.0 30 mm 2 BJ5HG 31.99 | 8J5F9 3199 | 8J659 32.99
35 28 mm BJSHS 2399 | 8J5F8 2399 | 8J6S8 24.99
3.0 24 mm P 8J5H4 22.99 | 8J5F7 2299 | 8J657 23.99
25 20 mm BJSH3 18.99 | 8JSF6 18.99 | 8J6S6 19.99
2.0 16 mm 2 8J5H2 16.99 | 8J5F5 16.99 | 8J655 17.99
15 12 mm 8JSH1 13.99 | 8J5F4 13.99 | 8J654 14.99

Note that the rows are now sorted according to the descending values of the Length.

Example 2, adding more sort criteria :

Sorting

Comman Values Sorting

Left Side w3 w | [#] Ascending

Left Side w2 [ Ascending

Add Sorting Option
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The above setup specifies that you wish to sort the 'body' rows, first according to the values in the third column in
the Left Common Values Area, then second according to the values in the second column. Both are sorted by
ascending values. The third column is '# Flutes', and the second column is the 'Length'. With this setup a table that
matches the Table Guide would look like this.

Brand Acme Drill Co. PSV Co.
| Material HSS Titanium Carbide Tipped |

Diameter | Length | #Flutes | SKU | Price | SKU Price | SKU | Price | Angle | Grade
15 12 mm 8J5H1 13.99 | 8J5F4 13.99 | 8J654 14.99
2.0 16 mm ) 8J5H2 16.99 | 8J5F5 16.99 | 8J6S5 17.99
3.5 28 mm 8J5HS 2399 | 8JSF8 2399 | 8J658 24.99
4.0 30 mm 8J5H6 31.99 | 8J5F9 31.99 | 8J6S9 32.99
25 20 mm 3 8J5H3 18.99 | 8J5F6 18.99 | 8J656 19.99
3.0 24 rom 8J5H4 2299 | 8JSF7 2299 | 8J6s7 23.99

You may also sort on the Right Side Common Values area, instead of selecting 'Left Side' in the drop down you
would select 'Right Side'. You may specify the desired sorting of the body rows by combining left side and right
side sorting options respectively

The Common Values Sorting setup in essence specifies the order in which the rows are displayed in the pivoted
table. If you wish to also specify the order that the columns are displayed in the Compacted Area then you set that
up using the 'Compacted Columns Sorting'. So if, for example, you wanted the columns that have the headings
'Acme Drill Co."and 'PSV Co.' to display in reverse alphabetical order, and if you then wanted the columns 'HSS'
and 'Titanium' to occur in reverse alphabetical order, then the setup would look like this:

[Sorting

Comman Values Sorting

Left Side w1 v | [] Ascending

Add Sorting Option

Compacted Columns Sorting

Top Pivotal Values w1 w | [] Ascending

Top Pivotal Values W

i w | [w] Ascending

| Add Sorting Option |

And the resultant table that matches the Table Guide would look like this:
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Brand PSV Co. | ~ AcmeDrill Co.
| Material | Carbide Tipped Titanium HSS |

Diameter | Length | # Flutes | SKU | Price = SKU | Price | SKU | Price | Angle | Grade
15 12 mm 2 8J654 14.99 | 8J5F4 13.99 | 8J5H1 13.99
2.0 16 mm 8J6S5 1799 | 8J5F5 16.99 | 8J5H2 16.99
25 20 mm 9 8J6S6 = 1999 8JSF6 = 1899 | 8J5H3 = 1899
3.0 24 rmm 8J6S7 2399 | 8J5F7 22.99 | 8J5H4 22.99
3.5 28 mm 2 8J658 2499 | 8J5F8 23.99 | 8J5HS 23.99
4.0 30 mm 8J6S9 3299 | 8J5F9 31.99 | 8J5HE 31.99
ﬁ Box Type Wooden Case | ' Pnp-Opdn Plastic _I

You may also sort on the Bottom Pivotal Values in a similar manner to sorting on the Top Pivotal Values. Instead of
selecting 'Top Pivotal Values' in the drop down you would select 'Bottom Pivotal Values'.

The above examples used only the ascending and descending option (Alphabetic). But you also may also sort on
Numeric, and Fraction, thus:

1 w | [« Ascending (@) Alphabetic (C) Mumeric  (C) Fraction

Pivot Transformation Step 9
In Step 9 you define some general settings.

Settings

Merge Equal Cells in the Left Common Values Rows
Merge Equal Cells in the Right Common Values Rows
Merge Equal Cellz in the Top Pivotal Values Columns
Merge Equal Cells in the Bottom Pivotal Values Columns
Remove Empty Value Rows

Remove Empty Value Columns

Allow Mare Than One Product in Each Pivot Value

A number of these options can be explained by referring to the Table Guide:
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Brand PSV Co. Acme Drill Co.
| Material | Carbide Tipped Titanium HSS |
Diameter | Length | #Flutes | SKU | Price = SKU | Price | SKU | Price | Angle | Grade
1.5 12mm | 2 8J654 14.99 | 8J5F4 13.99 | 8J5H1 13.99
2.0 16 mm 8J6S5 1799 | 8J5F5 16.99 | 8J5H2 16.99
25 20 mm 9 8J6S6 19.99 | 8J5F6 18.99 | 8J5H3 18.99
3.0 24 rmm 8J6S7 2399 | 8J5F7 22.99 | 8J5H4 22.99
3.5 28 mm 2 8J658 2499 | 8J5F8 23.99 | 8J5HS 23.99
4.0 0mm | 8J6S9 3299 | 8J5F9 31.99 | 8J5HE 31.99
_ Box Type Wooden Case | Pop-Open Plastic _I

These options are explained as follows:

« Merge Equal Cells in the Left Common Values Rows: The Table Guide shows the effect of this setting.
The values in the '# Flutes' column have been merged when consecutive cells have an equal value.

« Merge Equal Cells in the Right Common Values Rows The Table Guide shows the effect of this
setting. The values in the cells of the 'Angle' and 'Grade' columns have been merged when consecutive cells
have equal values

« Merge Equal Cells in the Top Pivotal Values Columns: The Table Guide shows the effect of this
setting. The attribute value 'Acme Drill Co." was merged since consecutive cells had the same value.

« Merge Equal Cells in the Bottom Pivotal Values Columns: The Table Guide shows the effect of this
setting. The attribute value 'Pop-Open Plastic' was merged since consecutive cells had the same value.

« Remove Empty Rows in the Compacted Values Area: Removes any row in the Compacted Area
where all the cells have empty values. This would only take effect if you had deselected the 'Horizontal
Values' checkbox in Step 3.

« Remove Empty Columns in the Compacted Values Area: Removes any column in the Compacted

Area where all the cells have empty values. This would only take effect if you had deselected the 'Horizontal
Values' checkbox in Step 3. So referring to the Table Guide, if in the Compacted Values Area all the Prices
were missing for the PSV Co. products, that column would be removed. Thus:

Brand PSV Co. Acme Drill Co.
Material Carbide Tipped Titanium HSS
Diameter | Length # Flutes SKU SKU Price SKU Price | Angle | Grade
15 12 mm 2 8J654 8J5F4 13.99 | 8J5H1 13.99
2.0 16 mm 8J6S5 8J5F5 16.99 | 8J5H2 16.99
25 20 mm 3 BJBSEH 8J5F6 18.99 | 8J5H3 18.99
3.0 24 mm 8J6s7 8J5F7 2299 | 8J5H4 2299
a5 28 mm 2 8J6S3 8J5F8 2399 | 8J5H5 2399
4.0 30 mm 8J659 8J5F9 31.99 | BJSHE 31.99
_ Box Type Wooden Case Pop-Open Plastic _
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« Allow More Than One Value in Cells in the Compacted Values Area: Consider the following table:

Brand PSV Co. Acme Drill Co.
Material Carbide Tipped Titanium HSS

Diameter Length # Flutes SKU Price SKU Price SKU Price | Angle | Grade
20 16 mm 9 8J654 14.99 | 8J5F4 13.99 | 8J5H1 13.99
8J655 1799 | 8J5F5 16.99 | 8J5H2 16.99
25 20 mm 3 8J6S6 19.99 | 8J5F6 18.99 | 8J5H3 18.99
3.0 24 mm 8J657 2399 | 8J5F7 2299 | 8J5H4 22.99
35 28 mm 2 8J658 2499 | 8J5F8 23.99 | 8J5H5 23.99
4.0 30 mm 8J659 3299 | 8J5F9 31.99 | 8J5H6 31.99

_ Box Type Wooden Case Pop-Open Plastic _

Note that in the first 'body' row there are cells with two part numbers and prices. However, there is no data in that
row or column that distinguishes one product from the other. In other words the reader cannot see any difference
between part number 8J6S4 and 8J6S5. The price is different, but there is no supporting data to differentiate
between the two products. So all that a reader would see is that part numbers 8J6S4 and 8J6S5 have identical
specifications, but one is more expensive than the other. Thus any normal customer would always order the less
expensive item. Or they would have to investigate by some other method the difference between the products.

This situation usually occurs when either a) the Table Definition is missing an attribute that would indicate the
difference in the products, or b) the data that does distinguish the two products is present in the Table Definition
but has not been accounted for in the Pivot Transformation, or c) the actual data is incorrect.

If you were to disable the checkbox 'Allow More Than One Value in the Compacted Area' then only the first entry
would be displayed (i.e. 8J6S4). But if the checkbox is selected, (i.e. itis OK to allow more than one product or
value in a cell), then the system will place a Return code between each entry in the cell.

Pivot Transformation - Finish
Finishing the Transformation

When you have made all your selections, click the Finish button to return to the Table Preview. You could check
what the Table Preview would show before you exit the transformation, using the option '‘Show Preview', and
updating that preview each time you make a change. However, the preview within the transformation will take all
transformations that are applied within the table, even if one or more of them were temporarily disabled by
deselecting the check box for that transformation. If you wish to see the Table Preview with just the
transformations that you have selected, you need to exit the Pivot Transformation and view the preview as you
would normally.

Adding Subsequent Transformations

The Pivot Transformation is reasonably tolerant of working together with subsequent transformations, such as
creating table subheads from a column, or applying alternate tints on rows, etc. However, because the table has
essentially been rebuilt you will not be able to refer to a column by its attribute. The only practical way to refer to a
column, for example, is to refer to it either by its subtype or by its column number after the Pivot Transformation.
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Priority of Cell Formatting Setups

Throughout the various Steps of the Pivot Transformation Wizard you are presented with options to specify the
formatting of the table cells. However, formatting can also be applied via the rows or column subtypes specified in
the Table Definition tab, as well as individual cell settings being applied. It is possible to create a setup that would
cause a conflict in determining which formatting values to use. Thus the Pivot Transformation uses a strict order of
prioritization. This priority is not always easy to determine, so an examples is presented here as a guide to help
with trouble-shooting any formatting "conflicts".

Determining how a table cell's background color is selected when there are several conflicting setups

in

place

Note that this example of Format Priority is valid for all the following setups:

Text Style

Background Color

Vertical Alignment
Rule Above

Rule Below

Rule Left

Rule Right
Cell Rotation

Process Flag

Cell Story Direction

In the Table Guide, consider the cells that hold the values for the attribute Length. That attribute resides in the Left
Common Values area of the table.

Diameter Length # Flutes
15 12 mm 2
2.0 16 mm
2.5 20 mim 3
3.0 24 mm
3.5 28 mim 2
4.0 30 mm

In the Table Definition, assume that there are several setups in effect, as follows:

1
2

» Column Head... |[JT Mame

* Mormal Ru:uwo g Local

Pivot Table

3 > |4 > |5

LH Compact Specifica... LH Compact SpedﬁaLH Compact Spedifica...

[13 piameter [T Length 1T #Flutes

Diameter Length # Flutes
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1. Assume that the row type Normal Row has a default BG Color assigned to it (Cyan) and that the BG Color is
overridden in the Table Definition on that row with a color of Leaf Green. Refer to the following picture.

Row Type

¥ » |Value

Mormal Row

W

Height in W
1 ? Column Head... |[If Name Text Style Mot Defined W
2 » Mormal Row Cg Local

Backaround Color | Leaf Green W

The row type Normal Row has a BG Color of Cyan, but is overridden in the Table Definition with a BG Color of
Leaf Green.

2. Further assume that the column type LH Compact Specifications has a BG Color assigned to it and that it also
has an override BG Color of Orange applied in the Table Definition on the column holding the attribute Length.

Column Type

Mame * | > |Value
* Mame LH Compact Specifications
» Defaults Style:CompactSpedificationLeft Background: Canary Yellow

4

Compact Spedifica... Width Proportional v
1T Length

Text Style Inherited: CompactSpecdificationLeft "

Length Background Color Drange o

The column type LH Compact Specifications has a BG Color of Canary Yellow, but is overridden in the Table

Definition with a BG Color of Orange.

3. Last, assume that there is a BG Color override applied at the cell level.

— 3 Change Cell Settings
W,
Text Style Inherited: ColumnHeader—CompactSpedficationLeft w
Background Color | Sandy Beach Y

Now consider the Format setup within the Pivot Transformation, and the effect that it has on the output.
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First Priority

This setting takes the highest priority for cell formatting—the Global Override setup in the Pivot Transformation.
But be aware that this Global Override affects all cells in the Left Common Values area, not just the ones for the
cells with the attribute values for Length.

Text Style Mot Defined v | Column types to apply

Background Golor  |Mud Yellow / Every Calumn v | |LH Compact Specifications  w

Vertical Alignment  |Center i
Diameter Length

Unused v | |Mone W

Second Priority

If there is no Global Override for the BG Color, then the next priority goes to the Cell Settings override, thus:

Length b+ 4 Change Cell Settings
Text Style Inherited: CompactSpedficationLeft o
Background Color | Sandy Beach v

Diameter Length # Flutes

15 12 mm 2

2.5 20 mm 3

35 28 mm 2

30 24 mm 3

4.0 30 mm 2

2.0 16 mm

Note that this setup affects only the cells with the attribute value of Length.

Third Priority

If there is no Cell Settings override, then the next priority goes to any localized setting on the row type. So in this
case, if a Row Settings override was applied to the Normal Row, the result would be similar to the following:
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Pivot Table 1 s |2 5|3 5

LH Compact Specifica... LH Compact Spedifica. .. LH Compact Specifica...
(1T Diameter [1T Lenath [T #Flutes

32 Change Row Settings

1 » Column Head... (]I Name

2 » Normal Row R Local Height | in w
Text Style Mot Defined W
Background Color | Leaf Green "
Diameter  [Length # Flutes SKU Price SKU Price SKU Price |
1.5 12 mm 2 BJEH1 £13.99 8JEF4 £13.99 8.J654 £14.99
] 20 mm 3 BJEH3 %18.99 8.J5F6 %18.99 BJE656 $19.99
3.5 28 mm 2 BJEHS £23.99 B.J5F8 £23.99 BJE58 £24.99
3.0 24 mm 3 BJEH4 %£22.99 BJEFT %£22.99 8J&5T £23.99
4.0 30 mm 2 BJSHE $31.99 8J5F9 $31.99 8.J659 $32.99
2.0 18 mm BJEH2 £16.99 BJEF5 £16.99 BJESE £17.99 |

Note that the row setting may well affect other cells in the table, not just the ones in the Left Common Values area.

Fourth Priority

If there is no Row Settings override, then the next priority goes to the default setting on the row type. So in this
case, if a default setting was applied to the Normal Row, the result would be similar to the following:

Mame ¥ 3 Vale
> Name Normal Riow
» Defaults Background:Cyan
Diameter Length # Flutes SKU Price SKU Price
1.5 12 mm 2 BJ5H1 $13.99 8J5F4 $13.99
25 20 mm 3 l8J5H3 $18.99 BJSF6 $18.99
3.5 28 mm 2 ‘BJEHS $23.99 8J5F8 $23.99
3.0 24 mm 3 ‘8J5H4 $22.99 8J5FT $22.99
4.0 30 mm 2 ‘SJSHG $31.99 8J5F3 $31.99
) 16 mm leJsH2 $16.99 BJSFS $16.99

Note once again that the row setting may well affect other cells in the table, not just the ones in the Left Common
Values area.

Fifth Priority

If there is no default setting on the row, the next priority goes to any Column Settings override, but only ifthe
column type in the Table Definition is the same as that applied in the Transformation, thus:
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Pivot Table 1 s |2 3|3 » |4 5|5 »
Compact Partio Compact Price |H Compact Spedific... |H Compact Spedific... LH Compact Spedfic...
[T st 1% Price (1T ciameter (1T Length 1T #Flutes

—
W

Column Head... (| Name SkU
Mormal Row  Cg Local

Diameter Length # Flutes

[2]
W

3 Format

Text Style fiot Defined { | Column types to apply
Background Color | Mot Defined v | [EvEry Column w | [LH Compact Specifications

Vertical Alignment | Center Unused v | |Mone W

3% Change Column Settings T L B
15

Width Proportional 2.5
35

Text Style Inherited: CompactSpedificationLeft w | Column Type =

Background Color Drange P 40

If the column type in the Table Definition does not match the column type that is applied in the Transformation,
then the Column Settings override in the Table Definition will be ignored.

Sixth Priority

If there is no Column Settings override, the last priority goes to the default setting in the column type that is
assigned in the Transformation, thus:

3 Format

Text Style fiot Defined ! s | Column types to apply
Background Color | Mot Defined v | |Every Column w | |LH Compact Specifications w

Vertical Alignment | Center W Unused v | [Nane v
Column Type Driameter Length # Flutes
1.5 12 mm 2
Mame » | » |Value Sc =0 mm 3
* Mame LH Compact Specifications 25 2% mm o
> Defaults Style: CompactSpedficationLeft Background: Canary Yellow (3.0 24 mm 3

Formatting Priority Synopsis

1. Global Override in the Transformation

2. Cell Setting override in the Table Definition
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3. Row Setting override in the Table Definition
4. Row Setting default in the Table Definition

5. Column Setting override, but only if the column type in the Table Definition matches that which is appplied in
the Transformation

6. Column Setting default, as applied in the Transformation

Comments

Itis not Best Practice to assign settings in such a way that it is difficult to determine which format setting is actually
used. It should be sufficient to make setups such that only one or two levels of priority are necessary.

If you wish to apply background colors to alternating rows you are advised to not use BG colors in any of the
row/column settings that will affect "body" rows (non-header rows) and use the standard transformation that will
apply those BG colors. That transformation may be applied after the Pivot Transformation.

If possible, try to avoid Text Style format setups that will cause a conflict in how the Table Preview can display the
text.

Header Repeating Pagination Plugin

The Header Repeating Pagination Plugin is accessible on Table Type objects. The settings available in this
'plugin’ allow more control over the behavior of tables—specifically related to the behavior of repeated header and
footer rows—when lengthy tables split across columns or pages.

Though the settings contained within this 'plugin’ are not transformations, they are designed to work along with
transformations, or in some cases, in place of them. For example, the Alternate Row Colors transformation may
be sufficient for simple, smaller tables, but for lengthy tables that split, more control is needed in how the alternate
row colors are calculated when headers split across pages. In this instance, the Header Repeating Pagination
Plugin would be used instead of the Alternate Row Colors transformation.

Note that all settings are not necessary for all tables. The specific combinations chosen are dependent on the
unique requirements for the table type being configured.

To configure the Header Repeating Pagination Plugin, follow these steps.

1. InSystem Setup, expand Table, then expand Table Types.

2. Expandthe Table Type Group that contains the table type that you would like to configure, then select the
relevant table type.

3. Onthe Table Type tab, click in the Pagination Plugin field and select Header Repeating Pagination
Plugin. (‘"None' will appear as the default selection.)
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< Price Table - Table Type L
Mame *| * Value *

* IName Price Table

* |Edited by 2015-07-16 18:04:00 by USER

* Defaults

* Dimension Dependenc...

>|Pagination Plugin None » Change Settings

= | egal Row Types

. | Column T Header Repeating Pagination Plugin

4. Click on Change Settings, which appears directly to the right of the dropdown list. The Header Repeating
Pagination Plugin displays.
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¢ Row/Coumn counts

Minimum Body Rows to Keep With Heading at Bottom of Column |1
Minimum Body Rows to be Carried Over to Top of Mext Column 1

Minimum Body Columns before a table width split

Minimum Body Columns after a table width split

i
Name >
* |Add Row Type
i
Name >
* | Add Column Type
4
MName >
* |Add Row Type
i
Name >
* | Add Column Type
4
MName >
* |Add Row Type
¢ Alternating Row Colors Settings

Enable alternating row colors
Restart row count at always repeated headers

Restart row count at repeat last headers

Ignore always repeated headers

Ignore repeat last headers
Ignore footers

Normal Colored Rows
Alternate Colored Rows

Normal Color Light Blue -

[
4

Alternate Color Paper

§ Table Rulers and Width settngs

Use table bottom ruler on splits as bottom ruler.
Use table top ruler on splits as top ruler.
Use table left ruler on splits as left ruler.

Use table right ruler on splits as right ruler.

-

Enable table split when wider than frame

Break before table width split

| ok || cancel
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11.
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In the Row/Column counts area, make the following selections as needed:

« In Minimum Body Rows to Keep With Heading at Bottom of Column, select a number from the
dropdown list. Numbers range from 0 to 10.

o In Minimum Body rows to be Carried Over to Top of Next Column, select a number from the
dropdown list. Numbers range from 0 to 10.

« In Minimum Body Columns before a table width split, select a number from the dropdown list.
Numbers range from 0 to 10.

« In Minimum Body Columns after a table width split, select a number from the dropdown list. Numbers
range from 0 to 10.

In the Always Repeated Row Headers area, click Add Row Type to choose the heading and/or subheading
row types that must always be repeated when a table is split.

In the Always Repeated Column Headers area, click Add Column Type to choose the heading and/or
subheading column types that must always be repeated when a table is split.

Inthe Repeat Current Header Row (in order of priority) area, click Add Row Type, then select the
heading and/or subheading row types where only the last row of that type will be repeated when a table is split.

In the Repeat Current Header Column (in order of priority) area, click Add Column Type, then select
the heading and/or subheading column types where only the last column of that type will be repeated when a
table is split.

Inthe Repeated Table Footers area, click Add Row Type to select the footer row types that must be
repeated at the bottom of a column or page when a table is spilit.

In the Alternating row colors settings area, make selections here only if you are not already using the
Alternate Row Colors transformation.

Though the Alternate Row Colors transformation adds color shading to alternating table rows, the
transformation offers no additional control over the alignment of shaded rows when a table splits across a
column or a page.

Using alternate row color settings in the Header Repeating Pagination Plugin provides a more complex level of
control over the appearance of split tables with multiple repeated headers. The following screenshot shows
neatly aligned row colors in a table split across two columns, accomplished by applying alternate row coloring
using the Header Repeating Pagination Plugin.
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Product Name Part No. Price Product Name Part No. Price
Christmas Party Hat 121184-A 5799 | |Yellow & Green Party Hat | 134416-A  §4.79
Cosmic Party Hat 134413-A $3.99 | |Glitter Party Hat 138934-A | 5399
Pink & Green Party Hat 134420-A | 54.79 Political Party Hat | 138935-A 3479
Pink & Green Pom-Pom Hat | 138925-A  §3.99 Birthday Party Hat 134426-A 0 §3.99
Christmas Party Hat 138826-A | $2.88 | |1st Birthday Party Hat 138936-A  $2.99
Purple & White Party Hat 138927-A | 52.99 | [2nd Birthday Party Hat 121192-A | 5299
Glitter Party Hat 121177-A | $3.95 | |3rd Birthday Party Hat | 134417-A 5309
Purple Foil Party Hat 134414-A  $2.99 Sweet 16 Party Hat 134428-A 0 §2.99
Yellow & Pink Party Hat 134422-A | $2.88 | |Over the Hill Party Hat 138937-A | $2.99
Yellow & Green Party Hat 138928-A 5209 Fringe Party Hat 138938-A  §3.99
Ice Princess Party Hat 138929-A 5293 | |Political Party Hat | 138939-A | $2.99
Fairy Princess Party Hat 138930-A | $2.99 Purple & White Party Hat 121178-A | $4.79

« First, check the Enable alternating row colors box to activate the rest of the options in this area.

« Next, check the following boxes as needed to control where alternate row coloring should and/or should not
appear:

« Restart row count at always repeated headers
« Restart row count at repeat last headers
« Ignore always repeated headers
« Ignore repeat last headers
« Ignore footers
« Enter the number of Normal Colored Rows and Alternate Colored Rows in the text boxes

« Selectthe Normal Color and Alternate Color from the dropdown lists. Selections are populated by colors
created in System Setup under Table > Colors

For more information on the Alternate Row Colors transformation, see Table Layout Transformations in the
Tables documentation.

12. Inthe Table Rulers and Width settings area, check the necessary boxes to determine which table rules
must be added to split tables and to fine-tune when tables split based on their width:

« Use table bottom ruler on splits as bottom ruler.
« Use table top ruler on splits as top ruler.

« Usetable left ruler on splits as left ruler.

» Use table right ruler on splits as right ruler.

« Enable table split when wider than frame

« Break before table width split

Understanding Table Inheritance

This section contains information about how to create and remove local overrides and information about table
dimension points.
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The STEP Table Component is based on the principle of inheritance which means that tables are linked or defined
at high levels in the product or classification hierarchy and then inherited to lower levels.

You can override the table definitions at lower levels if you need to create local variations of a table. This way you
can create a default table for an entire catalog, and then create different table styles for specific sections of the
catalog. You can also create table variations within a table variation if required.

Making a Local Override

The following modifications result in an override of the inherited table style.

» Adding, changing and removing columns and rows.

« Spanning or overriding cells.

« Changing the graphical settings for columns, rows or cells.
« Adding, changing or removing transformations.

« Changing the contents of a free text type cell.

Note: If you modify the layout of a table in InDesign, it does not create local override of the table in the STEP
database.

Overriding a table at a lower level

The following example shows a table that is created at a high level in the hierarchy, and then over-ridden at a lower
level.

) T4 A e Sl
Tree ‘Conduit rev.C.1 - Tables
g =HE01 Prirary Product Hisrarchy X Procuct | Sub Products | References | Images & Documents | History | Commercial Tables
=i [=HE0 Electrical @Tahles
E-E coTv Narme [ hefined ot
H-ED [ |

|StandardPriceTable EF'rimar\,r Product Hierarchy

F-E0 Consumer Goods

o= il ll\dd Table Type
{21 Ground Fault Circuit Interrupters — Frimary Product Hierarchy
Defnition Preview: D = Proguct hisrarchy root

In this example, the StandardPriceTable has been created at the Primary Product Hierarchy level. When you
select a product that contains one or more tables, you can see in the Defined at column where the tables are
defined.

Search Result

If you change an inherited table at a lower level, you create a local override of the table. In the example, if changes
are made to the contents of the table at the Conduit level, the table is still named the same, but the content from the
Conduit level and below is different from that defined at the Primary Product Hierarchy level.

When you override the inherited settings, a local instance of the table is created, and Defined at changes to Local.
All products below the current level will now inherit the table defined here.

Products at sibling levels still inherit the table definition from the higher level in the hierarchy.
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b q{l 5 culzss it Product | Sub Procucts || References | Images & Documents I History I Commercial | Tables |
=, | B3 Nordwest Publikationen .

=l _ E]Tables
Rl | Primary Procuct Hierarchy ——— e

o S E51 Electri | Name Defined At

s ectrical -

£ COTY |_|S{andardPriceTable acal

5 R | Concuit lAdd Tahble Type %

Lﬁ:‘gl -0 Consumer Goods | Definition | e

|—[:j Ground Fault Circuit Interrupters I

Removing Local Instances of a Table

When you delete the local instance of a table, it only removes the instance of the table defined at the local level.
The table that was inherited from a higher level is still there.

« Onthe Tables tab, click the Definition tab, right-click anywhere, and then select Delete Table.

Table Dimension Points and Inheritance

When you create a new table type, you can make that table dependent on a dimension point such as Language.

Note: Be aware, that the usual rules for dimension-dependent attributes also apply for tables.
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